Report Administration and Development Guide
**First Edition (January 2007)**
This edition applies to version 6, release 2, modification 1 of IBM Maximo and to all subsequent releases and modifications until otherwise indicated in new editions.

Third-Party Technology: Certain Maximo products contain technology provided under license from third parties, as noted in the following table:

<table>
<thead>
<tr>
<th>IBM Product</th>
<th>Third-Party Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Portions © 2005 BEA Systems, Inc. BEA WebLogic Server® provided by BEA Systems, Inc.</td>
</tr>
<tr>
<td>Maximo Discovery</td>
<td>MSDE Copyright © Microsoft® Corporation.</td>
</tr>
<tr>
<td>IBM Maximo Mobile</td>
<td>Portions © 2005 DataMirror, Inc.</td>
</tr>
<tr>
<td></td>
<td>Portions © 1996-2005 Syco, LLC.</td>
</tr>
</tbody>
</table>


© Copyright International Business Machines Corporation 2007. All rights reserved.

US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
# Contents

About This Guide .............................................. vii
  Audience .................................................. vii
  Related Actuate Documentation .......................... viii
  Related Maximo Documentation ........................... ix
  Support ..................................................... x

Chapter 1: Understanding Actuate Components ...................... 1-1
  Using Actuate as Your Reporting Application ............... 1-1
  Defining Actuate Components ................................ 1-2
  Configuring the Maximo Network with Your Actuate Server 1-7

Chapter 2: Listing Overview and Detail Reports by Application ...... 2-1
  Listing Overview and Detail Reports by Application ........ 2-2

Chapter 3: Using Maximo Reports .................................. 3-1
  Signing In to Reports ..................................... 3-2
  Opening Reports .......................................... 3-2
  Using Business Analysis and Reporting Tabs ................. 3-3
  Using the Request Page Tabs ................................ 3-8
  Running a Report ........................................... 3-13
  Using the Reporting Toolbar ................................ 3-15
  Downloading a Report ..................................... 3-17
  Searching within a Report for a Specific Record .......... 3-23
  Adding and Removing a Search Field ....................... 3-26
  Running a Query .......................................... 3-29
  Customizing a Query ...................................... 3-31

Chapter 4: Creating Spreadsheet Reports ........................... 4-1
  Installing Maximo eSpreadsheet Designer .................. 4-1
  Setting Up a JDBC Connection ................................ 4-2
  Creating a Report .......................................... 4-3
  Modifying the SQL Query ................................... 4-14
  Linking Related Tables through Joins ....................... 4-17
  Modifying the Report ...................................... 4-20
  Creating a Parameter ...................................... 4-21
  Defining a Parameter ...................................... 4-24
  Running the Report Locally (as a Test) ..................... 4-25
  Finding Information on Additional Topics .................. 4-25
  Finding Information on Advanced Topics ................... 4-25

Chapter 5: Using Maximo Query in e.Report Designer Professional ... 5-1
  Creating Query Reports ................................... 5-1
  Maximo Query Creation Process ........................... 5-1
  Creating a Query Report Object Using the Textual Query Editor 5-3
  Setting Up Global Vars Parameters ........................ 5-7
  Adding Parameters ......................................... 5-9
  Posting to an iServer Encyclopedia ......................... 5-11
  Running a Query .......................................... 5-11
  Creating Queries – Tips ................................... 5-11

© Copyright IBM Corp. 2007
Chapter 6: Administering Reports .......................................................... 6-1
  Tracking Report Administration Actions Flowchart .......................... 6-2
  Accessing the Report Administration Module ................................. 6-3
  Registering (Adding) a New Maximo Report to the Maximo Database . 6-4
  Attaching Documents ................................................................. 6-7
  Using the Detail Check Box for Detail Reports .................................. 6-8
  Creating a Button on the Maximo Toolbar ...................................... 6-9
  Creating a Toolbar Button in the Purchase Orders Application .......... 6-11
  Generating and Previewing a Request Page .................................... 6-12
  Changing Report Titles and Field Labels in the Labels Tab ............... 6-14
  Renaming Report Columns .......................................................... 6-14
  Defining Report Types .................................................................. 6-17
  Working with Parameters ......................................................... 6-18
  Running Current/Selected/All Reports ......................................... 6-19
  Defining and Running Parameter-Based Reports ............................ 6-24
  Deleting a Report ....................................................................... 6-27
  Providing Security Access to Your Report Developers ..................... 6-28
  Running Parameter-Based Reports – Tips for the Report Administrator .. 6-34
  Defining Bound and Unbound Parameters .................................... 6-35
  Determining Your Parameter’s Attribute Name ............................... 6-37
  Storing Parameter-Based Reports in Multiple Maximo Applications ... 6-39

Chapter 7: Loading and Configuring e.Report Designer Professional .......... 7-1
  Describing Actuate Files ............................................................... 7-1
  Loading and Customizing e.Report Designer Professional ............... 7-4
  Customizing Your Actuate Template Files .................................... 7-5
  Pointing to Maximo Configuration Files ....................................... 7-5
  Pointing to Maximo Palette Files ................................................ 7-7
  Adding a Server Profile ................................................................ 7-8

Chapter 8: Compiling and Running Reports in e.Report Designer Professional 8-1
  Selecting a Report ................................................................. 8-2
  Compiling a Report .................................................................. 8-3
  Adding Compiled Reports and Queries to the Encyclopedia ............ 8-4
  Running a Report from e.Report Designer Professional .................. 8-4

Chapter 9: Using Advanced Features in e.Report Designer Professional .... 9-1
  Using Maximo Templates ........................................................... 9-1
  Creating Your First Report ....................................................... 9-6
  Changing Report Titles and Field Labels Using the Maximo Labels Tab . 9-16
  Working with Your SQL SELECT Statement in Maximo .................. 9-19
  Creating a Hyperlink from One Report to Another ....................... 9-20

Chapter 10: Configuring Actuate ............................................................... 10-1
  Setting Privileges ..................................................................... 10-1
  Configuring Security ................................................................... 10-2
  Setting Privileges by Role .......................................................... 10-2
  Setting Privileges by User .......................................................... 10-7
  Using the Jobs Folder ............................................................... 10-11

Chapter 11: Adding Reports to the Encyclopedia .................................... 11-1
  Defining Encyclopedia Components ........................................... 11-1
  Adding Compiled Reports to the Encyclopedia ............................. 11-4
## Chapter 12: Maintaining a Report Server

- Setting Up Factories and Processors ................................................. 12-1
- Increasing the JVM Maximum Heap Size on the iServer ........................ 12-3
- Compiling Reports in Batch Format .................................................. 12-4
- Clearing a Completed Notice ............................................................... 12-5
- Clearing Multiple Completed Notices .................................................. 12-6
- Archiving Reports .............................................................................. 12-7

## Chapter 13: Setting Up Localized Reports and Queries in Maximo

- Determining Report Language ......................................................... 13-2
- Localizing Reports ........................................................................... 13-4
- Localizing Report Data ................................................................. 13-5
- Setting the Label Value Maximo Displays on Your Report .................. 13-7
- Changing the Value of Report Labels ............................................... 13-10
- Localizing Cross-Tab Reports ......................................................... 13-11
- Localizing Queries ........................................................................... 13-12
- Viewing Query Label Values ........................................................... 13-13
- Localizing Query Data ................................................................. 13-14
- Adding Query Labels ...................................................................... 13-15

## Appendix A: Maximo.Properties File Descriptions

- Report Server Properties ................................................................. A-2
- Database Properties .......................................................................... A-3

## Appendix B: RSSE Properties Descriptions

- RSSE_Localhost.Properties and RSSE_Maximo.Properties Files .............. B-1
- JDBC Connection Properties ............................................................... B-2
- Maximo Connection Properties ......................................................... B-3
- LDAP Connection Properties .............................................................. B-3
- Maximo Role Mapping Properties (RSSE_Maximo.Properties File Only) .... B-4

## Appendix C: Actuatei18ntext.Properties File Descriptions

- Glossary .......................................................................................... Glossary-1
- Notices .............................................................................................. Notices-1
- Index ............................................................................................... Index-1
About This Guide

This section explains how this guide can help you to use IBM® Maximo®. It also provides information about other IBM Corporation resources available to you, such as additional documentation and support.

Audience

The following table identifies five types of report users and summarizes the tasks associated with each type of user:

<table>
<thead>
<tr>
<th>User</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business User</td>
<td>▼ uses spreadsheets and other computer software programs frequently in their day to day activities ▼ executes complex reports, such as analysis, crosstab, and hierarchical reports, to analyze processes and information ▼ creates Query Reports with e.Report® Designer Professional ▼ creates spreadsheets with eSpreadsheet®</td>
</tr>
<tr>
<td>End User</td>
<td>▼ runs and prints a limited number of reports with emphasis on quick and ready access to information ▼ relies on report data to provide the specific information necessary to do a job</td>
</tr>
<tr>
<td>Report Administrator</td>
<td>▼ adds and deletes reports, queries, and spreadsheets in the Report Encyclopedia® (Encyclopedia) ▼ deletes scheduled jobs when users no longer require them ▼ performs as administrator and manager of the Encyclopedia ▼ sets up report archiving policies ▼ sets up user or group report privileges ▼ uses the Maximo Report Administration module to register, modify, or delete reports and their parameters</td>
</tr>
<tr>
<td>Report Developer</td>
<td>▼ tests reports ▼ publishes reports to the Encyclopedia ▼ uses complex SQL and database queries required for report development ▼ uses e.Report Designer Professional to create or modify reports ▼ uses the Maximo Report Administration module</td>
</tr>
<tr>
<td>System Administrator</td>
<td>▼ installs Management Console ▼ maintains the Report Server ▼ sets Maximo and report property files for proper configuration</td>
</tr>
</tbody>
</table>
You can find the following Actuate documentation in the manuals folder on the Actuate Reporting Release 8 e.Report Designer Professional CD-ROM.

**Actuate Documentation Shipped with Maximo**

<table>
<thead>
<tr>
<th>File Name</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>actuate-glossary.pdf</td>
<td>Actuate 8 Glossary</td>
<td>▼ defining terms used in Actuate 8.</td>
</tr>
<tr>
<td>using-management-console.pdf</td>
<td>Using Actuate Management Console</td>
<td>▼ running reports</td>
</tr>
<tr>
<td>eReport Designer Professional CD-ROM</td>
<td></td>
<td>▼ working with items in an Encyclopedia volume</td>
</tr>
<tr>
<td>developing-basic-reports.pdf</td>
<td>Developing Actuate Basic Reports with Actuate e.Report Designer Professional</td>
<td>▼ designing reports using the graphical user interface</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▼ developing programs with e.Report Designer Professional</td>
</tr>
<tr>
<td>programming-with-actuate-basic.pdf</td>
<td>Programming with Actuate Basic</td>
<td>▼ developing programs with Actuate Basic including data types, functions, keywords, operators, and statements</td>
</tr>
<tr>
<td>working-with-basic-reports.pdf</td>
<td>Working with Actuate Basic Reports</td>
<td>▼ downloading Actuate Basic Reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▼ printing Actuate Basic reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▼ searching Actuate Basic Reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▼ viewing Actuate Basic Reports</td>
</tr>
<tr>
<td>programming-with-afc.pdf</td>
<td>Programming with Actuate Foundation Classes</td>
<td>▼ using class inheritances, hierarchies properties, variables, and methods</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▼ working with classes and topics</td>
</tr>
<tr>
<td>working-with-multiple-locales.pdf</td>
<td>Working with Multiple Locales</td>
<td>▼ designing and deploying report applications in languages other than U.S. English.</td>
</tr>
<tr>
<td>designing-spreadsheet-reports.pdf</td>
<td>Designing Spreadsheet Reports using Actuate e.Spreadsheet Designer</td>
<td>▼ designing and publishing e.Spreadsheet reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▼ establishing a data source connection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▼ formatting and manipulating data</td>
</tr>
<tr>
<td>accessing-data-spreadsheet.pdf</td>
<td>Accessing Data using e.Spreadsheet Technology</td>
<td>▼ accessing data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▼ understanding data access concepts</td>
</tr>
<tr>
<td>programming-spreadsheet-reports.pdf</td>
<td>Programming Spreadsheet Reports using e.Spreadsheet Technology</td>
<td>▼ reviewing classes and code samples</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▼ using callback classes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▼ working with XSL style sheets</td>
</tr>
</tbody>
</table>
Related Maximo Documentation

For more information about Maximo, refer to the following documentation:

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>IBM Maximo Finance Manager’s Guide</em></td>
<td>Describes how IBM Maximo completes financial transactions and how to set up general ledger accounts.</td>
</tr>
<tr>
<td><em>IBM Maximo Installation Guide</em></td>
<td>Describes how to install and configure the following software:</td>
</tr>
<tr>
<td></td>
<td>▼ Application server</td>
</tr>
<tr>
<td></td>
<td>▼ IBM Maximo</td>
</tr>
<tr>
<td></td>
<td>▼ Actuate®</td>
</tr>
<tr>
<td><em>IBM Maximo Multisite Administrator’s Guide</em></td>
<td>Describes how to configure IBM Maximo for a Multisite implementation.</td>
</tr>
<tr>
<td><em>IBM Maximo Online Help</em></td>
<td>Provides step-by-step procedures for Maximo applications.</td>
</tr>
<tr>
<td><em>IBM Maximo Reconciliation Module Implementation Guide</em></td>
<td>Describes how to use the IBM Maximo Reconciliation module to reconcile the two types of information that IBM Maximo maintains about information technology (IT) assets: IT asset data and deployed asset data.</td>
</tr>
<tr>
<td><em>IBM Maximo System Administrator’s Guide</em></td>
<td>Describes database configuration, security, and other administrative level applications and tasks.</td>
</tr>
<tr>
<td><em>IBM Maximo User’s Guide</em></td>
<td>Provides an overview of the Maximo end user applications. It also describes how the IBM Maximo applications interact with each other.</td>
</tr>
<tr>
<td><em>IBM Maximo Workflow Implementation Guide</em></td>
<td>Provides information about how to use IBM Maximo to plan, design, build, test, implement, and manage Workflow processes.</td>
</tr>
<tr>
<td><em>IBM Maximo Enterprise Adapter (MEA) System Administrator’s Guide</em></td>
<td>Describes how to configure and use the IBM MEA.</td>
</tr>
</tbody>
</table>
Support

IBM Corporation users with a valid Annual Customer Support Plan (ACSP) can obtain product support online at Support Online: support.mro.com.

Support Online includes information about product releases, software patches, and documentation updates. To find the most current version of a document, refer to the Knowledge Base on this site.
This chapter provides information on the following topics:

- using Actuate as your reporting application
- defining Actuate components
- configuring the Maximo network with your Actuate server

Using Actuate as Your Reporting Application

Overview

Maximo uses Actuate as its reporting tool. Actuate’s information delivery solution lets you create, manage, and deliver interactive content that you can act on.

You can use Actuate to perform the following tasks:

- access information seamlessly throughout Maximo
- focus on specific information to help users pinpoint problems
- offer security at report and/or user level
- enable sending reports via e-mail in Adobe® PDF or spreadsheet format
- schedule reports to run now, later, or on a recurring basis
- deliver dynamic content in a browser to users
- hyperlink among reports to get the information you need
- search report content for specific information
- print reports in PDF format for clear viewing
- download report information to PDF, spreadsheet, or rich-text format (RTF) for further analysis
Defining Actuate Components

IBM Corporation integrates the following Actuate components:

- Active Portal
- Encyclopedia
- e.Report Designer and e.Report Designer Professional
- Maximo Query
- eSpreadsheet
- iServer
- Management Console

This section describes each component in detail. For a diagram of a Maximo network configuration with Actuate, see “Configuring the Maximo Network with Your Actuate Server,” on page 1-7.

Active Portal

Active Portal lets you use the Web to access reports in your Encyclopedia through Microsoft® Internet Explorer®.

Encyclopedia

The Encyclopedia is a repository that contains the items managed by the iServer. These items include folders, report files, and user profiles.

e.Report Designer and e.Report Designer Professional

Actuate offers two report development tools:

- e.Report Designer
- e.Report Designer Professional


e.Report Designer

e.Report Designer is a flexible tool that lets report developers create or modify simple reports quickly. Reports created in e.Report Designer require no programming skills.

e.Report Designer has the following features:

- lets developers create code-free e.Reports
- modifies e.Reports through a template-based system
Defining Actuate Components

- shares e.Report Designer format with e.Report Designer Professional so that all users can leverage and share your development work
- simplifies the process of creating e.Reports

The following figure shows some of the properties on the Properties tab in e.Report Designer:

**Component Properties Dialog Box**

![Component Properties Dialog Box](image)

**Minimum Hardware Requirements**

To run e.Report Designer, you need to meet the following minimum hardware requirements:

- Intel® Pentium®-based processor with 300 MHz
- 128 MB of memory for Windows XP Professional or Windows 2000 operating system
- 175 MB free space

**NOTE** Unlike e.Report Designer Professional, described in the following section, e.Report Designer cannot overwrite or view methods.
e.Report Designer Professional

e.Report Designer Professional is a tool that professional report developers install on their desktop to let them create custom reports and/or modify existing reports. Using e.Report Designer Professional lets developers deliver complex reports in multiple layouts.

Use e.Report Designer Professional to perform the following tasks:

- create and maintain large numbers of e.Reports efficiently by using a development model based on libraries
- design, build, and distribute report object designs for delivery via the Web
- override complex methods
- plan content layout for rapid e.Report development
- support complex data access and formatting requirements by using the extended capabilities of e.Report designs with Actuate Basic

The following figure shows some of the properties on the Properties tab in e.Report Designer Professional.

Component Properties Dialog Box
For information about advanced functions in e.Report Designer Professional, see the following chapters:

- Chapter 7: “Loading and Configuring e.Report Designer Professional”
- Chapter 8: “Compiling and Running Reports in e.Report Designer Professional”
- Chapter 9: “Using Advanced Features in e.Report Designer Professional”

**Minimum Hardware Requirements**

- Intel Pentium-based 300 MHz processor
- 128MB of memory for Windows XP Professional or Windows 2000 operating system
- 175MB free space

**Maximo Query**

The report administrator or business user opens Maximo Query to develop information in a row/column format. It uses a wizard to guide users in field selection, sort order, filtering, and report format. You can name and save these queries for later use.

You can view reports created with Maximo Query using either Microsoft Internet Explorer, Microsoft Excel®, or Adobe® Acrobat® Reader®.

**eSpreadsheet**

To run eSpreadsheet, you need to meet the following minimum hardware requirements:

eSpreadsheet lets you create a report using a spreadsheet format. You can create and format a report, and you can add graphs, headers, footers, and other spreadsheet-type features such as calculating totals.

**Minimum Hardware Requirements**

- Intel Pentium-based 450 MHz processor
- 128 MB of memory for Windows XP Professional or Windows 2000 operating system
- 150 MB free space

**iServer**

The Actuate iServer lets you generate report documents and queries, manage them in the Encyclopedia, and share them with other users.
Management Console

Management Console lets you manage reports. Management Console also lets report developers deploy and test reports on the Encyclopedia. After installing Management Console on a server, the report administrator can open, copy, view, modify, and delete reports.

The following table lists the tasks you can perform using Management Console.

<table>
<thead>
<tr>
<th>To perform this task</th>
<th>See this chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage reports</td>
<td>Chapter 3, “Using Maximo Reports”</td>
</tr>
<tr>
<td>Manage groups</td>
<td>Chapter 10, “Configuring Actuate”</td>
</tr>
<tr>
<td>Add reports</td>
<td>Chapter 11, “Adding Reports to the Encyclopedia”</td>
</tr>
<tr>
<td>Archive (delete) reports</td>
<td>Chapter 12, “Maintaining a Report Server”</td>
</tr>
</tbody>
</table>
Configuring the Maximo Network with Your Actuate Server

The following diagram shows the Actuate 8 server in a Maximo network environment.

Maximo Network Configuration with Actuate

The Network Configuration depicted in this drawing is only one example of an Actuate Server setup. Your setup can vary depending on your individual implementation requirements.
This chapter contains a table of Maximo applications that have both list (overview) and detail reports. These reports are part of the standard Maximo installation.

**NOTE** Depending on your Maximo license, you might receive additional reports for other Maximo applications.

Your report administrator can create additional reports customized for your site or business. Your system administrator can customize and delete existing reports and add new reports in Maximo.

The following table lists the types of reports in Maximo:

**Maximo Report Types, Descriptions, and Examples Table**

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis</td>
<td>A report providing calculated values or a graphical representation of the data.</td>
<td>Summary of Asset Failures by Location</td>
</tr>
<tr>
<td>Cross-tab</td>
<td>A report displaying data in grid format using rows and columns.</td>
<td>Asset Availability Report</td>
</tr>
<tr>
<td>Detail</td>
<td>A report detailing a specific record. You can select this report for one record, selected records, or all records.</td>
<td>Work Order Details Report</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>A report showing parent-child relationships.</td>
<td>Maintenance Cost by System Report</td>
</tr>
<tr>
<td>List/Overview</td>
<td>A report listing a limited amount of details about a set of records. You can select this report for one record, selected records, or all records.</td>
<td>Purchase Order List Report</td>
</tr>
<tr>
<td>Queries</td>
<td>A report in which the user selects unique fields, filtering, and grouping to meet individual needs.</td>
<td>List of Expired Items Query</td>
</tr>
</tbody>
</table>
The following table lists each Maximo application that has both overview and detail reports, the module where you can find the reports, and the names of the reports.

**Maximo Applications with Overview and Detail Reports Table**

<table>
<thead>
<tr>
<th>Maximo Application</th>
<th>Module</th>
<th>Report Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Contracts</td>
<td>Contracts</td>
<td>Contract List Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Master Contracts Detail Report</td>
</tr>
<tr>
<td>Labor Rate Contracts</td>
<td>Contracts</td>
<td>Contract List Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Labor Rate Contracts Detail Report</td>
</tr>
<tr>
<td>Lease/Rental Contracts</td>
<td>Contracts</td>
<td>Contract List Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lease/Rental Contracts Detail Report</td>
</tr>
<tr>
<td>Purchase Contracts</td>
<td>Contracts</td>
<td>Contract List Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Purchase Contract Detail Report</td>
</tr>
<tr>
<td>Warranty Contracts</td>
<td>Contracts</td>
<td>Contract List Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Warranty Contract Details Report</td>
</tr>
<tr>
<td>Job Plans</td>
<td>Planning</td>
<td>Job Plans List Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Job Plans Detail Report</td>
</tr>
<tr>
<td>Invoices</td>
<td>Purchasing</td>
<td>Invoices List Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Invoices Detail Report</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>Purchasing</td>
<td>Purchase Order List Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Purchase Order Details Report</td>
</tr>
<tr>
<td>Purchase Requisitions</td>
<td>Purchasing</td>
<td>Purchase Requisitions List Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Purchase Requisitions Details Report</td>
</tr>
<tr>
<td>Request for Quotations</td>
<td>Purchasing</td>
<td>Request for Quotations List Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Request for Quotations Details Report</td>
</tr>
<tr>
<td>Quick Reporting</td>
<td>Work Orders</td>
<td>Quick Reporting List Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Quick Reporting Details Report</td>
</tr>
<tr>
<td>Work Order Tracking</td>
<td>Work Orders</td>
<td>Work Order Tracking Detail Report</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Work Order Tracking Overview Report</td>
</tr>
</tbody>
</table>
This chapter covers the following topics:

- reports – signing in, opening, and running
- request pages – entering parameters, sending reports via e-mail, and scheduling reports
- reporting toolbar – printing, downloading, and searching
- queries – accessing, customizing, and running
Signing In to Reports

When you sign in to Maximo using your Maximo username and password, Maximo automatically signs you in to Actuate. You access reports through Maximo.

Opening Reports

You can access the report functions in Maximo in either of the following ways:

- From the Navigation Bar on the Start Center, select Reports which opens the list of applications containing reports.

Selecting Reports on Navigation Bar

- From the Select Action menu of any Maximo application containing reports, select Run Reports.

Selecting Run Reports on Select Action Menu (Work Order Tracking Application)
Using Business Analysis and Reporting Tabs

This section describes the three tabs available on the Business Analysis and Reporting page. You can access this page by selecting one of the following methods:

- Click **Reports > Application Name**.
- Select Run Reports from the **Select Action** menu.

Reports Tab

The Reports tab contains the following subtabs:

- Run Report – lists reports that you can run in the application. Click a report to bring up its request page.

*Run Report Subtab (Work Order Tracking Application)*

![Business Analysis and Reporting](image-url)
View Report – lists reports that were previously saved in the application. To open a report in your browser, click the report name.

**View Report Subtab (Work Order Tracking Application)**

![Business Analysis and Reporting Tab](image)

- **Run Report**
- **View Report**

**Previously Run Reports**

<table>
<thead>
<tr>
<th>Description</th>
<th>Run Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Order Details</td>
<td>2/15/06 1:48 PM</td>
</tr>
<tr>
<td>Work Order Material Shortage</td>
<td>2/15/06 1:46 PM</td>
</tr>
<tr>
<td>Work Order List</td>
<td>2/15/06 1:46 PM</td>
</tr>
<tr>
<td>Work Order List</td>
<td>2/15/06 1:36 PM</td>
</tr>
<tr>
<td>Work Order List</td>
<td>2/15/06 1:32 PM</td>
</tr>
</tbody>
</table>
Queries Tab

The Queries tab contains the following subtabs:

- **Run Query** – lists queries that you can run in the application. Click a query to bring up the query wizard in the report browser. You can use the wizard to form your own unique query.

**Run Query Subtab (Work Order Tracking Application)**

![Run Query Subtab](image)
View Query – lists queries that were previously saved in the application. To open a saved query, click the query name. You then can run the query to get “real-time” data.

**View Query Subtab (Work Order Tracking Application)**
Scheduling Status Tab

You use the Scheduling Status tab to view the status of submitted reports or queries. Reports can have any of the following statuses:

<table>
<thead>
<tr>
<th>Report Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule</td>
<td>Going to run at a specific date and time.</td>
</tr>
<tr>
<td>Pending</td>
<td>Waiting to run.</td>
</tr>
<tr>
<td>Running</td>
<td>Generating right now.</td>
</tr>
</tbody>
</table>

**Scheduling Status Tab (Asset Application)**

![Business Analysis and Reporting Tab](image)
Using the Request Page Tabs

This section describes the three tabs available on the Request Page.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Report</td>
<td>Specify report parameters.</td>
</tr>
<tr>
<td>E-mail Report</td>
<td>Send a report via e-mail.</td>
</tr>
<tr>
<td>Schedule Run Report Interval</td>
<td>Set report run schedule.</td>
</tr>
</tbody>
</table>

**NOTE** The following Maximo reports do not have request pages. You can access them only from other reports or from actions embedded in Maximo applications.

- Asset Cost Rollup Update Report
- E-commerce Details Report
- Inventory ABC Update Report
- Inventory EOQ Update Report
- Inventory ROP Update Report
- Material Requisition Detail Report
- Suggested Reorder Report
- Vendor Contacts Report
Run Report Tab

When you run a report, the parameters that open on the Run Report tab vary from report to report. For some reports, Maximo requires that you enter parameters.

**NOTE**  An asterisk (*) denotes required parameter fields.

*Request Page for Asset Move History Report*

Fill in the fields in the Parameters section below and select the Submit button to run the report. If no parameters are displayed, the report will execute against the current/selected/all record set. Optionally, fill out the Email or Schedule Tabs to set e-mail notification preferences and schedule report run times.

**Asset Move History**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>11430</td>
</tr>
<tr>
<td>Current Site</td>
<td>BEDFORD</td>
</tr>
<tr>
<td>From Site</td>
<td></td>
</tr>
<tr>
<td>From Location</td>
<td></td>
</tr>
<tr>
<td>To Site</td>
<td></td>
</tr>
<tr>
<td>To Location</td>
<td></td>
</tr>
</tbody>
</table>

Submit  Cancel
**E-mail Report Tab**

You can send a report via e-mail from the E-mail Report tab. To send a report, complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Select one or more pre-defined e-mail addresses or type e-mail addresses for non-Maximo users.</td>
</tr>
<tr>
<td>Comments</td>
<td>Type any message you want to accompany the report.</td>
</tr>
<tr>
<td>File Type</td>
<td>Send a report electronically as an Adobe PDF or spreadsheet attachment.</td>
</tr>
</tbody>
</table>

**NOTE** You cannot send queries through e-mail.

![E-mail Report Tab](image)
Schedule Report Run Interval Tab

The Schedule Report Run Interval tab lets you schedule when you want to run the report.

<table>
<thead>
<tr>
<th>Interval</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Immediate</td>
<td>Now</td>
</tr>
<tr>
<td>At This Time</td>
<td>On a specific date and time in the future.</td>
</tr>
<tr>
<td></td>
<td>Enter a date or click the Select Date icon.</td>
</tr>
<tr>
<td></td>
<td>The date you enter must be in (M or MM)/(D or DD)/YY format.</td>
</tr>
<tr>
<td></td>
<td>Enter a time when you want to run the report</td>
</tr>
<tr>
<td></td>
<td>on that date.</td>
</tr>
<tr>
<td>Recurring</td>
<td>At regular intervals.</td>
</tr>
<tr>
<td></td>
<td>To select a report run interval, click the</td>
</tr>
<tr>
<td></td>
<td>Select Value icon.</td>
</tr>
<tr>
<td></td>
<td>For example, you can run a report every</td>
</tr>
<tr>
<td></td>
<td>Monday or on the first day or last day of</td>
</tr>
<tr>
<td></td>
<td>the month.</td>
</tr>
<tr>
<td></td>
<td>Also, enter a time when you want to run the</td>
</tr>
<tr>
<td></td>
<td>report on that day.</td>
</tr>
</tbody>
</table>
Using the Request Page Tabs

Schedule Report Run Interval Tab
Running a Report

This section describes how to run a report in Maximo. For this example, you will run the Asset Move History report.

**NOTE** The Asset Move History Report is an example of a parameter-based report, as opposed to a Current/Selected/All report. For further information on running these two types of reports, see the following sections:

▼ “Running Current/Selected/All Reports,” on page 6-19

▼ “Defining and Running Parameter-Based Reports,” on page 6-24

To run the Asset Move History report, complete the following section:

1. Open the Assets application in Maximo.

2. From the Select Action menu, select **Run Reports** to open the Reports tab.

3. Select the Asset Move History report.
Running a Report

4 Enter any required parameters. For example, in the Asset Move History Request Page, you must enter an asset number and a current site.

**Run Report Tab (for Asset Move History Report)**

To open the Reporting page and view the report in browser (DHTML) format, click **Submit**. The Asset Move History report appears.

5 To open the Reporting page and view the report in browser (DHTML) format, click **Submit**. The Asset Move History report appears.
Using the Reporting Toolbar

After you execute a report or a query, the report or query displays in the report browser. The following sections describe how to use the Reporting Toolbar to perform the following actions:

- Print a report
- Download a report
- Search within a report

Printing a Report

To print your report using the report browser in Adobe Acrobat Reader, complete the following steps:

1. Click the Print icon on the reporting toolbar in Maximo. A separate browser session launches. The report opens in Adobe Acrobat Reader, displaying a print dialog box.

2. To print your report on the default printer, click **OK**.
   
   To cancel printing, click **Cancel**. If you click **Cancel**, the separate browser session remains open, letting you review and print the report from the Acrobat toolbar.

Supported Adobe Acrobat Versions

IBM Corporation supports the following versions of Adobe Acrobat Reader:

- **7.0.**
  
  IBM Corporation supports this version for only Maximo Release 6.0, Patch 4 and later Maximo releases.

- **6.0.**
  
  If you are using this version with Microsoft Internet Explorer 6.0, you cannot print PDF documents when the source URL exceeds 255 characters. Adobe fixed this bug in Adobe Acrobat version 6.0.1.

- **5.1**

- **5.0**
Attached Documents in Maximo

The Attached Document feature in Maximo lets you attach Microsoft Word documents, PDF files, Web page, diagrams, pictures, and other documents to individual Maximo reports. Your report administrator determines whether a report prints with attached documents.

To enable Attached Documents when you run a report, complete the following steps:

1. In Internet Explorer, select **Tools > Internet Options** to open the Internet Options dialog box.

2. Select the Security tab.

3. Click **Custom Level** to open the Security Settings dialog box.

4. Set all ActiveX® controls and plug-ins to Enable. The following list contains all of your ActiveX controls and plug-ins:
   - Download signed ActiveX controls
   - Download unsigned ActiveX controls
   - Initialize and script ActiveX controls not marked as safe
   - Run ActiveX controls and plug-ins
   - Scripts ActiveX controls marked safe for scripting

5. Click **OK**. You receive a warning message.

6. To save your settings, click **Yes**. The Security tab reappears.

You now can attach documents to your Maximo reports.
By downloading your report in Maximo, you can convert your browser output to any of the five formats described in this section. To download a report, complete the following steps:

1. Click the Download icon on the Reporting toolbar. The Download dialog box opens.

### Download Dialog Box

![Download Dialog Box](image)

- **Download Report To:**
  - PDF
  - Excel Data
  - Excel Display
  - RTF
  - Fully Editable RTF

- **Page Range:**
  - All
  - Current page
  - Pages: 

Enter page numbers and continuous page ranges separated by commas. For example: 1,3,5-12.
2 In the Download Dialog Box, complete the following two sections:

**a Download Report To:** – Select a download option.

<table>
<thead>
<tr>
<th>Download Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF</td>
<td>report output in Adobe Acrobat format (PDF format).</td>
</tr>
<tr>
<td>Excel Data</td>
<td>a format used mainly for tabular or listing reports. The appearance is not always faithful to the original report and does not work well for complex reports. Potential issues include images and graphs that do not open, data that is difficult to read against some background colors, and the loss of accuracy for component positioning.</td>
</tr>
<tr>
<td>Excel Display</td>
<td>a format that resembles an Actuate report on an Excel spreadsheet.</td>
</tr>
<tr>
<td>RTF</td>
<td>report output in Rich Text Format. The report’s visual layout is similar to browser (DHTML) layout.</td>
</tr>
<tr>
<td>Fully Editable RTF</td>
<td>report output in Rich Text Format, with more flexibility when manipulating output. For example, you can move and delete several lines from a report at one time. This format produces a larger RTF file than RTF format.</td>
</tr>
</tbody>
</table>

**b Page Range:** – Select a page range option.

<table>
<thead>
<tr>
<th>Page Range Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Print all pages.</td>
</tr>
<tr>
<td>Current Page</td>
<td>Print page that currently appears.</td>
</tr>
<tr>
<td>Pages</td>
<td>Type page numbers to print.</td>
</tr>
</tbody>
</table>

3 To view the report, click View. To save the report, click Save. A separate dialog box opens that lets you view or save the report page(s) in the format you selected.
Options for Downloading

When you download a report, the option you select determines the report’s appearance. This section provides an example of how one report, the Asset Cost Rollup Report, opens differently depending on the download option (PDF, Excel Data, Excel Display, RTF, or Fully Editable (RTF) that you select.

For detailed information about each download option, see the previous section, “Downloading a Report”.

Asset Cost Rollup Report in PDF Format

<table>
<thead>
<tr>
<th>Description</th>
<th>New YTD Cost</th>
<th>Previous YTD Costs</th>
<th>Budget Costs</th>
<th>New Total Cost</th>
<th>Previous Total Cost</th>
<th>New Labor Cost</th>
<th>New Material Cost</th>
<th>New Tool Cost</th>
<th>New Service Costs</th>
</tr>
</thead>
<tbody>
<tr>
<td>HVAC System - 50 Ton Chiller</td>
<td>1,307.45</td>
<td>725.45</td>
<td>1,500.00</td>
<td>13,707.45</td>
<td>13,133.45</td>
<td>0.00</td>
<td>504.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Reciprocating Compressor - Air</td>
<td>5,000.00</td>
<td>4,955.00</td>
<td>2,000.00</td>
<td>7,755.00</td>
<td>27,385.00</td>
<td>0.00</td>
<td>144.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Boiler - 50,000 Unit Gas Fired Water Tube</td>
<td>4,900.00</td>
<td>4,900.00</td>
<td>5,000.00</td>
<td>114,755.00</td>
<td>114,755.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Centrifugal Pump 100GPM/250FT-HP</td>
<td>5,750.00</td>
<td>122.00</td>
<td>1,000.00</td>
<td>10,851.00</td>
<td>11,334.00</td>
<td>0.00</td>
<td>47,172.00</td>
<td>0.00</td>
<td>600.00</td>
</tr>
<tr>
<td>Centrifugal Pump 100GPM/250FT-HP</td>
<td>362.00</td>
<td>241.00</td>
<td>1,000.00</td>
<td>375.83</td>
<td>234.58</td>
<td>0.00</td>
<td>141.97</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Burner, Gas Fired - For Boiler</td>
<td>37.00</td>
<td>37.00</td>
<td>0.00</td>
<td>37.00</td>
<td>37.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Gear Pump 102 GPM, 03 FT-HP</td>
<td>706.00</td>
<td>706.00</td>
<td>1,200.00</td>
<td>7,855.00</td>
<td>7,855.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Gear Pump 102 GPM, 03 FT-HP</td>
<td>500.54</td>
<td>900.54</td>
<td>1,200.00</td>
<td>5,543.95</td>
<td>5,543.95</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
### Asset Cost Rollup Report in Excel Data Format

This report displays the costs the asset incurred since the date the report was last run. The costs of the assets are rolled up to their parents, and any other levels in the asset hierarchy.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>HVAC System, 50 Ton Cool Cap</td>
<td>1,207.45</td>
<td>723.45</td>
<td>1,500.00</td>
<td>13,707.45</td>
<td>13,123.45</td>
<td>0.00</td>
<td>564.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Reciprocating Compressor, Air Compress 100 CFM</td>
<td>5,099.00</td>
<td>4,865.00</td>
<td>3,000.00</td>
<td>27,599.00</td>
<td>27,385.00</td>
<td>0.00</td>
<td>164.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Boiler, 50,000 Lb/Hr Gas Fired Water Tube</td>
<td>4,965.00</td>
<td>4,865.00</td>
<td>5,000.00</td>
<td>114,765.00</td>
<td>114,765.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Centrifugal Pump 100GPM/600FT Head</td>
<td>5,739.00</td>
<td>122.00</td>
<td>1,520.00</td>
<td>18,851.56</td>
<td>11,234.56</td>
<td>0.00</td>
<td>4,717.00</td>
<td>0.00</td>
<td>900.00</td>
</tr>
<tr>
<td>Centrifugal Pump 1000GPM/3000FT/150</td>
<td>302.07</td>
<td>241.00</td>
<td>1,600.00</td>
<td>375.63</td>
<td>234.56</td>
<td>0.00</td>
<td>141.07</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Burner, Oxy-Fuel, For Boiler</td>
<td>37.00</td>
<td>37.00</td>
<td>0.00</td>
<td>37.00</td>
<td>37.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
### Asset Cost Rollup Report in Excel Display Format

This report displays the costs the asset incurred since the date the report was last run. The costs of the assets are rolled up to their parents, and any other levels in the asset hierarchy.

<table>
<thead>
<tr>
<th>Asset Cost Rollup</th>
<th>New YTD Cost</th>
<th>Previous YTD Costs</th>
<th>Budget Costs</th>
<th>New Total Cost</th>
<th>Previous Total Costs</th>
<th>New Labor Cost</th>
<th>New Material Cost</th>
<th>New Total Cost</th>
<th>New Service Costs</th>
</tr>
</thead>
<tbody>
<tr>
<td>HVAC System: 60 Ton</td>
<td>1,087.45</td>
<td>723.45</td>
<td>150.00</td>
<td>13,782.45</td>
<td>13,238.45</td>
<td>0.00</td>
<td>554.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Refrigerating Compressors: Air Cooled</td>
<td>5,050.00</td>
<td>2,050.00</td>
<td>3,000.00</td>
<td>27,505.00</td>
<td>27,205.00</td>
<td>0.00</td>
<td>94.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Boiler 50,000 Btu/hr Fire Fired Water Tube</td>
<td>4,085.00</td>
<td>2,085.00</td>
<td>5,000.00</td>
<td>14,265.00</td>
<td>14,265.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Centrifugal Pump 100 GPM/900Ft TD</td>
<td>5,728.00</td>
<td>2,728.00</td>
<td>1,000.00</td>
<td>16,928.00</td>
<td>16,294.00</td>
<td>0.00</td>
<td>4,700.00</td>
<td>0.00</td>
<td>980.00</td>
</tr>
<tr>
<td>Centrifugal Pump 100 GPM/900Ft TD</td>
<td>102.00</td>
<td>24.00</td>
<td>100.00</td>
<td>375.60</td>
<td>375.60</td>
<td>0.00</td>
<td>61.07</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Burner Gas Fired For Boiler</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Centrifugal Pump 100 GPM/900Ft TD</td>
<td>790.00</td>
<td>790.00</td>
<td>1,000.00</td>
<td>7,980.00</td>
<td>7,585.06</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Centrifugal Pump 100 GPM/900Ft TD</td>
<td>863.54</td>
<td>863.54</td>
<td>1,750.00</td>
<td>6,543.96</td>
<td>5,736.06</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

### Asset Cost Rollup Report in RTF Format

This report displays the costs the asset incurred since the date the report was last run. The costs of the assets are rolled up to their parents, and any other levels in the asset hierarchy.

<table>
<thead>
<tr>
<th>Asset Cost Rollup</th>
<th>New YTD Cost</th>
<th>Previous YTD Costs</th>
<th>Budget Costs</th>
<th>New Total Cost</th>
<th>Previous Total Costs</th>
<th>New Labor Cost</th>
<th>New Material Cost</th>
<th>New Total Cost</th>
<th>New Service Costs</th>
</tr>
</thead>
<tbody>
<tr>
<td>HVAC System: 60 Ton</td>
<td>1,087.45</td>
<td>723.45</td>
<td>150.00</td>
<td>13,782.45</td>
<td>13,238.45</td>
<td>0.00</td>
<td>554.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Refrigerating Compressors: Air Cooled</td>
<td>5,050.00</td>
<td>2,050.00</td>
<td>3,000.00</td>
<td>27,505.00</td>
<td>27,205.00</td>
<td>0.00</td>
<td>94.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Boiler 50,000 Btu/hr Fire Fired Water Tube</td>
<td>4,085.00</td>
<td>2,085.00</td>
<td>5,000.00</td>
<td>14,265.00</td>
<td>14,265.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Centrifugal Pump 100 GPM/900Ft TD</td>
<td>5,728.00</td>
<td>2,728.00</td>
<td>1,000.00</td>
<td>16,928.00</td>
<td>16,294.00</td>
<td>0.00</td>
<td>4,700.00</td>
<td>0.00</td>
<td>980.00</td>
</tr>
<tr>
<td>Centrifugal Pump 100 GPM/900Ft TD</td>
<td>102.00</td>
<td>24.00</td>
<td>100.00</td>
<td>375.60</td>
<td>375.60</td>
<td>0.00</td>
<td>61.07</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Burner Gas Fired For Boiler</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Centrifugal Pump 100 GPM/900Ft TD</td>
<td>790.00</td>
<td>790.00</td>
<td>1,000.00</td>
<td>7,980.00</td>
<td>7,585.06</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Centrifugal Pump 100 GPM/900Ft TD</td>
<td>863.54</td>
<td>863.54</td>
<td>1,750.00</td>
<td>6,543.96</td>
<td>5,736.06</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Using Maximo Reports
### Asset Cost Rollup Report in Fully Editable RTF Format

This report displays the costs the asset incurred since the date the report was last run. The costs of the assets are rolled up to their parents, and any other levels in the asset hierarchy.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>112389</td>
<td>3,077.45</td>
<td>732.45</td>
<td>1,500.00</td>
<td>13,707.45</td>
<td>13,707.45</td>
<td>0.00</td>
<td>584.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>11389</td>
<td>5,000.00</td>
<td>4,000.00</td>
<td>2,000.00</td>
<td>27,000.00</td>
<td>27,000.00</td>
<td>0.00</td>
<td>144.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>11485</td>
<td>4,885.00</td>
<td>4,885.00</td>
<td>5,000.00</td>
<td>114,785.00</td>
<td>114,785.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>11483</td>
<td>5,738.00</td>
<td>1,220.00</td>
<td>1,500.00</td>
<td>16,538.00</td>
<td>11,254.56</td>
<td>0.00</td>
<td>4,717.00</td>
<td>0.00</td>
<td>900.00</td>
</tr>
<tr>
<td>11489</td>
<td>392.07</td>
<td>241.00</td>
<td>1,000.00</td>
<td>375.03</td>
<td>254.50</td>
<td>0.00</td>
<td>141.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>11489</td>
<td>37.00</td>
<td>37.00</td>
<td>0.00</td>
<td>37.00</td>
<td>37.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>11488</td>
<td>728.00</td>
<td>700.00</td>
<td>1,300.00</td>
<td>7,885.08</td>
<td>7,885.08</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>12233</td>
<td>868.54</td>
<td>860.54</td>
<td>1,750.00</td>
<td>6,543.86</td>
<td>6,543.86</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>13185</td>
<td>888.48</td>
<td>878.98</td>
<td>1,500.00</td>
<td>4,927.50</td>
<td>4,927.50</td>
<td>0.50</td>
<td>111.50</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
Searching within a Report for a Specific Record

For some reports, you might want to isolate specific records. To find specific records in a lengthy report, use the Search function in Actuate.

In the following example, you search the Asset Move History report to locate all search results from the REPAIR location. To search for this data in a report, complete the following steps:

1. In the Assets application, open the Asset Move History report.

2. On the Reporting Toolbar in Maximo, click the Search icon to open the Search panel on the left side of the report page.

---

**Asset Move History Report with New Search Panel**

<table>
<thead>
<tr>
<th>Date Moved</th>
<th>From Site</th>
<th>From Location</th>
<th>From Parent</th>
<th>To Site</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/29/2015</td>
<td>BEDFORD</td>
<td>CENTRAL</td>
<td>11400</td>
<td>BBFC</td>
</tr>
<tr>
<td>5/26/2014</td>
<td>BEDFORD</td>
<td>CENTRAL</td>
<td>11400</td>
<td>BBFC</td>
</tr>
<tr>
<td>2/11/2014</td>
<td>BEDFORD</td>
<td>JOHNSTOWN</td>
<td>BBFC</td>
<td>BBFC</td>
</tr>
<tr>
<td>2/11/2014</td>
<td>BEDFORD</td>
<td>REPAIR</td>
<td>BBFC</td>
<td>BBFC</td>
</tr>
<tr>
<td>5/28/2014</td>
<td>BEDFORD</td>
<td>11400</td>
<td>BBFC</td>
<td>BBFC</td>
</tr>
<tr>
<td>5/26/2014</td>
<td>BEDFORD</td>
<td>11400</td>
<td>BBFC</td>
<td>BBFC</td>
</tr>
</tbody>
</table>

---
3 Add the **From Location** field search query by clicking data in that column. In the following figure, you selected all search criteria from the REPAIR location.

**NOTE** You can also choose to search on multiple fields.

---

**Asset Move History Report with Search Criteria**

![Asset Move History Report with Search Criteria](image)

4 Click **Search Now** to search on the criteria you entered. The filtered records appear as a link in the Search panel.

**Asset Move History Report with Value Returned from Search Criteria**

![Asset Move History Report with Value Returned from Search Criteria](image)

5 To jump to the report page containing the relevant data, click a result link. Result links appear underlined in the search panel.
NOTE In addition to searching for one match, you also can use search expressions to find a set of matches. Maximo supports several operators and wildcard characters that you can use in search expressions.

You can use the following operators:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ]</td>
<td>Comma to separate values.</td>
</tr>
<tr>
<td>[=]</td>
<td>Equal. By default, the equal operator is implied.</td>
</tr>
<tr>
<td>[&gt;]</td>
<td>greater than or alphabetically after.</td>
</tr>
<tr>
<td>[&gt;=]</td>
<td>Greater than or equal to.</td>
</tr>
<tr>
<td>[-]</td>
<td>Hyphen to indicate ranges.</td>
</tr>
<tr>
<td>[&lt;]</td>
<td>Less than or alphabetically before.</td>
</tr>
<tr>
<td>[&lt;=]</td>
<td>Less than or equal to.</td>
</tr>
<tr>
<td>[!]</td>
<td>Not</td>
</tr>
</tbody>
</table>

You can use the following global wildcard characters:

<table>
<thead>
<tr>
<th>Character</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>[*]</td>
<td>Find any number of characters.</td>
</tr>
<tr>
<td>[#]</td>
<td>Find any one ASCII numeric character.</td>
</tr>
<tr>
<td>[?]</td>
<td>Find any one character.</td>
</tr>
</tbody>
</table>
Adding and Removing a Search Field

Some reports are lengthy due to their queries. To find specific information in a lengthy report, use the Search function in Actuate.

In the following example, you search the Asset Move History report to locate all search results from the REPAIR location. To search for this data in a report, complete the following steps:

1. Open an Asset Move History report. In this example, the Asset Move History report is for asset 11430.

2. On the Reporting Toolbar, click the icon to open the Search panel.

3. To add a report field to your search, click data in the report and enter a value in the Value column that appears in the Search panel.

For example, to search for asset 11430 in the Repair location only, complete the following steps:

a. Click a value in the From Location column

b. Type Repair in the Value field that appears.

c. Click Search Now.
Using Maximo Reports

Adding and Removing a Search Field

4. You can remove a field from the search in two ways:

   ▼  Click a data field in the report, again.

   ▼  Click the Remove Item from List icon next to the field in the Search pane.

   The Search column no longer appears in the Search list.

Using Maximo Reports 3-27
To remove all search fields, click **New Search**.

**Asset Move History Report with New Search Indicated**
Running a Query

In the following example, you run a query to create a Work Order Start and Finish Dates Report by user Wilson.

1. Click the Queries tab.
2. From the Maximo Start Center, select **Work Orders>Work Order Tracking** to open the Work Order Tracking application.
3. Select **Run Reports** from the Select Action menu to open the Business Analysis and Reporting dialog box.
4. To display a list of queries in this application, click the Queries tab.

**Business Analysis and Reporting Dialog Box (Queries Tab)**
Running a Query

5 In the Run Query subtab, select the Work Orders Overdue by Location query to open the Request Page dialog box. Type a location and site or click the Select Value icon with either field to open a dialog box containing available values.

6 To run the query, click Submit.

Request Page Dialog Box (Run Report Tab)
Customizing a Query

After you select a query in Maximo and click **Submit**, a series of five tabs opens. Each tab gives you a different way to customize your report.

**Query Tabs and Descriptions Table**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>Select the fields to appear on the report.</td>
</tr>
<tr>
<td>Groups</td>
<td>Specify how to group information on the report.</td>
</tr>
<tr>
<td>Sorting</td>
<td>Indicate whether the groups selected should open in ascending or descending order.</td>
</tr>
<tr>
<td>Filters</td>
<td>Select any customer filters. This page defaults to the parameters you entered on the request page.</td>
</tr>
<tr>
<td>Finish</td>
<td>Selecting a format for your report:</td>
</tr>
<tr>
<td></td>
<td>◀ browser (DHTML)</td>
</tr>
<tr>
<td></td>
<td>◀ Excel</td>
</tr>
<tr>
<td></td>
<td>◀ PDF</td>
</tr>
</tbody>
</table>

You also use this tab to save your query.

**NOTE** To print, download, or search a report you MUST open your query in browser (DHTML) format on the Finish tab.

In the following section, you will create a Work Order Start and Finish Date Query.

To create this query, complete the following steps:
1 After you select the query (the Work Order Start and Finish Dates Query) in Maximo, the Content tab opens. On the Content tab, select the following columns to appear on your query:

- Work Order
- Work Order Description
- Scheduled Start
- Scheduled Finish

Work Order Start and Finish Date Query (Content Tab)

Choose the fields to include to your query.

Available Columns

- Work Order Type
- Class
- Status
- Work Order Priority
- Asset
- Asset Description
- Lead Craft
- Supervisor
- Job Plan
- Remaining Duration
- Actual Start
- Target Start
- Target Completion

Selected Columns

- Work Order
- Work Order Description
- Schedule Start
- Schedule Finish

Preview  Cancel  Back  Next  Finish
2 To select the Groups Tab, click Next.

3 On the Groups tab, select the following groups to appear on your Work Order Start and Finish Dates query:
   ▼ Schedule Start as your Level 1 Group
   ▼ Schedule Finish as your Level 2 Group

Work Order Start and Finish Date Report (Groups Tab)
Customizing a Query

4 To select the Sorting tab, click Next.

5 On the Sorting tab, use the drop-down list to select the following sort order:
   ▼ Ascending for Schedule Start
   ▼ Ascending for Schedule Finish

**Work Order Start and Finish Dates Report (Sorting Tab)**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Specify the sort order.</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Groups</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schedule Start</td>
<td></td>
<td>Ascending</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schedule Finish</td>
<td></td>
<td>Ascending</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Detail</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ascending</td>
</tr>
</tbody>
</table>
6. To select the Filters Tab, click **Next**.

7. To include any custom filters, use the **Custom Filters** text boxes to select specifications that further refine your search.

**NOTE** The **Location** and **Site** fields default to the values you selected in the Request Page (see page 3-30).

### Filters Tab for Work Orders Start and Finish Dates Report

<table>
<thead>
<tr>
<th>Content</th>
<th>Groups</th>
<th>Sorting</th>
<th>Filters</th>
<th>Finish</th>
</tr>
</thead>
</table>

Enter values for the predefined filters and custom filters.

- **Predefined Filters (Parameters)**
  - Location: BR430
  - Site: BEDFORD

- **Custom Filters**

```plaintext
= =
```

![Filters Tab Diagram](image-url)
Customizing a Query

8 To select the Finish tab, click **Next**.

9 On the Finish tab, enter or accept the values in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Header</td>
<td>Enter a title for the query. The title appears at the top of the report when users run it.</td>
</tr>
<tr>
<td>Output Format</td>
<td>The default output format is Browser (DHTML).</td>
</tr>
<tr>
<td>Query Name</td>
<td>If you want to save the query, you must enter a name for the query.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a unique query description to appear in the View Queries section of the Queries tab in Maximo. If you do not enter a description, the Query Name appears to the user as the Description.</td>
</tr>
</tbody>
</table>

**NOTE** To print, download, or search a report, you MUST open your query in browser (DHTML) format.

*Work Order Start and Finish Dates Report (Finish Tab)*

|------------|-----------|------------|------------|-----------|

**Finish your query, choose output format and save the query (optional).**

- **Page header:** Work Order Start and Finish Dates
- **Output format:**
  - Browser (DHTML)
  - Excel
  - PDF
- **Query name:** Wilson's Work Order Start and Finish Dates
- **Description:** Work Order Start and Finish Dates Query by Wilson

[Save Query]
To run the report, click **Run**. The report appears in the output format you selected.

You have created a query on Work Order Start and Finish Dates.

**Work Order Start and Finish Dates Report in Browser DHTML Format**

<table>
<thead>
<tr>
<th>Work Order</th>
<th>Schedule Start</th>
<th>Schedule Finish</th>
<th>Work Order Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31150</td>
<td>11/24/2001</td>
<td>11/25/2001</td>
<td>11480 get work</td>
</tr>
</tbody>
</table>
Customizing a Query
Creating Spreadsheet Reports

Overview

Business users can use Maximo eSpreadsheet to create reports in spreadsheet format quickly. You can create a report with formatting, and then, you can add graphs, headers, footers, and other spreadsheet-type features.

This chapter describes the following topics related to Maximo eSpreadsheet Designer:

- installing Maximo eSpreadsheet Designer
- setting up a JDBC™ Connection
- creating a Maximo eSpreadsheet Designer Report using the Report Range Wizard
- modifying the SQL query
- creating a parameter
- defining a parameter
- linking related tables through joins
- running the report locally (as a test)
- finding information on additional topics
- finding information on advanced topics

Installing Maximo eSpreadsheet Designer

You must install Maximo eSpreadsheet Designer on a client computer with a JDBC connection to the iServer.

To install and configure Maximo eSpreadsheet Designer on a client computer, accept all default values during installation.
Setting Up a JDBC Connection

The following section describes how to set up your JDBC Connection in Data Manager. To check your JDBC connection, complete the following steps:


   **NOTE** For more information about PMD, see your *IBM Maximo Installation Guide*.

2. Shut down Maximo e.Spreadsheet Designer on your client computer.

3. On the machine where you installed Maximo, go to the following location in Maximo root:
   
   `\applications\activeportal\WEB-INF\lib`

   If you are running Maximo against an Oracle® or Microsoft SQL Server database™, go to Step 4. If you are running Maximo against an IBM DB2® Universal Database 8.2.7, go to Step 5.

4. Copy `oraclethin.jar` (Oracle) or `opta.jar` (Microsoft SQL Server) to the following locations:

   **On your . . .**  
   **copy to . . .**  
   client computer  
   \eSpreadsheet\extensions  
   Actuate Report Server  
   \iServer\eSpreadsheet\extensions

   Skip to Step 6.

5. Copy `db2jcc.jar` and `db2jcc_license_cu.jar` to the following locations:

   **On your . . .**  
   **copy to . . .**  
   client computer  
   \eSpreadsheet\extensions  
   Actuate Report Server  
   \iServer\servletcontainer\webappps\acrsse\Web-INF\lib

6. On your Actuate Report Server, restart the PMD Service.

7. Open Maximo eSpreadsheet Designer and select JDBC Connections. If you do not set up your JDBC Connection properly, you receive an error message.
Creating a Report

The following section describes how to create a report using the Report Range Wizard in Maximo eSpreadsheet Designer. The following example shows you how to create a Work Order by Labor Cost report. Your report also will include groupings by status, location, and site.

To create the example report, complete the following steps:

1. Go to the Start menu and choose Programs/Actuate 8/Actuate e.Spreadsheet Designer to open Maximo eSpreadsheet Designer.

2. Select Data>Report Range Wizard to open the Report Range Wizard – Step 1 of 8 dialog box. Accept the default.

   **Report Range Wizard – Step 1 of 8 Dialog Box**

3. Click Next to open the Step 2 of 8 dialog box.

   **Report Range Wizard – Step 2 of 8 Dialog Box**

   - What query do you want to use?
     - Name
     - Type
     - Details
     - Add Connection
     - Edit
     - Remove

   - ODBC Connections
   - JDBC Connections
   - File/URL Connections
   - SAP Connection
   - XML Connection
   - Actuate Data Integration Service Connection
Creating a Report

4 Select JDBC Connections. Click Add Connection to open the JDBC Connection dialog box.

5 Enter data in the four fields on the connection tab. The information you enter is in the Database Properties section of the MAXIMO.PROPERTIES file (property names indicated in parentheses after each field).

<table>
<thead>
<tr>
<th>Field</th>
<th>Oracle</th>
<th>SQL Server</th>
<th>IBM DB2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Driver Class Name</strong> (mxe.db.driver)</td>
<td>oracle.jdbc.driver. OracleDriver</td>
<td>com.inet.tds.TdsDriver</td>
<td>com.ibm.db2.jcc.DB2Driver</td>
</tr>
<tr>
<td></td>
<td>where</td>
<td>where</td>
<td>where</td>
</tr>
<tr>
<td></td>
<td>▼ &lt;dbserver&gt; is the name of your database server.</td>
<td>▼ &lt;servername&gt; is your database server name.</td>
<td>▼ &lt;host name&gt; is your database server name.</td>
</tr>
<tr>
<td></td>
<td>▼ 1521 is your default Oracle port number.</td>
<td>▼ 1433 is your default SQL Server port number.</td>
<td>▼ 50000 is your default IBM DB2 port number.</td>
</tr>
<tr>
<td></td>
<td>▼ &lt;sid&gt; is your Oracle system identifier.</td>
<td>▼ &lt;databasename&gt; is your SQL Server database name.</td>
<td>▼ &lt;database alias&gt; is the name you use to refer to the IBM DB2 database.</td>
</tr>
<tr>
<td><strong>User Name</strong> (mxe.db.user)</td>
<td>Enter the database user whom the server uses to attach to the database server. The default is maximo.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Password</strong> (mxe.db.password)</td>
<td>Enter the password for the username of the database schema owner. The default is maximo</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** You can put 7 (supports Unicode) or 7a (supports ascii) after the string jdbc:inetdae. Currently, Maximo supports only ascii for SQL server.
6 To accept your changes, click **Apply**.

7 To reopen the Step 2 of 8 dialog box, click **OK**.

8 Click **Add Query** to open the Query Type dialog box.

9 Select **SELECT Statement**. To open the Show Tables dialog box, click **OK**.

*Show Tables Dialog Box (Tables Tab)*
10 Select the table (WORKORDER) which stores the data for this report. Click **Add**, then **Close** to open the Query Editor Dialog box.

**NOTE.** If no tables open, click the plus sign (+) icon to open a Show Tables window.
11 Add the WONUM column to the query by either scrolling to it and double-clicking or dragging-and-dropping it to the lower pane.

12 Repeat the previous step for each of the following fields:
   ▼ STATUS
   ▼ ACTLABCOST
   ▼ SITEID
   ▼ LOCATION
   ▼ ASSETNUM

13 Click Close to open the Save Query dialog box.

14 Click Yes to save the query. The Step 2 of 8 dialog box reopens.

15 Click Next to open the Step 3 of 8 dialog box.

**Report Range Wizard – Step 3 of 8 Dialog Box**

16 Indicate where you want to see the results on an existing worksheet or on a new worksheet.

If you use the default setting, the Report Range Wizard places the report on the upper left corner of the spreadsheet.
17 Click Next to open the Step 4 of 8 dialog box.

*Report Range Wizard – Step 4 of 8 Dialog Box*

<table>
<thead>
<tr>
<th>Field</th>
<th>Sort Order</th>
<th>Grouped</th>
</tr>
</thead>
<tbody>
<tr>
<td>SITEID</td>
<td>Ascending</td>
<td></td>
</tr>
<tr>
<td>LOCATION</td>
<td>Ascending</td>
<td></td>
</tr>
<tr>
<td>ASSETNUM</td>
<td>Ascending</td>
<td></td>
</tr>
</tbody>
</table>

18 You can sort data in ascending or descending order. You can also determine the report grouping structure.

For the Workorder by Labor Cost report, click the drop-down arrow to select a field and complete the columns as indicated:

- **SITEID** – sort this field in ascending order and group items together
- **LOCATION** – sort this field in ascending order and group items together
- **ASSETNUM** – sort this field in ascending order
19 Click **Next** to open the Step 5 of 8 dialog box.

Use the Step 5 of 8 dialog box to hide or reorder the remaining report fields. Maximo displays the fields on the report in the same order that you list them in the **Selected fields** list box.

*Report Range Wizard – Step 5 of 8 Dialog Box*
Creating a Report

20 If you do not want to move any fields, or after you move one or more fields, click **Next** to open the Step 6 of 8 dialog box.

*Report Range Wizard – Step 6 of 8 Dialog Box*

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTLABCOST</td>
<td>Sum</td>
<td>0.00</td>
</tr>
<tr>
<td>ASSETNJM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WONUM</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Specify the type and formatting of subtotal calculations. For the Workorder by Labor Cost report, select to have the sum of the actual labor cost calculated in a two-decimal format.

21 Specify the type and formatting of subtotal calculations. For the Workorder by Labor Cost report, select to have the sum of the actual labor cost calculated in a two-decimal format.
22 Click **Next** to open the Step 7 of 8 dialog box.

**Report Range Wizard – Step 7 of 8 Dialog Box**

![Report Range Wizard - Step 7 of 8](image)

Click **Next** to open the Step 7 of 8 dialog box.
Creating a Report

23 Choose from several predefined report layouts. Accept the default for the Workorder by Labor Cost Report by clicking Next to open the Step 8 of 8 dialog box.

Report Range Wizard – Step 8 of 8 Dialog Box

24 Use the Step 8 of 8 dialog box to define the style and color for the report. Accept the default for the Workorder by Labor Cost Report.
25 Click **Finish** to view the report.

**e. Spreadsheet Designer with Actual Labor Cost by Work Order Number Report**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SITEID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>BEDFORD</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>BPM3100</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>1015-60</td>
<td>COMP</td>
<td>13140</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>3011-40</td>
<td>WSCH</td>
<td>13141</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>3006-80</td>
<td>WSCH</td>
<td>13150</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>6006</td>
<td>WAPP</td>
<td>13143</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>31305</td>
<td>CLOSE</td>
<td>13180</td>
<td>94.76</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>2005</td>
<td>CLOSE</td>
<td>13145</td>
<td>50.20</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>3011-30</td>
<td>WSCH</td>
<td>13141</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>144.96</strong></td>
</tr>
</tbody>
</table>

26 To view the report in Spreadsheet mode, click the Toggle Spreadsheet/Design View icon.
Modifying the SQL Query

You can modify the original query in Maximo eSpreadsheet Designer by adding groupings, additional sort orders and filters, and adding other tables. This section describes how to open those tabs that let you change the SQL Query.

To modify the SQL Query, complete the following steps:

1. Open a spreadsheet in Maximo eSpreadsheet Designer.

2. Click the Toggle Spreadsheet/Design View icon to change the spreadsheet to Design mode.

---

**eSpreadsheet Designer in Design Mode View**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SITEID</td>
<td>LOCAL STATUS</td>
<td>ASSET ACT</td>
<td>Range</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>=SITEID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>=LOCATION</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>=STATUS</td>
<td>=ASSET ACT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Locate the</td>
<td>=SUBTOTAL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

IBM Maximo: Report Administration and Development Guide
3. To open the Data Manager dialog box, select **Data>Data Manager**.

**Data Manager Dialog Box**

- Select **Query1**. Click **Edit** to open the Query Editor pane.

4. Select **Query1**. Click **Edit** to open the Query Editor pane.
The following table describes the tabs in the Query Editor.

**Query Editor Tabs Table**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design</td>
<td>Select tables and views.</td>
</tr>
<tr>
<td>Fields</td>
<td>Change column and field types.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Work with report parameters.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the results of the query.</td>
</tr>
<tr>
<td>Properties</td>
<td>Set name and schema properties for the query.</td>
</tr>
<tr>
<td>SQL</td>
<td>Enter or edit the SQL statement.</td>
</tr>
</tbody>
</table>

**Query Editor (Design Tab)**

![Query Editor (Design Tab) Screenshot](image-url)
Linking Related Tables through Joins

Maximo eSpreadsheet Designer links related tables through joins. This section describes how to create a join.

A join is an SQL query operation that combines two tables and returns them in a result set based on the values in the join fields.

You continue with the Work Order by Labor Cost Report you created in the previous section. The join you create will be from the Location field in the WORKORDER table to the Location field in the LOCATIONS table.

1. On the Query Editor dialog box, click the Display Show Tables dialog box to Add a Table to the Query icon.

**Query Editor Dialog Box (Design Tab)**

Display show tables dialog box to add a table to the query

The Show Tables dialog box opens with the Tables tab.
2 Highlight the LOCATIONS table. Click Add, and then click Close. The LOCATIONS table opens, with the WORKORDER table from the previous section, in the QUERY EDITOR dialog box.

Query Editor Dialog Box with Joined Tables
To join the tables, highlight a field in one table and drag it to the same field in another table. For example, use LOCATION to join the WORKORDER and LOCATIONS tables.

You can make additional joins either from the same tables or add other tables as necessary.

To view the details of the join, double-click the connecting line to open the Join Properties dialog box.

NOTE You must select the correct type of database join to ensure your report returns the correct data. If you have any questions about your join, contact your database or system administrator.

To return to the Query Editor dialog box, click OK.

Click Close to open the eSpreadsheet Designer dialog box.

Click Yes to save the query. You have linked two related query tables together through a join.
Modifying the Report

You can change the appearance of a report by formatting cells and using conditional formatting.

Format Actions

Use the format actions available in the toolbar to format your report to your individual needs.

Conditional Formats

Conditional Formatting enables you to assign conditions, colors, and text attributes to a cell. For this example, you will continue with the Work Order by Labor Cost Report you created previously in this chapter.

1. In Maximo eSpreadsheet Designer, in design view, open the Work Order by Labor Cost Report.
2. Highlight the ACTLABCOST column.
3. Select Format>Conditional to open the Conditional Formats dialog box.
4. In the Conditions tab, click Add to enable the values in the Criteria section of this dialog box.
5. Complete the following actions in order:
   a. Select Cell Value.
   b. From the Cell Value drop-down list, select less than or equal to.
   c. Type 5000.
   d. Click Apply to accept these changes.
6. Select the Fill tab.
7. Select Solid and select a fill color for Actual Labor Costs that meets the condition you specified in Step 5.
8. Click Apply to set this Fill condition.
9. Click OK to close the dialog box.

You have assigned a fill color.
Creating a Parameter

Parameters let you pass data into a spreadsheet report. The information you supply to the parameters lets you customize the published report so you can control the data selection, processing, and/or formatting.

There are two types of parameters:

- Ad hoc Parameters – can be omitted when you run the report
- Static Parameters – must be entered when you run the report

To add the static parameter SITE to the SITEID column of a spreadsheet report, complete the following steps:

1. In Maximo eSpreadsheet Designer, select Data>Data Manager to open the Data Manager dialog box.

Data Manager Dialog Box

![Data Manager Dialog Box](image)
Creating a Parameter

2. Highlight Query1. Click **Edit** to open the Query Editor dialog box.

*Query Editor Dialog Box (Design Tab) with Static Parameter Indicated*
3 Locate the field you want to use as a parameter. In the Criteria row, enter one of the following types of parameters where `<parameter>` is the text to appear to the end user:

- `?:<parameter>` for an ad hoc parameter that defaults the corresponding where clause to TRUE if no parameter is entered
- `!:<parameter>` for an ad hoc parameter that defaults the corresponding where clause to FALSE if no parameter is entered
- `:<parameter>` for a static parameter

In the figure shown, you enter the static parameter SITE in the criteria row of the SITEID column. When end users run the report, Maximo eSpreadsheet Designer will prompt them with the word SITE. End users must enter a site to for the system to generate the report.

4 Click Close to close the Query Editor Dialog Box. The e.Spreadsheet Designer dialog box opens.

5 Click Yes to save the query.

If you receive an error message that the parameter is not defined, follow the instructions in the next section of this chapter.
Defining a Parameter

When you add a parameter to a report, as described in the previous section, “Creating a Parameter,” that parameter must be defined. If the parameter is not yet defined, Maximo eSpreadsheet Designer displays an error message.

To define a parameter, complete the following steps:

1. In the Maximo eSpreadsheet Designer dialog box, click **OK** to open the Parameters tab in the Query Editor.

2. Enter a valid value in the Parameters tab for the undefined parameter. For example, enter Bedford as a valid site.

3. Click **Close** to return to the Design Tab and save the query.

4. Click **Yes** to save the query.

You have defined a parameter.
Running the Report Locally (as a Test)

After you create a report, you should run it locally to test it before posting it on the iServer for all users. To run a report locally, complete the following steps:


   ![Run Report Page]

2. The system prompts you for any parameters you assigned. Enter a parameter value.

3. Click OK to run the report.

Finding Information on Additional Topics

Refer to the Designing Spreadsheet Reports using Actuate e.Spreadsheet Designer manual from Actuate Corporation for information about these additional topics:

- Defined Names
- Graphics
- Multiple Queries
- Pivot Ranges
- Virtual Defined Names

Finding Information on Advanced Topics

Refer to the Programming Spreadsheet Reports using e.Spreadsheet Technology from Actuate Corporation for information about these advanced topics:

- Callback Classes
- XSL Stylesheets
Maximo Query enables business users to develop customized reports. Business users can select fields and then specify sorting, filtering, grouping, and formatting to meet their needs.

To develop a query report, you must have installed e.Report Designer Professional on your local computer.

This chapter explains how to perform the following tasks:

- create query report
- using textual query editor
- set up global parameters
- post to an iServer Encyclopedia

This chapter also contains the following tips on Creating Queries:

- add parameters
- modify display names with the same label
- rename labels (by remaining columns) in the Textual Query Editor
- change column names for end users

### Creating Query Reports

Report Developers and Business Users use e.Report Designer Professional to create query (.rod) design. The .rod files specify the content of a finished query and are compiled to become a .dox file. Maximo End Users use the .dox files to specify information that they want to view and how the information should appear. These become .dov files. Multiple users can share the same query file (.dox) to create multiple unique query reports (.dov).

For more information on Actuate file types, see Chapter 7, “Loading and Configuring e.Report Designer Professional.”

### Maximo Query Creation Process

The query process begins when the Report Developer installs e.Report Designer Professional. The business user then creates a Query Report which is published to the report server. The Report Administrator registers and sets up access privileges in the Report Administration Application. The end user runs the query in Maximo.

The following flowchart further illustrates this process:
Maximo Query Creation Process

Maximo Query Creation Process Flowchart

Report Developer installs e.Report Designer Professional version 8

Business user creates information object (.rod file) using Textual Query Editor

Report Developer publishes information object to Report Server

Actuate 8

Maximo

Report Administrator registers information object

Report Administrator sets up Report Access Privileges

End user A develops query (.dov file)

End user B develops query (.dov file)

End user C develops query (.dov file)

End user D develops query (.dov file)

Query as defined by user A

Query as defined by user B

Query as defined by user C

Query as defined by user D

End user accesses information object through Query Tab
Creating a Query Report Object Using the Textual Query Editor

The following section describes how you can create a query report using the Maximo Query Report Template. Query reports allow you to specify which rows to retrieve from your data source. For this example, the query report you will create is the Open PM Work Order Query.

**NOTE** You must have a database connection in order to create a query report.

## Creating a Query Report Object Using the Textual Query Editor

To create a query report using the Maximo Query Report Template, complete the following steps.

1. Open e.Report Designer Professional and select **File>New** to open the Create New Report Dialog Box.

2. Select Maximo Query Report Template and click **OK** to open the template.

   If you cannot see... then select...

   **the Report Structure,** *View>Report Structure.*

   **Libraries,** *View>Libraries.*

   e.Report Designer Professional opens to the Design view.

---

### Actuate e.Report Designer Professional Dialog Box with MRO Connection Selected

![Diagram of e.Report Designer Professional Dialog Box with MRO Connection Selected](image-url)
3. To open the MRO Connection – Properties dialog box, double-click MROConnection in the Libraries panel.

Depending on whether you are running Maximo against an Oracle or SQL Server database, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>MAXIMO.PROPERTY</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host String (Oracle)</td>
<td>mxe.report.actuate.db.connectstring</td>
<td>Enter the connection string that Actuate will use to connect to the Maximo database. You must define the connection string on the machine where you run the iServer.</td>
</tr>
<tr>
<td>DataSource (SQL Server)</td>
<td>mxe.report.actuate.db.connectstring</td>
<td>Enter the Data Source Name (DSN) that Actuate will use to connect to the Maximo database. You must define the DSN on the machine where you run the iServer.</td>
</tr>
<tr>
<td>DataSource (IBM DB2)</td>
<td>mxe.report.actuate.db.connectstring</td>
<td>Enter the Database Alias that Actuate will use to connect to the Maximo database. You must define the Database Alias on the machine where you run the iServer.</td>
</tr>
<tr>
<td>Password</td>
<td>mxe.db.password</td>
<td>Enter the password for the user name of the database schema owner.</td>
</tr>
<tr>
<td>UserName</td>
<td>mxe.db.user</td>
<td>Enter the database user that the server uses to attach to the database server.</td>
</tr>
</tbody>
</table>

4. To close this dialog box, click X in its upper-right corner.

5. Open the Database Login dialog box by clicking the Data icon.

**NOTE** The remaining steps and dialog boxes in this procedure are specific to an Oracle database.

6. Enter your Oracle database user name and password.
Creating a Query Report Object Using the Textual Query Editor

7 To open the Textual Query Editor dialog box, click OK.

**Textual Query Editor Dialog Box with Describe Query and Clear Query Icons Indicated**

8 Test your database connection by typing an SQL statement. For example, type the following statement exactly as shown with no ending punctuation:

```
select * from workorder
```

9 To view the results, click the Describe Query icon.

**NOTE** If you later decide to change the width of any column, you must use the **Display Length** field on the Textual Query Editor.

10 To clear the Textual Query Editor dialog box so you can continue with Step 11, click the Clear Query icon.
Creating a Query Report Object Using the Textual Query Editor

11 To view overdue work orders, type the following SQL statement on the Textual Query Editor dialog box:

```sql
SELECT WORKORDER.WONUM, WORKORDER.DESCRIPTION, WORKORDER.ASSETNUM,
WORKORDER.LOCATION, WORKORDER.SUPERVISOR, WORKORDER.JNUM,
WORKORDER.WOPRIORITY, WORKORDER.ESTDUR, WORKORDER.TARGSTARTDATE,
WORKORDER.TARGCOMPDATE, WORKORDER.SITE_ID
FROM MAXIMO.WORKORDER WHERE WORKORDER.WORKTYPE <> 'PM'
AND WORKORDER.STATUS NOT IN ('CLOSE', 'COMP', 'CAN')
AND WORKORDER.TARGCOMPDATE<SYSDATE
AND WORKORDER.ACTFINISH IS NULL AND 1=1
```

**Note** You must add the text `AND 1=1` to the query text in the Textual Query Editor if either of the following conditions is true:

- ▼ Your query has a bound parameter.
- ▼ Your query does not have any parameters.

12 To save the query, click the Describe Query icon, then click **OK**.
Setting Up Global Vars Parameters

Before you can run the query, you must set up the Global Vars parameters for yourself or the report developer who will run it.

1. Using the query you created in the previous section, open e.Report Designer Professional and select **Tools>Parameters** to open the Parameter Editor Dialog Box.

2. Click Global Vars to open the Global Vars parameters fields.

Parameter Editor Dialog Box
3. Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ParmPassword</td>
<td>Enter your user password. If you are providing access to a report developer, enter the report developer's password.</td>
</tr>
<tr>
<td>ParmUserName</td>
<td>Enter your user password. If you are providing access to a report developer, enter the report developer's user name.</td>
</tr>
<tr>
<td>ConnectString</td>
<td>Enter the Actuate database connect string.</td>
</tr>
<tr>
<td>Schema</td>
<td>Enter the database schema owner. The default is maximo.</td>
</tr>
</tbody>
</table>

**NOTE** For information about setting up security for your report developer, see “Providing Security Access to Your Report Developers,” on page 6-28.

4. To accept the changes, click **Apply**. To close the dialog box and return to the Design view, click **Close**.

5. Run the query by clicking the Run icon.

The Open PM Work Order Query that you defined on page 5-6 opens in a new page.

**Open PM Work Order Query**

<table>
<thead>
<tr>
<th>ASSTNUM</th>
<th>DESCRIPTION</th>
<th>EQTUR</th>
<th>JPRKM</th>
<th>LEADG</th>
<th>LOCATION</th>
<th>STRFLD</th>
<th>SUPER</th>
<th>TARGCO</th>
<th>TARGET</th>
<th>WORKUM</th>
</tr>
</thead>
<tbody>
<tr>
<td>1200</td>
<td>Electric Call Tune-Up</td>
<td>5</td>
<td>JPI000</td>
<td>ME1</td>
<td>BOLIER</td>
<td>BEDPO</td>
<td>MILLR</td>
<td>1221/1999</td>
<td>1221/1999</td>
<td>1003</td>
</tr>
<tr>
<td>11450</td>
<td>Feedwater Pump Service</td>
<td>1</td>
<td>JPH1200</td>
<td>ME1</td>
<td>SHIPPNG</td>
<td>BEDPO</td>
<td>MILLR</td>
<td>1221/1999</td>
<td>1221/1999</td>
<td>1003</td>
</tr>
<tr>
<td>13141</td>
<td>Packaging Mach Elevator &amp; Drinpper</td>
<td>20</td>
<td>JPH1430</td>
<td>EL1</td>
<td>BPIK00</td>
<td>BEDPO</td>
<td>MILLR</td>
<td>1221/1999</td>
<td>1221/1999</td>
<td>1003</td>
</tr>
<tr>
<td>11230</td>
<td>Prevent Deligaged Cond Feedting</td>
<td>24</td>
<td>JPH1314A</td>
<td>ME1</td>
<td>BPIK00100</td>
<td>BEDPO</td>
<td>MILLR</td>
<td>1221/1999</td>
<td>1221/1999</td>
<td>1003</td>
</tr>
<tr>
<td>13600</td>
<td>12 Months Service on Shipping Dept #1</td>
<td>4</td>
<td>JPH13140</td>
<td>ME1</td>
<td>SHIPPNG</td>
<td>BEDPO</td>
<td>MILLR</td>
<td>1221/1999</td>
<td>1221/1999</td>
<td>1003</td>
</tr>
<tr>
<td>13145</td>
<td>Check-out, Leaking</td>
<td>1.5</td>
<td>RP1</td>
<td>ME2</td>
<td>BOLIER</td>
<td>BEDPO</td>
<td></td>
<td>1222/1992</td>
<td>1222/1992</td>
<td>8008</td>
</tr>
<tr>
<td>11450</td>
<td>Reuseable Fluid Cooler Pump</td>
<td>20</td>
<td>JPH1430</td>
<td>EL1</td>
<td>BPIK00</td>
<td>BEDPO</td>
<td>MILLR</td>
<td>1221/1999</td>
<td>1221/1999</td>
<td>1003</td>
</tr>
<tr>
<td>11435</td>
<td>Check-out Alignment of Stir Support</td>
<td>1.5</td>
<td>RP1</td>
<td>ME2</td>
<td>BOLIER</td>
<td>BEDPO</td>
<td></td>
<td>1222/1992</td>
<td>1222/1992</td>
<td>8008</td>
</tr>
</tbody>
</table>

The table lists various Open PM Work Order Queries with their respective details.
Adding Parameters

Parameters filter output on a query so that users see only the information they want. In this section, you query only for Location parameter BR230 and only for Site parameter Bedford.

You can add unbound parameters that meet either of the following criteria:

- The parameter is not in the main table of the application.
- The parameter has no relationship to the main table.

For more information about bound and unbound parameters, see “Providing Security Access to Your Report Developers” on page 6-28.

To add a parameter, complete the following steps:

1. In e.Report Designer Professional, click the Data icon to open the Textual Query Editor dialog box.
2. Add your parameters to the end of the query SQL statement. In the figure shown, Location and Site are the added parameters.

A colon indicates that the line is a parameter. The text after the colon is what users see when prompted to enter a parameter. In this example, the system prompts users to enter site and location parameters.

**Textual Query Editor (Static Parameters Subtab)**

```
SELECT WORKORDER.WONUM, WORKORDER.STATUS, WORKORDER.WORKTYPE, WORKORDER.ASSETNUM, WORKORDER.LOCATION, WORKORDER.DESCRIPTION, ASSET.DESCRIPTION FROM MAXIMO.WORKORDER, MAXIMO.ASSET WHERE WORKORDER.ASSETNUM=ASSET.ASSETNUM AND WORKORDER.SITEID='SITE' AND WORKORDER.LOCATION='LOCATION' AND 1=1
```

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Actuate Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SITE</td>
<td>String</td>
</tr>
<tr>
<td>LOCATION</td>
<td>String</td>
</tr>
</tbody>
</table>
Adding Parameters

3. Click OK. The system saves the information you entered and returns to Design view.

**NOTE** You can modify saved parameters. For example, you can set parameter default values, mark the parameter as required, or hide the parameter so users do not see it.

4. To run the query, click the Run icon. The Requester dialog box opens.

5. Enter values for the requested parameters.

6. Click OK. The query opens, filtered according to the new parameters.

   To use other parameters, repeat steps 2 – 4.

---

**Query with Parameter-Defined Information**

<table>
<thead>
<tr>
<th>Asset</th>
<th>Asset Number</th>
<th>Location</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WSCB</td>
<td>Clean engine unit</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WSCB</td>
<td>Remove and clean air induction filter</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB300</td>
<td>WSCB</td>
<td>Check coolant level</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WSCB</td>
<td>Check battery charge rate of each charge, record</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WSCB</td>
<td>Check battery posts, cables for tightness</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB300</td>
<td>WSCB</td>
<td>Place control switch on each control board to off</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WSCB</td>
<td>Remove generator panels from exit of generator</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WSCB</td>
<td>Check motor housing for loose plug</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WSCB</td>
<td>Ensure for live bearing</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WSCB</td>
<td>Review generator test log</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WSCB</td>
<td>Check heat exchanger</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WSCB</td>
<td>Check battery voltage and water level</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB500</td>
<td>WSCB</td>
<td>Take battery hydrometer readings</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WSCB</td>
<td>Check filter, deflection 90° to 131/16 in</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WSCB</td>
<td>Generators Overhaul</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WAPFR</td>
<td>Repair damaged control on south side of generator</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WAPFR</td>
<td>Disconnect power to generator</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>WAPFR</td>
<td>Repair Damaged Control Housing Generator</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Check coolant level</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Ensure for live bearing</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Check battery voltage and water level</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Check battery posts, cables for tightness</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Check battery charge rate of each charge, record</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Check all hose connections for tightness</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Review generator test log</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Generators Overhaul</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Take battery hydrometer readings</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Check heat exchanger</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Place control switch on each control board to off</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Check filter, deflection 90° to 131/16 in</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Clean engine unit</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Remove and clean air induction filter</td>
</tr>
<tr>
<td>Emergency Generator</td>
<td>11220</td>
<td>BB200</td>
<td>NIPB</td>
<td>Remove generator panels from exit of generator</td>
</tr>
</tbody>
</table>
Posting to an iServer Encyclopedia

To enable Query Reports to display in Maximo, post them to the Queries subfolder in the appropriate application where business users can access them.

Actuate Encyclopedia Queries Folder (Files & Folders Selected)

Running a Query

For information about running a query, see Chapter 3, “Using Maximo Reports.”

Creating Queries – Tips

The following sections can help you create Queries:

- adding additional fields
- modifying display names with the same label
- renaming labels (by renaming columns) in the textual query editor
- changing column names for end users

Adding Additional Fields

When you create queries, you should determine the fields end users might want to see and add them. When end users customize the query, they can use the Content tab to select those fields. If you do not make a field available, end users cannot select it.
Modifying Display Names with the Same Label

If you enter multiple fields with the same field name in the Textual Query Editor, the editor appends a number to the description in the Data Row Editor, as shown in the following example:

Data Row Editor Dialog Box with Display Names Indicated

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Display Name</th>
<th>Type</th>
<th>Native Type</th>
<th>Format</th>
<th>Width (Chars)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASSETNUM</td>
<td>ASSETNUM</td>
<td>String</td>
<td>VARCHAR2(12)</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>DESCRIPTION</td>
<td>String</td>
<td>VARCHAR2(100)</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>DESCRIPTION_1</td>
<td>DESCRIPTION_1</td>
<td>String</td>
<td>VARCHAR2(100)</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>LOCATION</td>
<td>LOCATION</td>
<td>String</td>
<td>VARCHAR2(12)</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td>STATUS</td>
<td>String</td>
<td>VARCHAR2(16)</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>WONUM</td>
<td>WONUM</td>
<td>String</td>
<td>VARCHAR2(10)</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>WORKTYPE</td>
<td>WORKTYPE</td>
<td>String</td>
<td>VARCHAR2(6)</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

The next section shows how you can change the Display Name to more easily distinguish between two similar entries.
Renaming Labels (by Renaming Columns) in the Textual Query Editor

You can rename labels with similar names so they are easier to identify. In this section, you will use the Textual Query Editor to rename columns (and their corresponding labels) for both the Work Order and Asset tables.

1. In e.Report Designer Professional, click the Data icon to open the Textual Query Editor.

Textual Query Editor with Description Labels
Renaming Labels (by Renaming Columns) in the Textual Query Editor

2. Open an SQL statement containing duplicate field names. In this example, the duplicate fields are:
   - WORKORDER.DESCRIPTION
   - ASSET.DESCRIPTION

3. In the top half of the Textual Query Editor, create aliases for each line.
   - Rewrite WORKORDER.DESCRIPTION as WODESCRIPTION.
   - Rewrite ASSET.DESCRIPTION as ASSETDESCRIPTION.

4. Click the Describe Query icon to display updated column names.

   ![Textual Query Editor with Aliases (Columns Subtab)](image)

5. Click OK to accept these changes and return to Design view.
Changing Column Names for End Users

The following section explains how to modify a column heading so that the heading is more descriptive for your business needs. In this example, you will change the ASSTNUM display name to ASSET NUMBER.

**NOTE**
This procedure only explains how to modify the columns. For more information about this dialog box, click Help.

To use the Column Editor Dialog Box to change the column heading, complete the following steps:

1. In e.Report Designer Professional, open the query you worked with in the previous section.
2. Click the Data Row Editor icon to open the Data Row Editor dialog box.
3. Click the Assetnum variable name.

**TIP**
Do not use the Column Editor Dialog Box to change the width of a field. The field will revert to the default value each time you click the Describe Query icon on the Textual Query Editor. To change the length of a field, use the **Display Length** field on the Textual Query Editor.

**Data Row Editor Dialog Box**

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Display Name</th>
<th>Type</th>
<th>Native Type</th>
<th>Format</th>
<th>Width (Chars)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASSETNUM</td>
<td>ASSETNUM</td>
<td>String</td>
<td>VARCHAR2(12)</td>
<td></td>
<td>12</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>DESCRIPTION</td>
<td>String</td>
<td>VARCHAR2(100)</td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>DESCRIPTION_1</td>
<td>DESCRIPTION_1</td>
<td>String</td>
<td>VARCHAR2(100)</td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>LOCATION</td>
<td>LOCATION</td>
<td>String</td>
<td>VARCHAR2(12)</td>
<td></td>
<td>12</td>
</tr>
<tr>
<td>STATUS</td>
<td>STATUS</td>
<td>String</td>
<td>VARCHAR2(16)</td>
<td></td>
<td>16</td>
</tr>
<tr>
<td>WONUM</td>
<td>WONUM</td>
<td>String</td>
<td>VARCHAR2(10)</td>
<td></td>
<td>10</td>
</tr>
<tr>
<td>WORKTYPE</td>
<td>WORKTYPE</td>
<td>String</td>
<td>VARCHAR2(5)</td>
<td></td>
<td>5</td>
</tr>
</tbody>
</table>
Changing Column Names for End Users

4 To open the Column Editor dialog box, click **Modify**.

5 Type your changes to the fields that appear. Change the Display name for ASSETNUM to display ASSET NUMBER.

6 Click **OK** to save your change and return to the Data Row Editor dialog box.

7 Click **Close** to see the query in Design View.

8 Run the query to view the new heading.

**Query with ESTDUR (HRS) Heading**

```
<table>
<thead>
<tr>
<th>ASSET NUMBER</th>
<th>DESCRIPT</th>
<th>ESTDUR</th>
<th>FNUM</th>
<th>LEADCRAFT</th>
<th>LOCATION</th>
<th>SITEID</th>
<th>SUPER</th>
<th>TARGCD</th>
<th>TARGST</th>
<th>WUSERNAME</th>
<th>WORDER</th>
</tr>
</thead>
<tbody>
<tr>
<td>11230</td>
<td>Repair</td>
<td>24</td>
<td></td>
<td>BR230</td>
<td>BEDFORD</td>
<td>1/1/99</td>
<td>1/20/99</td>
<td>1008</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11230</td>
<td>Generator</td>
<td>7</td>
<td>F11210</td>
<td>ME1</td>
<td>BR230</td>
<td>BEDFORD</td>
<td>1/20/99</td>
<td>12/30/99</td>
<td>1004</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11230</td>
<td>Generator</td>
<td>4</td>
<td>F11210</td>
<td>ME1</td>
<td>BR230</td>
<td>BEDFORD</td>
<td>4/20/02</td>
<td>4/20/02</td>
<td>1020</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```
Report Administration lets report administrators or report developers complete the following actions. These actions are described in detail in this chapter:

- access the Report Administration module
- register (add) a new Maximo report to the Maximo database
- attach documents
- use the detail check box for detail reports
- create a button on the Maximo toolbar
- create toolbar buttons in the Purchase Order application
- generate and preview a request page
- change report titles and field labels in the labels tab
- rename report columns
- define report types
- work with parameters
- run Current/Selected/All reports
- define and run Parameter-based reports
- delete a report
- provide security access to your report developers
- store parameter-based reports in multiple Maximo applications
- run parameters based reports

This chapter also contains a section with tips for the Report Administrator. The tips described include the following items:

- determining your parameter’s attribute name
- storing Maximo reports in multiple Maximo applications
- understanding the two different types of parameters (bound and unbound)

**MAXDEMO User Names** In the MAXDEMO database shipped to you with Maximo, Maximo provides the following users with access to the Report Administration application:

- HENRYL (as a member of the REPORTADMIN group)
- WILSON (as a member of the MAXADMIN group)
The following flowchart shows the different actions that the report developer or report administrator performs.
Accessing the Report Administration Module

Access the Report Administration Module, as shown in either of the following ways from the Go To menu:

\[ \text{Select Administration} \rightarrow \text{Report Administration.} \]

Accessing Report Administration in the Go To Menu

\[ \text{T Select Administration} \rightarrow \text{Report Administration.} \]

Accessing Report Administration from Administration in the Go To Menu

\[ \text{Select Reporting} \rightarrow \text{Report Administration.} \]

Accessing Report Administration from Reporting in the Go To Menu
Registering (Adding) a New Maximo Report to the Maximo Database

This section describes how you register (add) a new report to the Maximo database.

**NOTE**  You must add all customized reports to the database in order to access them.

To register a new Maximo report to the Maximo database, complete the following steps:

1. On the Maximo toolbar, open the Report Administration module.
2. Click the New Report icon. The Report tab appears with empty fields.
Registering (Adding) a New Maximo Report to the Maximo Database

3. Enter or accept the default values in the following fields:

   ▼ **Report File Name** (and Report Description) –

   You must enter the file name of the report executable EXACTLY as it was created in e.Report Designer Professional or eSpreadsheet.

   Enter the report description in the field next to it. The report description appears to the end user when that user runs the report.

   The file name you enter must have one of the following suffixes:
   - .rox for reports
   - .dox for queries
   - .vtf for eSpreadsheets

   **CAUTION** Maximo does NOT verify this report file name and this field has no Select Value icon.

   ▼ **Report Run Type** – You must accept Report as the default or enter Query or eSpreadsheet.

   The Report Run Type you select determines the tab that appears. Maximo places reports and eSpreadsheets on the Reports tab. It places queries on the Queries tab.

   ▼ **Application** – You must enter the Maximo application that business users and end users will use to open this report. To open a dialog box containing available application names, click the Select Value icon.

   The application name you select determines the following information:
   - the attribute names of any report parameters
   - the application where the business user or end user can find the report

   **NOTE** Multiple application names and reports can correspond to the same report executable (.rox) file, as shown in the following table:

<table>
<thead>
<tr>
<th>Application Name</th>
<th>Report Name</th>
<th>Report Executable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Activity Details Report</td>
<td>woprint_act.rox</td>
</tr>
<tr>
<td>Change</td>
<td>Change Details Report</td>
<td>woprint_act.rox</td>
</tr>
<tr>
<td>Quickrep</td>
<td>Quick Reporting Detail Report</td>
<td>woprint_act.rox</td>
</tr>
<tr>
<td>Release</td>
<td>Release Details Report</td>
<td>woprint_act.rox</td>
</tr>
<tr>
<td>Wotrack</td>
<td>Work Order Details Report</td>
<td>woprint_act.rox</td>
</tr>
</tbody>
</table>

   ▼ **Report Folder** – The folder where Maximo stores the Actuate Executable file (.rox for reports, .dox for queries, .vtf for spreadsheets) in the report Encyclopedia. You either must accept the default or enter another Encyclopedia folder where you want to store the report.

   The **Report Folder** field defaults to the value you entered in the **Application** field.
Click the Save Report icon or press Ctrl + Alt + S to save the report.

Report Tab with Completed Fields for Work Order Details Report
Attaching Documents

You can use the Attached Document feature in Maximo to attach Word documents, PDF files, Web page URLs, diagrams, pictures, and other types of documents to individual Maximo reports.

**NOTE** End users must set their ActiveX controls and plug-ins in Internet Explorer in order to activate this feature. For more information about this process, see “Using the Reporting Toolbar,” on page 3-15.

To attach documents to a report, complete the following steps:

1. In Maximo, complete the fields as described in the preceding section, “Registering (Adding) a New Maximo Report to the Maximo Database.”

2. Select the **Attach documents?** check box to print the report with the attached documents from that application.

   - If you select the **Attach Documents?** check box and no documents exist, Maximo will print only the report.
   - If you select the **Attach Documents?** check box, the selected report ALWAYS will print with attached documents until you clear the check box.

3. To save the changes, click the Save Report icon.

4. To apply the changes, click **Generate XML on the Report Tab**.

You have enabled attached documents to run with this report.

**Report Tab with Attach Documents? Field Indicated**
Using the Detail Check Box for Detail Reports

The Detail? check box prevents your business users and end users from using system resources to run a detail report against a large number of records. Since detail reports can be very specific and complex for each record, IBM Corporation gives you a Detail? check box that limits users to running detail reports against a maximum of 200 records.

Examples of detail reports are the Purchase Order Details Report and the Work Order Details Report. IBM Corporation selects the Detail? check box as the system default.

For a list of all Detail Reports, see the “Listing Overview and Detail Reports by Application,” on page 2-2.

If you must run the report against more than 200 records, select the Detail? check box to remove the checkmark, generate the request page, then preview and run the report.

After running the report, be sure to click the Detail? check box to prevent users from running the report against more than 200 records.

NOTE If you attempt to run a detail report against more than 200 records without clearing the Detail? check box, you receive an error message.
Creating a Button on the Maximo Toolbar

Follow these instructions to create a toolbar button on the Maximo toolbar. A toolbar button allows the end user one-click access to selected reports within an application.

For more information about the Maximo toolbar, refer to the Maximo User’s Guide.

To create a button on the Maximo toolbar, complete the following steps:

1. In the Maximo Report Administration application, open the list of reports and select one.

**NOTE** You can create a toolbar button for only Current/Selected/All reports (those reports without parameters).

2. Complete the following fields.

   ▼ **Toolbar Location** – Select the tabs where you want the toolbar button to appear for the report.

<table>
<thead>
<tr>
<th>If you select . . .</th>
<th>the icon . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>appears on all application tabs.</td>
</tr>
<tr>
<td>List</td>
<td>appears on List tab, only.</td>
</tr>
<tr>
<td>Main</td>
<td>appears on all application tabs, except the List tab.</td>
</tr>
<tr>
<td>None</td>
<td>does not appear on any tabs. This is the default value.</td>
</tr>
</tbody>
</table>

   ▼ **Toolbar Image** – Select an image for the toolbar button.

<table>
<thead>
<tr>
<th>If you select . . .</th>
<th>the toolbar button . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>nav_icon_detrreport.gif</td>
<td>appears as a detail report icon image.</td>
</tr>
<tr>
<td>nav_icon_overview.gif</td>
<td>appears as an overview report icon image.</td>
</tr>
<tr>
<td>None</td>
<td>does not appear. This is the default value.</td>
</tr>
</tbody>
</table>

   ▼ **Toolbar Sequence** – Enter the sequence of this icon in relation to other toolbar buttons. All toolbar buttons you create will appear at the end of the Maximo toolbar. For example, enter 1 for the toolbar button to appear as the first reporting icon on the toolbar.

**NOTE** You MUST enter values in all three fields (Toolbar Location, Toolbar Image, and Toolbar Sequence) to create a toolbar button on the Maximo toolbar.
Creating a Button on the Maximo Toolbar

3 Click the Save Report icon. You have created a button on the Maximo toolbar.

Report Administration (Report Tab)
Creating a Toolbar Button in the Purchase Orders Application

In the following example from the Purchase Orders application, you create buttons on the Maximo toolbar for the Purchase Order Status Details Report.

1. In the Maximo Report Administration application, filter the list of reports to show only those for the Purchase Order application.

Report Administration (List Tab with Purchase Order Reports)


3. Beneath the Report Details heading, complete the following fields:
   - Toolbar Location – Select All.
   - Toolbar Image – Select nav_icon_overview.gif.
   - Toolbar Sequence – Enter 3.

4. To save the changes, click the Save Report icon.

5. To apply the changes, click Generate XML on the Report Tab.

6. Open the Purchase Orders application and select any of the four tabs (PO, PO Lines, Ship To/Bill To, Terms and Conditions).

You now have three buttons enabled on the Maximo toolbar. IBM Corporation enabled the first two icons for the Purchase Order List and Purchase Order Details report, respectively. In this section, you enabled the third icon for the Purchase Order Status Details report.

Purchase Orders Application (PO Tab) with PO Details, PO List, and PO Status Details Icons Enabled
Generating and Previewing a Request Page

You can use the Report Administration application to generate and preview the request page. The Report Administration application lets you specify which parameters, if any, the end user sees on the request page. Parameters let end users run reports based on specific information that they enter just before running the report.

In this section, you will generate and preview a request page for the Purchase Order Status Details report that you worked on in the previous section.

**NOTE** To remove the request page from a report, select the *No Request Page?* check box. For example, you might want to remove a request page to prevent users from running database update reports.

To return a request page to a report, clear the *No Request Page?* check box.

To generate and preview a request page, complete the following steps:

1. Open a report in Maximo. For example, open the Purchase Order Status Details report that you worked on in the previous section.

2. On the Report tab, click **Generate XML on the Report Tab** to create the report’s request page. When Maximo finishes, a message box appears:

   You have generated the request page.

3. Click **Close** to close the message dialog box.

4. Click **Preview** to verify that you generated the Request Page.
Request Page for the Purchase Order Status Details Report

Fill in the fields in the Parameters section below and select the Submit button to run the report. If no parameters are displayed, the report will execute against the current/selected/all record set. Optionally, fill out the Email or Schedule Tabs to set e-mail notification preferences and schedule report run times.

Submit  Cancel
Changing Report Titles and Field Labels in the Labels Tab

The Labels tab lets you change report titles and field labels in your report. After you (or your report developer) publish a report through the Management Console, you can use the Labels tab to customize how titles and fields appear.

Renaming Report Columns

The following section explains how to rename a column. For example, you might change a column name (Asset) to be more descriptive (Asset Number).

To rename the Asset column on the Summary of Asset Failures Location Report to Asset Number, complete the following steps:

1. In the Maximo Report Administration application, select a report from the list of reports.
2. Click the Labels tab to open up the label values for this report.
3 Select the Asset Label row to open the Details section of this page for the Asset label.

4 Complete the fields in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label Value</td>
<td>The new name for the field you want to rename. For this example, change Asset to Asset Number</td>
</tr>
<tr>
<td>Font Name</td>
<td>The font type for that label. We recommend that you use only the following fonts:</td>
</tr>
<tr>
<td></td>
<td>▼ Arial</td>
</tr>
<tr>
<td></td>
<td>▼ Arial Unicode MS</td>
</tr>
<tr>
<td></td>
<td>▼ Batang</td>
</tr>
<tr>
<td></td>
<td>▼ Courier New</td>
</tr>
<tr>
<td></td>
<td>▼ MS Gothic</td>
</tr>
<tr>
<td></td>
<td>▼ MS Mincho</td>
</tr>
<tr>
<td></td>
<td>▼ Symbol</td>
</tr>
<tr>
<td></td>
<td>▼ Times New Roman</td>
</tr>
<tr>
<td>Font Size</td>
<td>The point size of the font.</td>
</tr>
<tr>
<td>Custom Width (queries, only)</td>
<td>The width of the label column on the query report.</td>
</tr>
</tbody>
</table>

5 Click Save Report to save the new name to the Label Value column.
Renaming Report Columns

6 After the end user runs the report from the browser, the new value displays in the Label Value field.

Summary of Asset Failures by Location Report with Updated Asset Number Heading Indicated

<table>
<thead>
<tr>
<th>Asset Number</th>
<th>Description</th>
<th>Mfr</th>
<th>Install Date</th>
<th>Warranty Date</th>
<th>Failure Class</th>
<th># of Failures</th>
<th>MTFI (Days)</th>
<th>Avg Downtime</th>
<th>Avg Downtime</th>
<th>All (hrs)</th>
</tr>
</thead>
<tbody>
<tr>
<td>T11401</td>
<td>Decker 53000 L117G/6 Cross Flow Water Tube</td>
<td>BMC</td>
<td>03/05/2006</td>
<td>11/05/2006</td>
<td>ROLERS</td>
<td>4</td>
<td>416.77</td>
<td>1.28</td>
<td>1.28</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** IBM Corporation provides you with a custom Application Programming Interface (API) that requires you to provide an Oracle, SQL Server, or IBM DB2 database user with read-only access to the following tables:

- L_REPORTLABEL
- MAXVARS
- REPORTLABEL

For more information about how to grant database access to a user, see “Providing Security Access to Your Report Developers,” on page 6-28.

**WARNING** If you delete the database user with read-only access, you cannot access the Labels feature for Maximo queries.
Defining Report Types

This section defines the two types of reports you can run in Maximo:

- **Current/Selected/All** – reports without parameters that the end user runs by selecting either the current record, selected records, or all records
- **Parameter-Based** – reports containing parameters that the end user runs against parameter values defined by the report administrator or report developer

The following flowchart shows the report process as described in this section.
Working with Parameters

The following table describes how the actions of the Report Administrator (who registers reports) affect the end user (who generates those reports).

**Reports with Parameters Information Table**

<table>
<thead>
<tr>
<th>Number of parameters in Report</th>
<th>How you register report</th>
<th>What end user generates the report against</th>
</tr>
</thead>
<tbody>
<tr>
<td>one or more parameters</td>
<td>with parameters in the Report Administration application</td>
<td>the parameter(s) that the Report Administrator defined for this Parameter-Based report.</td>
</tr>
<tr>
<td>no parameters</td>
<td>without parameters in the Report Administration application</td>
<td>one or more records that user selects for this Current/Selected/All report.</td>
</tr>
</tbody>
</table>
Running Current/Selected/All Reports

You run a Current/Selected/All report by querying the record set in a specific application. When you run the report, Maximo passes the where clause to the report in Actuate to execute it.

You can run a Current/Selected/All Report in one of three ways:

- Current Record
- Selected Records
- All Records

The following sections depict scenarios illustrating each way.

Current Record

You open one record and run a report based on only that record, as in the following example:

1. Open the Work Order Tracking application
2. Select work order 5009.
3. Run the Work Order Details Report for work order 5009.

Work Order Details Report for Work Order 5009

<table>
<thead>
<tr>
<th>Work Order Details</th>
<th># 5009 - Ventilator in Boiler Room</th>
<th>Making Noise</th>
<th>Check-out</th>
</tr>
</thead>
<tbody>
<tr>
<td>WO: 5009</td>
<td>Sched Start: 1/1/2000 0:00:00 AM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Site: BEDFORD</td>
<td>Target Start: 1/1/2000 0:00:00 AM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status: WARPPR</td>
<td>Actual Start:</td>
<td>Actual Finish:</td>
<td></td>
</tr>
<tr>
<td>Parent:</td>
<td>Report Date: 12/31/1999 9:00:00 AM</td>
<td>Reported By: WINTON</td>
<td></td>
</tr>
<tr>
<td>Work Type: CM</td>
<td>Priority: 5</td>
<td>OL Account: 810-500-???</td>
<td></td>
</tr>
<tr>
<td>Vendor:</td>
<td>Contract:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Classification:</td>
<td>Failure Class:</td>
<td>Problem Code:</td>
<td></td>
</tr>
<tr>
<td>Lead:</td>
<td>Supervisor: BOYD</td>
<td>Person Group:</td>
<td></td>
</tr>
<tr>
<td>Owner:</td>
<td>Owner Group:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service:</td>
<td>Service Group:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job Plan:</td>
<td>Asset:</td>
<td>Location: BOILER</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Side Room:</td>
<td></td>
</tr>
</tbody>
</table>

Planned Labor

<table>
<thead>
<tr>
<th>Task ID</th>
<th>Craft</th>
<th>Skill Level</th>
<th>Labor</th>
<th>Vendor</th>
<th>Contract</th>
<th>Qty</th>
<th>Hours</th>
<th>Rate</th>
<th>Line Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>ELECT</td>
<td>FIRSTCLASS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>$1.00</td>
<td>$22.00</td>
<td>$22.00</td>
</tr>
<tr>
<td>MECH</td>
<td>FIRSTCLASS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>$2.00</td>
<td>$25.00</td>
<td>$50.00</td>
</tr>
</tbody>
</table>

Total Planned Labor: $72.00
Selected Records

You filter the entire list of records and run a report based upon those selected, as in the following example:

1. Open the Work Order Tracking application.
2. Select the List tab.
3. Select a method to limit work orders:
   - ▼ If you want to limit work orders through the header row, go to step 4.
   - ▼ If you want to limit work orders through the Select Records check box, go to step 6.
4. In the header row, enter the following values:

<table>
<thead>
<tr>
<th>Column</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Boiler</td>
</tr>
<tr>
<td>Status</td>
<td>WAPPR</td>
</tr>
<tr>
<td>Site</td>
<td>Bedford</td>
</tr>
</tbody>
</table>

5. Click Enter to open this list of selected records.
   
   Go to step 9.

6. Check the Select Records check box to open a column of check boxes, one corresponding to each record in the list.

   **NOTE** If the list contains more than 200 records, Maximo displays a dialog box that you must further limit the results.
Running Current/Selected/All Reports

7. Place a checkmark next to those records you want to include in the report. For example, use header rows to limit the list to the following values:

<table>
<thead>
<tr>
<th>Column</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Boiler</td>
</tr>
<tr>
<td>Status</td>
<td>WAPPR</td>
</tr>
<tr>
<td>Site</td>
<td>Bedford</td>
</tr>
</tbody>
</table>

8. Select those records for which you want to run a report.

Work Order Tracking Application (List Tab) with Selected Records Checked

<table>
<thead>
<tr>
<th>Column Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location Boiler</td>
</tr>
<tr>
<td>Status WAPPR</td>
</tr>
<tr>
<td>Site Bedford</td>
</tr>
</tbody>
</table>

9. Run the Work Order List Report for the selected records.

Work Order List Report for Selected Records
You run a report against the Maximo database for all records in a specific application. For example, you run a report against all work order tracking records in the database.

### Work Order Tracking Application (List Tab) with All Records Selected

<table>
<thead>
<tr>
<th>Work Order</th>
<th>Description</th>
<th>Location</th>
<th>Asset</th>
<th>Status</th>
<th>Scheduled Start</th>
<th>Priority</th>
<th>Site</th>
</tr>
</thead>
<tbody>
<tr>
<td>5002</td>
<td>Ventilator in Order Room Moving Noise - Check-Out</td>
<td>BOILER</td>
<td>11308</td>
<td>WAPPY</td>
<td>2</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5003</td>
<td>Fire Door Close Beam</td>
<td>BOILER</td>
<td>11308</td>
<td>WAPPY</td>
<td>5</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5004</td>
<td>Check-Out Alignment of Steel Support Bracket</td>
<td>BMX3100</td>
<td>13143</td>
<td>WAPPY</td>
<td>2</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5005</td>
<td>Air Filter - Check-Out</td>
<td>BOILER</td>
<td>11345</td>
<td>WAPPY</td>
<td>2</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5006</td>
<td>Check-Out Leading</td>
<td>BMX3100</td>
<td>13145</td>
<td>WAPPY</td>
<td>4</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5007</td>
<td>Feeder Insulated</td>
<td>BMX3100</td>
<td>13145</td>
<td>WAPPY</td>
<td>5</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5008</td>
<td>Scale Calibration on Dock Lift Reading</td>
<td>SHIP100</td>
<td>12310</td>
<td>WAPPY</td>
<td>1</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5009</td>
<td>Stop Guard on Shipping Dock</td>
<td>SHIP100</td>
<td>12310</td>
<td>WAPPY</td>
<td>1</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5010</td>
<td>Ventilation Fan - Check-Out Noise</td>
<td>SHIP100</td>
<td>12310</td>
<td>WAPPY</td>
<td>3</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5011</td>
<td>Airlock Hook in Shipping Dock</td>
<td>SHIP100</td>
<td>12310</td>
<td>WAPPY</td>
<td>2</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5012</td>
<td>Close Quarterly Inspection and Certification</td>
<td>SHIP100</td>
<td>12310</td>
<td>WAPPY</td>
<td>4</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5013</td>
<td>Full Lift #1 Quarterly Inspection and Certification</td>
<td>SHIP100</td>
<td>12310</td>
<td>WAPPY</td>
<td>3</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5014</td>
<td>Compressor Quarterly Inspection and Certification</td>
<td>ER300</td>
<td>11200</td>
<td>WAPPY</td>
<td>4</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5015</td>
<td>HVAC Quarterly Inspections &amp; Certification</td>
<td>ER300</td>
<td>11200</td>
<td>WAPPY</td>
<td>3</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5016</td>
<td>Pneumatic Valve Elevator &amp; Driveway Inspection</td>
<td>BMX3100</td>
<td>13441</td>
<td>APFR</td>
<td>5</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5017</td>
<td>Repair Damaged Control Panel Feeding Generator</td>
<td>BMX3100</td>
<td>11230</td>
<td>WAPPY</td>
<td>7</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5018</td>
<td>12 North Service on Shipping Dock #1 Conveyor</td>
<td>SHIP100</td>
<td>13650</td>
<td>BFRG</td>
<td>6</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
<tr>
<td>5019</td>
<td>12 North Service on Shipping Dock #2 Conveyor</td>
<td>SHIP100</td>
<td>12950</td>
<td>WAPPY</td>
<td>1/23/00 8:04 AM</td>
<td>2</td>
<td>1 BEDFORD</td>
</tr>
<tr>
<td>5020</td>
<td>12 North Service on Shipping Dock</td>
<td>SHIP100</td>
<td>12950</td>
<td>WAPPY</td>
<td>3</td>
<td>1 BEDFORD</td>
<td></td>
</tr>
</tbody>
</table>
Running Current/Selected/All Reports

The Work Order List report appears for all records.

**Work Order List Report for All Records**

---

The Work Order List report appears for all records.
Defining and Running Parameter-Based Reports

This section describes how a report administrator can define a Parameter-Based report so that the end user can run it. After the administrator registers parameters, the end user can use that parameter to have Maximo filter information and generate only the information that the end user needs.

As you define this report, you will want to refer to “Running Parameter-Based Reports – Tips for the Report Administrator,” on page 6-34.

1 In the Maximo Report Administration application, open a Parameter-Based report. For this example, open a Summary of Asset Failures by Location Report as an example of a Parameter-Based report.

2 To display the details fields, click **New Row**.

3 Complete the fields that appear beneath the Details heading.

   The Tips section at the end of this chapter contains the following information to help you in completing these fields:

   - “Defining Bound and Unbound Parameters,” on page 6-35
   - “Determining Your Parameter’s Attribute Name,” on page 6-37
   - “Storing Parameter-Based Reports in Multiple Maximo Applications,” on page 6-39

   **Parameter Name** – Enter the exact name of the parameter you defined in e.Report Designer Professional.

   **Attribute Name** – Enter an attribute name or click the Detail Menu icon to select a name from a list of all attributes for the Maximo application you selected. Available attributes correspond to the column tables for that application.

   **NOTE** Do not use the **Attribute Name** field if you are adding an Unbound Parameter.
**Special Relationship/Attribute Dialog Box (for Attribute Name Field)**

![Dialog Box Image]

- **Lookup Name** – If you select an attribute name with an existing Maximo lookup, this field defaults to that lookup value. Or, you can click the Select Value icon to select from a list of all lookups.

- **Operator** – Use this field to select a mathematical operator for the new parameter. For example, when adding a START DATE parameter:
  - Select “>=” to run a report with start dates later (greater) than or equal to the date you enter when you run the report.
  - Select “<=” to run a report with start dates earlier (less) than or equal to the date you enter when you run the report.

- **Multi-lookup Enabled?** – If you select this check box, the end user can enter or select multiple entries for a parameter field. For example, if this check box is selected, the end user can enter or select Bedford, McLean, and Nashua as valid sites instead of only one site.

- **Display Sequence** – The order in which the new parameter appears on the request page. For example, if the parameter is to appear after four existing parameters, enter 5 in this field.

- **Override Label** – The name of the parameter as it will appear on the page to the end user.

- **Default Value** – The default value, if any, that will appear to the end user. For example, if you are creating a LABOR parameter, you can enter **ACTIVE** as the default value.
NOTE If you use Default Values for your parameter, you cannot use the **Operator** field that appears on this screen.

▼ **Required?** – select this check box if the end user running this report needs this parameter.

4 To continue adding parameters, click **New Row**. The new parameter appears with the other Report Lookups.

5 To save the report, click the Save Report icon.

6 To apply the changes, click **Generate XML on the Report Tab**.

You have added a parameter to the report.
Deleting a Report

When you delete a report, you remove it permanently from the Maximo database. Among reasons for deleting a report would be if it offers you a report you no longer use or a view of report data that you no longer use.

The following section contains instructions for deleting the Summary of Asset Failures by Location Report. To delete the report, complete the following steps:

1. Open the Maximo Report Administration application to display the List tab.

2. To select the report that you want to delete, click that report. The report opens in the Report Tab.

3. From the Select Action Menu, select **Delete Report**. Maximo opens a dialog box asking you to confirm the deletion.

4. To delete the record, click **Yes**.
Providing Security Access to Your Report Developers

As the Report Administrator, you have a unique database sign in to your Maximo database. End users have a unique sign in to Maximo, but not to the Oracle or SQL Server database.

Unlike your end users, your report developer needs Maximo database access to develop reports in e.Report Designer Professional. This section describes how to let your report developers have access to the database(s) that they need in order to develop reports.

This section describes the following tasks:

▼ As the Report Administrator, you provide READ access to the ASSET object for Report Developer HENRYL in Maximo (steps 1 – 6).

▼ As the Report Developer HENRYL, you create and refine a report in e.Report Designer Professional (steps 7 – 10).

▼ As the Report Administrator or Report Developer HENRYL, you publish the report to the Management Console (step 11).
The following diagram further illustrates the process for providing security access to your Report Developer:

Provide Security Access to your Report Developer – Illustration of Steps

- Report Administrator
  - Defines Database Access for Report Developer
  - Oracle, SQL Server, or DB2 Database - FULL Access

- Maximo

- Report Developer
  - Creates / Refines Report
  - Oracle, SQL Server, or DB2 Database - LIMITED Access

- erdPro

- Management Console
  - Publishes Report to Encyclopedia
To provide security access to your Report Developer HENRYL, complete the following steps:

1. In Maximo, select **Security > Users** to open the Users application.

2. In the Users Application, select the Report Developer for whom you want to provide database access. In the following example, you have selected HENRYL who is one of the Report Developers in your organization.

3. Click the Users tab and from the Select Action menu, select **Database Access** to open the Database Access dialog box.
4 In the Database Access dialog box, complete the following fields.

**NOTE** Your Report Developer will use the user ID and password you enter here (through the Database Login page in e.Report Designer Professional) to access the Oracle or SQL Server database.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database User ID</td>
<td>Provide the Report Developer with an Oracle, SQL Server, or IBM DB2 database user ID. You can use the Maximo ID (HENRYL) for the Database User ID, or you can enter another name for this developer.</td>
</tr>
<tr>
<td>Database Password</td>
<td>Provide the Report Developer with an Oracle, SQL Server, or IBM DB2 database password. You can use the Maximo password for the database password, or you can enter another password for this developer.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Type the password again to confirm the database password that you entered.</td>
</tr>
</tbody>
</table>

5 Click **New Row** to open a table row that lets you define specific database access for your report developer. Complete the following fields:

**NOTE** Your report developer will use the object name that you enter here (through the Textual Query Editor in e.Report Designer Professional) to create a report using the Oracle or SQL Server database.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Name</td>
<td>Type an Object Name or click the Detail Menu arrow to select an object name from a list. The object name that you enter will be the default from the <strong>Entity Name</strong> field. In the following example, you have selected Asset as the Object Name.</td>
</tr>
<tr>
<td>Read?, Insert?, Update?, Delete?</td>
<td>Select the check box corresponding to the level(s) of access that you want to provide for the Report Developers.</td>
</tr>
</tbody>
</table>

For this example, you assign Report Developer HENRYL only READ access.

6 To define the database access for Report Developer HENRYL, click **OK**.

HENRYL now has his own database login that he will use to run reports. HENRYL can develop the report in e.Report Designer Professional until he is satisfied with it.

8 To run the report, Report Developer HENRYL clicks **OK**. When HENRYL is satisfied with the report, he can continue to step 9.

9 Before compiling and publishing the report, report developer HENRYL must delete all information contained in the following fields:

- ParmPassword
- ParmUserName
- connectString
- schema

When an end user runs the report in Maximo, the system must pass the information in these fields to the report. This information can be passed only if these fields are blank.

10 Report Developer HENRYL compiles the report in e.Report Designer Professional.

*Requester Dialog Box*

![Requester Dialog Box](image)

**Global Vars**

- ParmPassword
- ParmUserName
- connectString
- mroOrg
- mroSite
- schema
- where = 1=1

**Output Parameters**

- Required parameter (cannot be blank)
As the Report Administrator or Report Developer HENRYL, you must publish the report through Management Console.

If you want Report Developer HENRYL to use the one-click publish feature in e.Report Designer Professional, you must give that developer access to the Management Console. See “Adding a Server Profile,” on page 7-8, for additional information.

If you do not want your report developer to publish the report, do not provide any access to the Management Console. In this case, the developer must send you the report’s .rox file (or .dox file for a query) so that you can publish it to the Management Console.
Running Parameter-Based Reports – Tips for the Report Administrator

The following section contains important tips that you might want to refer to as you run a Parameter-based report. These tips are divided into the following sections:

▼ Defining Bound and Unbound Parameters
▼ Determining Your Parameter's Attribute Name
▼ Storing Parameter-Based Reports in Multiple Maximo Applications
Defining Bound and Unbound Parameters

You can use parameters to specify the information to appear on Parameter-Based reports. Maximo has two types of parameters:

- Bound
- Unbound

Bound Parameters

Bound parameters have fields, or relationships, in the Maximo database. For example, in the Summary of Asset Failures by Location Report, all four parameters (location, mroSite, startDate, and endDate) exist in the database. Maximo provides lookup information.

Some bound parameters might not contain lookup information. For these parameters, you must enter the correct parameter information.

**NOTE** The .rod file for a report in e.Report Designer Professional includes bound parameters.

Report Administration (Report Tab) with Summary of Asset Failures by Location Report
Unbound parameters do not exist in the Maximo database. For example, in the Inventory EOQ Analysis Report, two parameters (Carrying Cost % and Ordering Cost) have no equivalent fields or relationships in the Maximo database.

Unbound parameters, except for the Date parameter, do not contain lookup information. The user must type in the correct parameter information.

For an example of an unbound Date parameter, see the Commodity Analysis Report.

**NOTE** Maximo does not pass unbound parameters through the where clause. They MUST BE included in the report's .ROD file. The report developer must add the unbound parameter manually for the report to execute properly.

*Report Administration (Report Tab) with Inventory EOQ Analysis Report*
Determining Your Parameter’s Attribute Name

When you add a parameter to a report, one way that you can define the parameter further is through the Attribute Name field. This section is meant to assist you in determining a parameter’s attribute name.

To determine an attribute name, complete the following steps:

1. Determine if the main table of your Maximo application is the same as the main table that your report uses. If unable to determine this, continue to step 2.

2. Determine the relationship that exists between the parameter you are adding and the Maximo application. If unable to determine this relationship, continue to step 3.

3. Determine that no direct relationship exists between the parameter you are adding and the Maximo application where the report resides.

Determine if the main table of your Maximo application is the same as the main table that your report uses

To determine if the main table of your Maximo application is the same as the main table that your report uses (the parameter exists in the main table of that application), run an SQL statement on the report application using a database query tool.

For example, if you are adding a Location parameter to the Summary of Asset Failures Report, you could run a statement such as:

```
Select * from maxapps where app = 'ASSET';
```

where

"ASSET" is the application where that report is located.

After you execute this statement, the result indicates that the main table is Asset. Since the location parameter exists in the main table of the Asset application, you should enter Location in the Attribute Name field.

If the main table of your application is the same table that your report is using, enter that table name in the Attribute Name field.

If the main table of your application is not the same table that your report is using, continue to the section.
Determine Your Parameter’s Attribute Name

Determine the relationship that exists between the parameter you are adding and the Maximo application

To determine if the relationship that exists between the parameter you are adding and the Maximo application, run an SQL statement on the relationship (the MAXRELATIONSHIP) using a database query tool.

For example, if you are adding the Start Date parameter to the Summary of Asset Failures Report, you could run a statement such as:

```sql
SELECT * FROM maxrelationship WHERE parent = 'ASSET' AND child = 'WORKORDER';
```

where

- **ASSET** (the parent) is the main table application where the report exists.
- **WORKORDER** (the child) is the table name of the field where the Start Date parameter resides.

After you execute this statement, you can evaluate the where clauses of the available relationships and determine the relationship that best meets the needs of the report. In this case, the relationship is ALLWO and you should enter ALLWO.FAILDATE in the **Attribute Name** field for this parameter.

If you cannot determine the relationship between the parameter you are entering and the Maximo application, continue to the next step.

Determine that no direct relationship exists between the parameter you are adding and the Maximo application where the report resides

If there is no way to specify the MAXRELATIONSHIP that exists between the parameter and the application, you must add the parameter as an Unbound parameter and leave the Attribute Name field blank.

For more database information, refer to the database configuration chapter in the Maximo System Administrator’s Guide.
Storing Parameter-Based Reports in Multiple Maximo Applications

All standard Maximo reports belong to an application. For example, the Open Work Orders and PM Report is located in the Work Order Tracking Application.

**CAUTION**

If you want to move this report to another application, you must check that all its attributes, for both required and non-required parameters, appear in that application.

For example, if you receive a request to store the Open Work Orders and PM reports in the Preventive Maintenance application, you must verify that ASSET, LOCATION, and SITE are all attributes in the Preventive Maintenance application. You can verify the attributes in any application by using the following SQL statement:

```
select attributename from maxattribute where objectname = 'application name'
```

where

**application name** is Preventive Maintenance

You can store the Open Work Orders and PM reports in the Preventive Maintenance application as all three attributes are common to both the Work Order Tracking application and the Preventive Maintenance application.

**Report Administration (Report Tab) with Open Work Orders and PM Report (All Parameters in PM)**

All parameters also exist in Preventive Maintenance application.
If this report contained a parameter with an application name that was in Work Order Tracking, but not available in Preventive Maintenance (PM), such as SERIALNUM, you would receive an invalid binding error message because Maximo has no link from SERIALNUM in Work Order Tracking to SERIALNUM in the PM application (as this attribute does not exist in PM).

**Report Administration (Report Tab) with Open Work Orders and PM Report (Serial Number Not in PM)**

To resolve this issue, you can create a MAXRELATIONSHIP or an unbound parameter. For more information, refer to the database configuration chapter in the Maximo System Administrator’s Guide.
Loading and Configuring e.Report Designer Professional

Overview
This chapter is for the Report Developer using e.Report Designer Professional who wants the following information:

- the different types of Actuate files
- how to load and customize e.Report Designer Professional
- how to add a server profile

Describing Actuate Files

The following table provides a quick reference to common Actuate file types. The sections following the table describe these file types in more detail.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.bas</td>
<td>Basic Source Files</td>
<td>Actuate Basic code associated with a specific report design.</td>
</tr>
<tr>
<td>.doi</td>
<td>Query Report Instance</td>
<td>Finished queries the end user sees in Internet Explorer.</td>
</tr>
<tr>
<td>.dov</td>
<td>Saved User Query</td>
<td>Contains user’s specified content and formatting for Query Report.</td>
</tr>
<tr>
<td>.dox</td>
<td>Query Report Executable</td>
<td>Compiled design file for a Query Report.</td>
</tr>
<tr>
<td>.rod</td>
<td>Report Design File</td>
<td>Components specifying the format and content of a finished report.</td>
</tr>
<tr>
<td>.roi</td>
<td>Report Document File</td>
<td>Instance or results of the report executable, that opens to the user in the browser</td>
</tr>
<tr>
<td>.rol</td>
<td>Library File</td>
<td>File containing components that can be used in one or more report designs to provide consistent behavior and performance.</td>
</tr>
<tr>
<td>.rox</td>
<td>Report Executable</td>
<td>Executable for a report.</td>
</tr>
</tbody>
</table>
Describing Actuate Files

Basic Source (.bas) Files

Basic source (.bas) files contain Actuate Basic code associated with a specific report design. Report developers create a basic source file in e.Report Designer Professional by compiling a report’s object design (.rod) file.

An example of a basic source file is the FrontEndFunctions.bas, which is in your Config folder. The FrontEndFunctions.bas file contains the following items:

- details for where clause
- parameter information
- security
- system-generated ID numbers for each finished report

Query Report Instance (.doi) Files

Query Report Instance files contain the output of a user’s saved query. These are the “live” results of when the query report is executed against the Maximo database.

Saved User Query (.dov) Files

The Saved User Query file contains an end user's customized inputs on fields, sorting, grouping, filtering, and formatting.

Query Report Executable (.dox) Files

The Query Report Executable files are the compiled design files. It is the file which the end user begins to form his unique query form. These .dox files are stored in the Encyclopedia.

Report Design Files (.rod) Files

Report design files contain components specifying the format and content of a finished query or report. Report Developers can open and edit an .rod file only on a desktop machine. End users do not need access to design files to run, view, or print queries or reports.

Use e.Report Designer Professional to create queries or report designs.

Depending on the type of output (query or report), design (.rod) files contain the following components:

- Query Report Executable (.dox) files (Queries)
- Query Report Instance (.doi) files (Queries)
- executable (.rox) files (Reports)
- library (.rol) files (Reports)
- report document (.roi) files (Reports)
Report Document (.roi) Files

Report document files are the finished reports that end users create and view in the report browser page. Executable (.rox) files produce (.roi) files. End users view reports on the Web in DHTML format.

You can access report document (.roi) files in the view reports section of the report page.

Library (.rol) Files

Library files contain reusable report components. Different report design files include library files.

**CAUTION**

Do NOT modify your library files unless you are an advanced Maximo reports user. If you change a library file without knowing the full implications, you can cause multiple reports to fail when you recompile them.

Library files are extremely useful when many reports use the same component multiple times. An example of a frequently used component is the database connection.

Typically, multiple reports use the same database connection. Once in the library, the Report Developer can define the database connection and include it in multiple reports which saves time. Report developers use e.Report Designer Professional to create reports using these Maximo libraries.

IBM Corporation has developed Maximo-specific libraries to generate Maximo reports. These libraries contain Maximo business logic and the look and feel of Maximo. When report developers create new reports in e.Report Designer Professional the templates include Maximo libraries. Also, all reports delivered to you “out of the box” use Maximo libraries.

You can access the following Maximo libraries in e.Report Designer Professional:

<table>
<thead>
<tr>
<th>Library Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MaximoBaseControls.rol</td>
<td>the base Maximo controls that IBM Corporation uses to customize Actuate</td>
</tr>
<tr>
<td>MaximoControls.rol</td>
<td>all subclasses that constitute the MaximoBaseControls library</td>
</tr>
<tr>
<td>MaximoDataComponents.rol</td>
<td>a library tailored to your Oracle, SQL Server, or IBM DB2 database operating</td>
</tr>
<tr>
<td></td>
<td>system</td>
</tr>
<tr>
<td>MaximoReportFrames.rol</td>
<td>the pre-defined library components that support the Maximo templates</td>
</tr>
<tr>
<td>MaximoReportPages.rol</td>
<td>a library that defines the page orientation (landscape or portrait), margins,</td>
</tr>
<tr>
<td></td>
<td>headers, footers, and other setup information</td>
</tr>
</tbody>
</table>

**NOTE**

For more information about library files, search for Doc ID M04764 in the Support Online Web site.
Executable (.rox) Files

Report Developers compile design (.rod) files to generate executable (.rox) files. Executable files generate report documents with current data when end users run them.


Loading and Customizing e.Report Designer Professional

IBM Corporation provides you with the Actuate Reporting Release 8 e.Report Designer Professional CD. Insert the CD into your CD-ROM drive. Locate the Source folder which contains the following subfolders:

▲ Custom folder – Be sure to work only within the Custom folder. To change a report, use the .ROD file from the Custom folder.

▲ Default folder – This folder is your backup.

CAUTION Do not modify the default folder. That folder is intended as a backup of the original source code.

Load e.Report Designer components in the order in which they appear. The following three sections describe how to load these components:

1 Customizing Your Actuate Template Files, on page 7-5
2 Pointing to Maximo Configuration Files, on page 7-5
3 Pointing to Maximo Palette Files, on page 7-7
Customizing Your Actuate Template Files

IBM Corporation provides you with template files specifically for use with Maximo. To customize your templates, run ERDPRO.REG from the Actuate Reporting Release 8 e.Report Designer Professional CD.

ERDPRO.REG updates your registry with these customized Maximo templates. The update varies depending on your Windows operating system.

Pointing to Maximo Configuration Files

IBM Corporation provides you with customized template and library configuration files for use with Maximo. You must configure e.Report Designer Professional to point to these files.

**CAUTION** Before you can complete this task, you must complete the section, “Customizing Your Actuate Template Files,” on page 7-5.

To configure e.Report Designer Professional to point to Maximo configuration files, complete the following steps:

1. In the erdPro folder, click SETUP.EXE and complete the online installation instructions to install e.Report Designer Professional.

2. Go to the location where you installed e.Report Designer Professional and click ERDPRO.EXE to launch the application.

   **NOTE** If you selected the default destination folder, launch the application from the following location:

   C:\Program Files\Actuate 8\eRDPro

   The Welcome to Actuate e.Report Designer Professional dialog box appears.

3. To close the dialog box, click **Cancel**.

4. From the e.Report Designer Professional toolbar, select **Tools>Options** to open the Options dialog box.
Pointing to Maximo Configuration Files

5 Click the General tab.

Under Configuration file, select the mroConfig.xml file stored in your source\custom\config folder. From **Load configuration file from the following file or URL**, you can type the path and file name manually or click the Detail icon to locate the file.

Since the default setting for the source\custom\config folder is Read only, to modify files in this folder you must clear the check from this Property setting and apply that change to all subfolders.

**CAUTION** Be sure to point to the source\custom\config folder. Do not point to the source\default\config folder as that folder serves as a backup for your original config folder.

6 Click **Refresh**. The following dialog box opens.

7 Click **OK** to clear the dialog box.

8 To accept your changes, click **OK**.

You have pointed e.Report Designer Professional to Maximo's template and library configuration files.
Pointing to Maximo Palette Files

The palette file determines how your report will look when you drag components from your field list and toolbox. IBM Corporation provides you with a palette file that you should use to replace the standard Actuate palette file.

**CAUTION** Before you can complete this task, you must complete the following sections:

- “Customizing Your Actuate Template Files,” on page 7-5
- “Pointing to Maximo Configuration Files,” on page 7-5

To copy the IBM Corporation palette file, complete the following steps:

1. In e.Report Designer Professional, select **Tools>Options** to open the Options dialog box.

2. Select the Classes tab.

3. Click **From File** to open the Read Class Representation dialog box.

4. In the Look in drop-down list, locate your config folder and open it.

5. Select MaximoPalette.apr. This is the Maximo palette file.

6. Click **Open** to return to the Options dialog box.

7. Click **OK**. You have replaced the standard Actuate Palette file with the Maximo Palette file.
Adding a Server Profile

You might want to set up a profile name in order to add reports to the Encyclopedia through e.Report Designer Professional. If you are a report developer and want to add reports to the Encyclopedia quickly, you should set up a profile.

You can use either e.Report Designer Professional or e.Report Designer to set up a profile name. After you create a server profile, you can select it directly from the Management Console drop-down list.

To add a server profile, complete the following steps:

1. In e.Report Designer Professional and e.Report Designer select File > Management Console to open the Management Console dialog box.

   **Management Console Dialog Box**

   ```plaintext
   Management Console
   
   Specify profile name or URL
   
   [Input field]
   
   [Button: Add...]
   
   [Checkbox: Use this as default]
   
   [Checkbox: Do not show this dialog box again]
   
   [Button: OK] [Button: Cancel]
   
2. Create a profile as described in Steps 3 – 6 or enter a URL. If you enter a URL, go to Step 6.

3. Click Add to open the iServer Profile dialog box.
4 Complete the following fields to add a server profile:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile name</td>
<td>Descriptive name for the server profile</td>
</tr>
<tr>
<td>Application server and Port</td>
<td>Machine name and port number for the application server</td>
</tr>
<tr>
<td>Context path</td>
<td>Part of the Actuate Management Console URL that specifies the volume administration path, such as /acadmin</td>
</tr>
<tr>
<td>Iserver and Port</td>
<td>Machine name and port number for the iServer</td>
</tr>
<tr>
<td>Volume name</td>
<td>Name of the Encyclopedia</td>
</tr>
<tr>
<td>User name</td>
<td>User name for logging into the Encyclopedia</td>
</tr>
<tr>
<td>Password</td>
<td>Password for logging into the Encyclopedia</td>
</tr>
<tr>
<td>Destination Folder</td>
<td>Folder for uploading the report executable (.rox or .dox file)</td>
</tr>
</tbody>
</table>

5 Click **Test** to verify the Actuate iServer connection using the values you entered. If the connection succeeds, a confirmation message appears. If the connection fails, an error message appears. You must correct the error.

6 Click **OK** to add the data server profile. The profile name or URL will appear in the drop-down list on the Management Console drop-down box.
Compiling and Running Reports in e.Report Designer Professional

Overview

This chapter describes how to use e.Report Design Professional to perform the following tasks:

▼ open, select, and compile a report
▼ run a report

Reports shipped with Maximo are compiled and stored in their applicable folders in the Encyclopedia. If the report developer creates or modifies a report in e.Report Designer Professional, that report must be compiled or recompiled in e.Report Designer Professional.

When you compile a report, e.Report Designer Professional translates an Actuate Basic source file and a report object design (.rod) into a report object executable (.rox) file. Compiling a report consists of several sets of steps, as detailed in the following sections.
Selecting a Report

To select a report, open e.Report Designer Professional and complete the following steps:

1. Go to the Start menu and choose Programs>Actuate 8>Actuate e.Report Designer Professional. The Welcome dialog box appears.

2. From the Welcome dialog box, choose Open an Existing Report and click More Files to open the Custom folder.

   **CAUTION** IBM Corporation also provides you with a Default folder as a backup to your original Custom folder. Do NOT change any information in your Default folder. The Default folder is a permanent copy of your Custom folder that you always can refer to for your original source code.

*Select File Dialog Box*

3. Select an application folder.

4. Click the application folder to bring up two subfolders:
   - queries – contains all of your query source files
   - report – contains all of your report source files

5. Open the reports folder. It contains the report files (Woprint_act, for example).

If you change a report file, you then must compile it in order for the changes to take effect.

For information about compiling a report, see the following section.
Compiling a Report

You must compile a report file in order to save any changes you have made. To compile a report, complete the following steps:

1. In e.Report Designer Professional, open the Report File you selected in the preceding section (woprint_act.rod).

2. To run the report, click the Run icon.

3. From the Report menu, choose Build or press Shift-F8 to open an Actuate Output dialog box.

4. The status bar in the lower part of the left side of the page tells you when the compiling finishes.

   ▼ If the compile succeeds, you will see the text:

   compiling . . . done

   You have compiled the report. Do not go to step 5 or step 6.

   ▼ If the compile fails, you will see the text:

   compile failed

5. To see the error message, select View>Output Window to open the Actuate Output dialog box. Double-click the error to go to its location in the report.

6. Fix any errors until you can successfully compile the report.
Adding Compiled Reports and Queries to the Encyclopedia

The following table provides the different file extensions Actuate creates, depending on whether you compiled a report or query file.

<table>
<thead>
<tr>
<th>When you compile a . . .</th>
<th>Actuate produces a compiled version executable</th>
</tr>
</thead>
<tbody>
<tr>
<td>report object design (.rod) file</td>
<td>(.rox) file</td>
</tr>
<tr>
<td>query design (.rod) file</td>
<td>(.dox) file</td>
</tr>
</tbody>
</table>

You can move the executable file to the correct reports folder in the Encyclopedia. For detailed instructions about compiling reports, see “Adding Compiled Reports to the Encyclopedia” on page 11-4.

Running a Report from e.Report Designer Professional

For testing purposes, you sometimes might want a report developer to run a report locally from e.Report Designer Professional instead of from the Maximo Reports application.

The following sections describe how to run locally two types of reports:

▼ Current/Selected/All reports (see page 8-5)

▼ Parameter-Based reports (see page 8-6)
Running a Current/Selected/All Report from e.Report Designer Professional

The following section describes how to locally run a Current/Selected/All report from e.Report Designer Professional. To run the report, you must either enter new values or accept default values for all Global Vars parameters.

1. Open e.Report Designer Professional and select a Current/Selected/All report (for example, the Purchase Order List report).

2. Click the Run icon to open the Requester dialog box.

3. Complete the following **Global Vars** fields or verify that default values appear:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ParmPassword</td>
<td>The password for the report developer for whom you created database access on page 6-31.</td>
</tr>
<tr>
<td>ParmUserName</td>
<td>The report developer user name for whom you created database access on page 6-31.</td>
</tr>
<tr>
<td>ConnectString</td>
<td>The Actuate database connect string. You can find the connect string in the mxe.report.actuate.db.connectstring property in the MAXIMO. PROPERTIES file.</td>
</tr>
<tr>
<td>mroOrg</td>
<td>The organization name against which you are running reports.</td>
</tr>
<tr>
<td>schema (Oracle)</td>
<td>For an Oracle database, the database schema owner. You can find the schema owner in the mxe.db.schemaowner property in the MAXIMO.PROPERTIES file. The default is maximo.</td>
</tr>
<tr>
<td>schema (SQL Server)</td>
<td>For a SQL Server database, leave this field blank.</td>
</tr>
<tr>
<td>schema (IBM DB2)</td>
<td>For an IBM DB2 database, the database schema owner. You can find the schema owner in the mxe.db.schemaowner property of the MAXIMO.PROPERTIES file. The default is maximo.</td>
</tr>
<tr>
<td>where</td>
<td>You must enter 1=1 since you are running a Current/Selected/All report.</td>
</tr>
</tbody>
</table>

4. Click **OK**. The Actuate Output Box opens. Close it to see the report.
Running a Parameter-Based Report from e.Report Designer Professional

The following section describes how to locally run a parameter-based report from e.Report Designer Professional. As with the Current/Selected/All report, you must enter new values or accept default values for all Global Vars parameters. For a parameter-based report, you must also enter information for all output parameters that appear. Output parameters vary from report to report.

1. Open e.Report Designer Professional and select a parameter-based report (for example, the Summary of Asset Failures by Location report) with bound parameters.

2. To open the Requester dialog box, click the Run icon.

3. Complete the following **Global Vars** fields or verify that they contain default values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ParmPassword</td>
<td>The password for the report developer for whom you created database access.</td>
</tr>
<tr>
<td>ParmUserName</td>
<td>The report developer user name for whom you created database access.</td>
</tr>
<tr>
<td>ConnectString</td>
<td>The Actuate database connect string. You can find the connect string in the mxe.report.actuate.db.connectstring property of the MAXIMO.PROPERTIES file.</td>
</tr>
<tr>
<td>mroOrg</td>
<td>The organization name against which you are running reports.</td>
</tr>
<tr>
<td>schema (Oracle)</td>
<td>For an Oracle database, the database schema owner. You can find the schema owner in the mxe.db.schemaowner property in the MAXIMO.PROPERTIES file. The default is maximo.</td>
</tr>
<tr>
<td>schema (SQL Server)</td>
<td>For a SQL Server database, leave this field blank.</td>
</tr>
<tr>
<td>schema (IBM DB2)</td>
<td>For an IBM DB2 database, the database schema owner. You can find the schema owner in the mxe.db.schemaowner property of the MAXIMO.PROPERTIES file. The default is maximo.</td>
</tr>
<tr>
<td>where</td>
<td>You must enter 1=1 since this report contains bound parameters. If this report contains only unbound parameters, leave this field empty.</td>
</tr>
</tbody>
</table>
4 You must enter information for all output parameters in order to run the report. For the Summary of Asset Failures report, the output parameters are:

- endDate
- location
- mroSite
- startDate

Requester Dialog Box for Summary of Asset Failures by Location Report

Click OK. The Actuate Output Box opens. Close it to see the report.

5 Click OK. The Actuate Output Box opens. Close it to see the report.
Running a Report from e.Report Designer Professional
Overview

This chapter describes the following advanced features in e.Report Designer Professional:

- using Maximo templates
- creating your first report
- changing report titles and field labels in the labels tab
- working with your SQL statement in Maximo
- creating a hyperlink from one report to another
- adding unbound parameters to a report

Using Maximo Templates

Maximo has the following templates to help you format your report or query:

- Maximo Diff(erent) Subheaders Template
- Maximo Mult(iple) Same Subheader Template
- Maximo Single Subheader Template

You can access these templates when you opt to create a new report.
Create New Report Dialog Box

This section can help you decide which template you should select by describing the different types of queries, showing the appearance of the default template, and showing a sample report using each type of template.

The following table summarizes this template information:

<table>
<thead>
<tr>
<th>Number of Subheaders</th>
<th>Multi Diff Subheader</th>
<th>Multi Same Subheader</th>
<th>Single Subheader</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Multiple</td>
<td>Multiple</td>
<td>One</td>
</tr>
<tr>
<td>Subheader Information</td>
<td>Different from subheader to subheader</td>
<td>Same for each subheader</td>
<td>One subheader</td>
</tr>
<tr>
<td>Examples</td>
<td>Open Work Orders and PM Report</td>
<td>Item Availability Report</td>
<td>Inventory Balance Report</td>
</tr>
<tr>
<td></td>
<td>PO Status Details Report</td>
<td>Work Order Pick Report</td>
<td>Summary of Asset Failures by Location Report</td>
</tr>
</tbody>
</table>
Using the Maximo Multiple Different Subheader Template

You use the Maximo Multiple Different Subheaders template to create reports that contain multiple, different subheader information. You use this template for complex reports.

Maximo Multiple Different Subheader Template

Maximo reports that use this template include the Purchase Order Status Details Report (shown below) and the Open Work Orders and PM Report.

Reporting Application with Purchase Orders Status Details Report

<table>
<thead>
<tr>
<th>PO #</th>
<th>1234</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>APPR</td>
</tr>
<tr>
<td>Buyer</td>
<td>SWITH</td>
</tr>
<tr>
<td>Vendor</td>
<td>OFFLUS</td>
</tr>
<tr>
<td>Required Delivery Date:</td>
<td>12/1/2001</td>
</tr>
<tr>
<td>Vendor Delivery Date:</td>
<td>12/1/2001</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PO Status History</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>4/25/2000</td>
</tr>
<tr>
<td>4/25/2000</td>
</tr>
<tr>
<td>4/25/2000</td>
</tr>
<tr>
<td>4/25/2000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Material Receipt History</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>4/25/2000</td>
</tr>
<tr>
<td>4/25/2000</td>
</tr>
<tr>
<td>4/25/2000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Service Receipt History</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>4/25/2000</td>
</tr>
</tbody>
</table>
Using the Maximo Multiple Same Subheader Template

You use the Maximo Multiple Same Subheader Template to create reports that contain multiple subheaders of the same information.

Maximo Multiple Same Subheader Template

Maximo reports that use this template include the Item Availability Report (shown below) and the Work Order Pick Report.

Reporting Application with Item Availability Report

<table>
<thead>
<tr>
<th>Site</th>
<th>Storeroom</th>
<th>Bin</th>
<th>Condition Code</th>
<th>Lot</th>
<th>Exp Date</th>
<th>Current Balance</th>
<th>Qty Avail</th>
<th>Qty Res/Avd</th>
<th>Standard Cost</th>
<th>Average Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEERFORD</td>
<td>CENTRAL</td>
<td>B-6-9</td>
<td></td>
<td>55</td>
<td></td>
<td>170.00</td>
<td></td>
<td></td>
<td>2.50</td>
<td>170.00</td>
</tr>
</tbody>
</table>

Item 123202: Description: Top, Ferrite, TR-75 Issue Unit: EACH

<table>
<thead>
<tr>
<th>Site</th>
<th>Storeroom</th>
<th>Bin</th>
<th>Condition Code</th>
<th>Lot</th>
<th>Exp Date</th>
<th>Current Balance</th>
<th>Qty Avail</th>
<th>Qty Res/Avd</th>
<th>Standard Cost</th>
<th>Average Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEERFORD</td>
<td>PWC</td>
<td>C-4-1</td>
<td></td>
<td>6</td>
<td></td>
<td>170.00</td>
<td></td>
<td></td>
<td>170.00</td>
<td>170.00</td>
</tr>
<tr>
<td>DEERFORD</td>
<td>CENTRAL</td>
<td>B-2-9</td>
<td></td>
<td>6</td>
<td></td>
<td>170.00</td>
<td></td>
<td></td>
<td>170.00</td>
<td>170.00</td>
</tr>
</tbody>
</table>

Item 1234-18: Description: Connector, Pipe, 1 in Male Issue Unit: EACH

<table>
<thead>
<tr>
<th>Site</th>
<th>Storeroom</th>
<th>Bin</th>
<th>Condition Code</th>
<th>Lot</th>
<th>Exp Date</th>
<th>Current Balance</th>
<th>Qty Avail</th>
<th>Qty Res/Avd</th>
<th>Standard Cost</th>
<th>Average Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEERFORD</td>
<td>CENTRAL</td>
<td>A-9-9</td>
<td></td>
<td>12</td>
<td></td>
<td>2.50</td>
<td></td>
<td></td>
<td>2.50</td>
<td>2.50</td>
</tr>
</tbody>
</table>

Item 1234-93: Description: V-25k, 16 in. 38 in Ceramic Issue Unit: EACH

<table>
<thead>
<tr>
<th>Site</th>
<th>Storeroom</th>
<th>Bin</th>
<th>Condition Code</th>
<th>Lot</th>
<th>Exp Date</th>
<th>Current Balance</th>
<th>Qty Avail</th>
<th>Qty Res/Avd</th>
<th>Standard Cost</th>
<th>Average Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEERFORD</td>
<td>PWC</td>
<td>A-4-3</td>
<td></td>
<td>4</td>
<td></td>
<td>35.00</td>
<td></td>
<td></td>
<td>35.00</td>
<td>35.00</td>
</tr>
</tbody>
</table>

Item 1235-00: Description: Tubing, Copper 1 in. x 0.625 in Wall Issue Unit: FEET

<table>
<thead>
<tr>
<th>Site</th>
<th>Storeroom</th>
<th>Bin</th>
<th>Condition Code</th>
<th>Lot</th>
<th>Exp Date</th>
<th>Current Balance</th>
<th>Qty Avail</th>
<th>Qty Res/Avd</th>
<th>Standard Cost</th>
<th>Average Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEERFORD</td>
<td>PWC</td>
<td>C-4-1</td>
<td></td>
<td>55</td>
<td></td>
<td>2.05</td>
<td>1.49</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEERFORD</td>
<td>CENTRAL</td>
<td>A-6-2</td>
<td></td>
<td>607</td>
<td></td>
<td>2.05</td>
<td>1.49</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEERFORD</td>
<td>SARGASSO</td>
<td>B-2-5</td>
<td></td>
<td>12</td>
<td></td>
<td>2.05</td>
<td>1.49</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEERFORD</td>
<td>MACHICHO</td>
<td>B-5-5</td>
<td></td>
<td>51</td>
<td></td>
<td>2.05</td>
<td>1.49</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Using the Maximo Single Subheader Template

You use the Maximo Single Subheader Template to create reports that contain a single subheader. You use this template for simpler reports.

Maximo Single Subheader Template

Maximo reports that use this template include the Inventory Balance Report (shown below) and the Summary of Asset Failures by Location Report.

Reporting Application with Inventory Balance Report
Creating Your First Report

This section shows you how to create your first report. The report you create will be the Open Work Orders Grouped by Site report, but you can use these same general steps when creating any report.

Complete the following sections in order:

1. Selecting a Template
2. Connecting to the Database
3. Writing a SQL Statement
4. Creating a Report Title
5. Creating a Page Header and Text
6. Creating Report Column Headings
7. Creating Report Column Headings Using Dynamic Text Controls
8. Creating Content Fields
Creating Your First Report

Selecting a Template

In this section, you begin creating a report by using the Maximo Single Subheader template described on page 9-5. To select the template, complete the following steps:


2. Click **OK** to open the Create New Report dialog box. A list of templates appears.

   If you do not have these templates loaded, then your configuration is not set up properly. For more information, see Chapter 7, “Loading and Configuring e.Report Designer Professional.”

3. Since you are creating a report that contains one subheader with multiple rows of data, select Maximo Single Subheader Template and click **OK**. A report template page opens with a blank report template as well as an Actuate Output dialog box.

   **e.Report Designer Professional Report Template**

   ![Report Structure](image)

   ![Layout](image)

   **Libraries**

   ![Included Libraries](image)

   4. If the Report Structure is not visible along the left side of the template, select **View>Report Structure** to open it.

   If the Report Library is not visible along the left side of the template, select **View>Libraries** to open it.

   You have selected the Maximo Single Subheader template for your report.
Connecting to the Database

In the following section, you use e.Report Designer Professional to connect the the Maximo Single Subheader template to a database. To do so, complete the following steps:

1. In the Libraries pane, open MaximoDataComponents.rol, and then double-click MROConnection to open the MROConnection – Properties dialog box.

2. Complete the following fields in this dialog box:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HostString (Oracle)</td>
<td>Enter the connection string that points to the Maximo database. You must define the connection string on the machine where you run e.Report Designer Professional.</td>
</tr>
<tr>
<td>DataSource (SQL Server)</td>
<td>Enter the Data Source Name (DSN) that points to the Maximo database. You must define the DSN on the machine where you run e.Report Designer Professional.</td>
</tr>
<tr>
<td>DataSource (IBM DB2)</td>
<td>Enter the Database Alias that points to the Maximo database. You must define the Database Alias on the machine where you run e.Report Designer Professional.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for the database schema owner user name.</td>
</tr>
<tr>
<td>UserName</td>
<td>Enter the database user that the server uses to attach to the database server</td>
</tr>
</tbody>
</table>

3. To save and close the dialog box, click X. e.Report Designer Professional reappears in Design view.

**NOTE** The remaining steps and dialog boxes in this section are specific to an Oracle database.


5. In the IBM Report Name field, enter the file name of the report (do not include the file extension). This file name is required for the report labels to publish correctly to the database.

   For more information on using Field labels in Maximo, see page 6-14.

6. To save and close the dialog box, click X. e.Report Designer Professional reappears in Design view.
Writing a SQL Statement

In the following section, you write an SQL statement to create an Open Work Orders Grouped by Site report. This report will run against the database you connected to in the previous section.

1. Click the **Data** icon in e.Report Designer Professional to open the Textual Query Editor dialog box.

2. Enter the following SQL statement in the empty dialog box exactly as shown:

   ```sql
   SELECT WORKORDER.WONUM, WORKORDER.DESCRIPTION, WORKORDER.WORKTYPE, WORKORDER.STATUS, WORKORDER.WOPRIORITY, WORKORDER.LOCATION, WORKORDER.ASSETNUM, WORKORDER.SUPERVISOR, WORKORDER.SCHEDSTART, WORKORDER.SCHEDFINISH, WORKORDER.SITEID
   FROM MAXIMO.WORKORDER
   WHERE WORKORDER.WOCCLASS = 'WORKORDER'
   AND WORKORDER.STATUS NOT IN ('CLOSE', 'COMP', 'CAN')
   AND 1=1
   ```

   **CAUTION** Do NOT include a semicolon ( ; ) at the end of your SQL statement.

   **NOTE** You must add the text **AND 1=1** to the query text in the Textual Query Editor if either of the following conditions is true:

   ▼ Your query has a bound parameter.

   or

   ▼ Your query does not have any parameters.

3. Click the Describe Query icon on the Textual Query Editor dialog box to populate the fields in the Columns tab.

4. To close the Textual Query Editor dialog box and return to Design view, click **OK**. Note that the **Field** column populates with the column names from the SQL statement that you ran in step 2.
Creating Your First Report

Creating a Report Title

Use the steps in this section to change the default title text. The new title will be "Open Work Orders Grouped by Site."

1. In the Open Work Orders Grouped by Site report you are creating, click the ReportSection:Page Header – TitleFrame1 section of the template and right-click the Report Title.

2. To open the Properties dialog box, select Properties.

3. In the Text field, type the following text:

   Open Work Orders Grouped by Site

4. To accept your change and return to the Report Template, click X.

You have created a report title.
Creating a Page Header and Text

Use the steps in this section to create a page header and text for that header for your Open Work Orders report.

1. In the Open Work Orders Grouped by Site report you are creating, click the Group Section: Page Header - TableLabelsFrame1 section of the template.

2. To open the Properties dialog box, right-click the Label field and select Properties.

3. In the Text field, type the following text:
   Site:

4. To accept the changes and close the dialog box, click X. e.Report Designer Professional reappears in Design view.

5. Right-click the Sample Text field in this same section of the template (Group Section: Page Header - TableLabelsFrame1) and select Properties to open the Properties tab.

6. Scroll down to ValueExp and click it so that the drop-down button appears.

7. Select SITEID so it appears in the field for ValueExp.

8. To accept the changes and close the dialog box, click X. e.Report Designer Professional reappears in Design view.

You have created a page header and text for that header.
Creating Report Column Headings

Continuing the report you used in the previous section, use these steps to create column headings and column text for your report.

1. Click the GroupSection: Content – TableLabelsFrame1 section of the report.

2. Select the Label field, right-click, and select Properties. The Properties dialog box opens.

3. In the Text property field, delete the existing entry and type Work Order.

4. To save and close the dialog box, click X. e.Report Designer Professional reappears in Design view.

5. Create seven additional fields in this report section by copying the Work Order field and replacing the Text property with a new field name. Create the following fields:
   - Description
   - Type
   - Status
   - Priority
   - Location
   - Asset
   - Supervisor

6. Space the fields out according to the label description. For example, provide the greatest amount of space to the Description field.
Creating Report Column Headings Using Dynamic Text Controls

With the report from the previous section, use dynamic text controls to create the following fields:

- Scheduled Start
- Scheduled Finish

1. In e.Report Designer Professional, selecting **Insert>Dynamic Text Control** and place the control to the right of the existing fields.

2. When the Component Properties dialog box opens, open the **ValueEXP** property and select `[SCHEDSTART]` from the drop-down list.

3. To save, click **OK**.

**Component Properties Dialog Box**

![Component Properties Dialog Box]

4. Repeat steps 1 – 3 for the Scheduled Finish `[SCHEDFINISH]` label. When you have completed this section, you can then create corresponding headers in the content section of the template.
Creating Content Fields

For each field in the GroupSection:PageHeader – TableLabelsFrame1 section of your template, create a comparable field in the GroupSection:Content – TableDataFrame1 by clicking on a field in the Fields column and dragging it into the Content frame underneath the appropriate heading.

Save the report you created.

*e. Report Designer Professional Report Template with Group Section Selected*
Tip for Adding Descriptive Headings in Group Section:Content

To add descriptive headings to the Group Section:Content frame, complete the following steps:

1. In e.Report Designer Professional, double-click a field in Group Section:Content to open its Properties dialog box.

   *TableDataFrame-Properties Dialog Box (Properties Tab)*

   ![TableDataFrame-Properties Dialog Box](image)

   - **ValueExp** property: [WONUM]

2. Copy the ValueExp property (the database tablename). In the following example, the ValueExp properties is [WONUM].

3. Paste the ValueExp property ([WONUM]) into the SampleValue property field. SampleValue is the placeholder for this data.
In Maximo’s Report Administration application, the Labels tab lets you change report titles and field labels in your report. After you (or your report administrator) publish a report through Management Console, you can use the Labels tab to customize how titles and fields appear.

This feature populates your database with report label information. To activate this feature for your new or customized report, you or your report developer must complete the following actions in order:

▼ Set the **PublishReportToDb** property to true. When you set this property to true, e_Report Designer Professional allows you to publish report labels and titles to the REPORTLABEL table in the Maximo database.

▼ Run the report. You must run (compile) the report to populate labels in the Maximo database.

▼ Reset the **PublishReportToDb** property to false (the default setting). If you do not reset this property, a report that you have previously customized may change each time that an end user generates it.
Activating the Maximo Labels Tab

To activate the Maximo Labels tab, complete the following steps:

1. In e.Report Designer Professional, open your report.


3. Complete the following fields:
   - **MROReportName** – Enter the Maximo Report Name.
   - **PublishReportToDB** – Change property from False to True.

*NewReportApp - Properties Dialog Box (Properties Tab)*
Changing Report Titles and Field Labels Using the Maximo Labels Tab

4 To save and close the dialog box, click X. e.Report Designer Professional reappears in Design view.

5 Run the report.

For more information on using Field labels in Maximo, see page 6-14.

6 Set the PublishReportDB property back to False (the default setting).
Working with Your SQL SELECT Statement in Maximo

As you work with your SQL SELECT statement, you might need to add certain Maximo-specific conditions in order to achieve the correct results:

- You must specify the database schema name each time you reference a database table. For example, the FROM clause (as shown in the following figure) specifies **MAXIMO.WORKORDER** where **MAXIMO** is your database schema name.

- You must add the statement **AND 1=1** (as shown below) to any SQL SELECT statement if you are creating any of the following types of reports:
  - a Current/Selected/All type report
  - a report that has a Bound parameter

**Textual Query Editor Dialog Box**

```
SELECT WORKORDER.WONUM, WORKORDER.DESCRIPTION, WORKORDER.WORKTYPE, WORKORDER.STATUS, WORKORDER.WORKORDER, WORKORDER.LOCATION, WORKORDER.ASSIGN, WORKORDER.SUPERVISOR, WORKORDER.SCHEDSTART, WORKORDER.SCHEDFINISH, WORKORDER.SITEID 
FROM MAXIMO.WORKORDER 
WHERE WORKORDER.WCLASS = 'WORKORDER' 
AND WORKORDER.STATUS NOT IN ('CLOSE', 'CUMP', 'CAN') 
AND 1=1
```

**Column Name** | **Static Parameters** | **Ad hoc Conditions** | **DB Type** | **Actual Type** | **Display Length** | **Reference Names**
---|---|---|---|---|---|---
WONUM | | | VARCHAR(10) | String | 10 | Wonum
DESCRIPTION | | | VARCHAR(100) | String | 100 | Description
WORKTYPE | | | VARCHAR(10) | String | 5 | Worktype
STATUS | | | VARCHAR(10) | String | 16 | Status
WORKORDER | | | NUMBER | Double | 22 | Workorder
LOCATION | | | VARCHAR(10) | String | 12 | Location
Creating a Hyperlink from One Report to Another

This section describes how to create a hyperlink from a summarized list report to a detailed report. In this example, you will create a hyperlink from a job plan on a Work Order List Report to a Job Plan Details Report (a Current/Selected/All Report). To create the hyperlink, you must modify the reports to be linked.

The detailed report returns data specific to the field from which the report was called. For example, when you select a job plan number from a Work Order List Report, the new report is limited to data relevant to the job plan selected.

For information on adding hyperlinks to localized reports, see “Setting Up Hyperlinks,” on page 13-6.

As the first part of creating a hyperlink between the WORKORDER.JPNUM field in a Work Order List Report to a Job Plan Details Report, complete the following steps:

1. In e.Report Designer Professional, click the WORKORDER.JPNUM Control field. Double-click this field to open the Properties dialog box.

2. Select Linking>LinkExp and click the Detail icon to open the Hyperlink Builder dialog box.

3. Paste the following link in the Url field:

   \`\`mroRootFolder & \\
   \`

   Note the bolded sections of this code:

   \`\`jobplan/reports/jobplan_print_act.rox? – This section of code links to a report, located in the reports section of the jobplan folder, called jobplan_print_act.rox.

   LinkedRep=True – This required parameter indicates to Maximo that you are accessing the Job Plan Details Report via the Work Order List Report, as opposed to a Maximo application. You define this parameter in the next section.

   &jpnum=" & DataValue & \\
   \`

   To link to the correct jobplan, you must pass both values that constitute a unique key for that jobplan (JOBPLAN.JPNUM and JOBPLAN.SITEID).

   To pass any other required values, refer to them by enclosing the corresponding data row variable in brackets as done with SITEID. In this example, the SITEID value for this workorder is referenced by [SITEID].

   **NOTE**

   Do NOT use the mroSite variable if you are including SITEID as a key. Use the [SITEID] value from the current record.

You have modified an existing report. In the following section, you change a detailed report to accept the hyperlink.
Changing a Detailed Report to Accept the Hyperlink

After modifying the Work Order List Report, you now must change the Job Plan Details Report to complete the hyperlink. To change a detailed report, complete the following steps.

1. In e.Report Designer Professional, close any reports you currently have open. Save any changes you have made.

2. Open your Job Plan Details Report. Select Tools>Parameters to open the Parameter Editor dialog box.

3. Select GlobalVars. Click Add to open the Parameter Properties dialog box.

4. Complete the following fields and check box:

   - **Name** – Type LinkedRep.
   - **Type** – Select String from the drop-down list.
   - **Group** – Select Global Vars from the drop-down list.
   - **Hidden (do not show in Requester)** – Select this check box.

5. To create the LinkedRep parameter, click OK. The Parameter Editor dialog box reappears.

6. To create the Jpnum parameter, repeat steps 3 – 5 and type Jpnum in the Name field.

7. To create the Site parameter, repeat steps 3 – 5 and type the word Site in the Name field.
Creating a Hyperlink from One Report to Another

Parameter Properties Dialog Box (General Tab)

8 In the Report Structure section of your report, select **DataStream** - **TextualQuerySource1** and double-click to open the Properties dialog box.

9 Select the Methods tab and Double-click the following line:

```
Function ObtainSelectStatement( ) As String
```

10 Add the following text immediately after the method declaration (preceding any existing code):

```
If LinkedRep = "True" Then
    where = where & " and jobplan.jpnum = " & jnum & ""
    where = where & " and jobplan.siteid = " & site & ""
End If
```
Creating a Hyperlink from One Report to Another

Method Editor with text added

```vbnet
Function ObtainSelectStatement( ) As String
    If LinkedRep = "True" Then
        where = " where e " & Jobplan.itemnum = '"' & itemnum & '"'
    End If

    If NROIncludeWhere Then
        SelectStatement = StrSubst(SelectStatement, "1=1", where)
        End If

    If NROParseSchema Then
        If UCase(schema) <> "MAXIMO" then
            Do While InStr(SelectStatement, "MAXIMO,"|
            SelectStatement = StrSubst(SelectStatement, "MAXIMO.", schema & ":")
            Loop
        End If
    End If

    ObtainSelectStatement = Super::ObtainSelectStatement( )
End Function
```

11 In the Report Structure, select a report element, other than DataStream - TextualQuerySource1. This step ensures that e.Report Designer Professional recognizes your changes to the Method Editor.

12 To save the new information, build the report.

NOTE When creating a link from one report to another, be sure to build both reports and place them in the appropriate folders using Management Console. Replace any existing versions of either report.
Creating a Hyperlink from One Report to Another
This chapter describes the following report administrative functions relating to working with Maximo:

- setting privileges
- setting privileges by role
- setting privileges by user
- using the jobs folder

Setting Privileges

In Maximo, privileges can be set by group. In Actuate, privileges can be set either of the following ways:

- by individual user level.
- by role level. Role level is equivalent to Maximo groups. For example, the Maximo group DEFLT corresponds to the Actuate role DEFLT.

Role level is a name for a set of privileges. You can use roles to ensure that the same privileges are granted to a group of users. Roles also help you to manage privilege sets as your environment changes. For example, as employees join or leave a group within your company, you can change the members of that group without having to change any individual security levels.

Refer to the following table to determine which method IBM Corporation recommends for setting privileges in your organization.

### Setting Privileges Table

<table>
<thead>
<tr>
<th>If the number of users in your organization is . . .</th>
<th>and Report Privileges are . . .</th>
<th>you should set report privileges by . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Few</td>
<td>unique to each user</td>
<td>user level</td>
</tr>
<tr>
<td></td>
<td>same for all members</td>
<td>role level</td>
</tr>
<tr>
<td>Many</td>
<td>unique for many members</td>
<td>role level</td>
</tr>
<tr>
<td></td>
<td>same for all members</td>
<td>role level</td>
</tr>
</tbody>
</table>

When your System Administrator uses Maximo to add a new user or group or delete an existing user or group, your Management Console is updated automatically through the RSSE (Report Server Security Extension) properties files.
Configuring Security

You can configure security for Actuate in one of the following ways:

- By Encyclopedia folder level. For example, you can set report privileges for the DEFLT group or for an individual user to all reports in the WOTRACK folder.

- By individual report level. For example, you can set report privileges for the DEFLT group or for a single user to only the Work Order Details Report in the WOTRACK folder.

**NOTE** In the MAXDEMO database that you receive with Maximo, Maximo provides user WILSON with all security privileges to all Maximo reports and folders.

Setting Privileges by Role

The following section describes how to set privileges by role. For more information about role-level security, see page 10-1.

In this example, you will set privileges for all Work Order Tracking reports and queries for the DEFLTGRP role. You will assign full access privileges to the DEFLTGRP.

**NOTE** In step 4, you can see how these same instructions can be used to assign individual user privileges to:

- all reports or all queries
- a report or query executable file
- a report or query document file

To set privileges by role, complete the following steps:

1. In Actuate, open Management Console.

2. Select **Files & Folders** from the Side Menu.
3 Click the RPT link to open a list of subfolders corresponding to all of your Maximo applications.

*Management Console (Files & Folders) with RPT Folder Selected*
4 Choose one of the following actions:

▼ If you want to assign privileges based on all reports and queries in the WOTRACK folder, click the arrow icon next to the WOTRACK folder and select Properties. Go to step 5.

▼ If you want to assign role privileges to only reports or only queries:
   a Select the WOTRACK folder.
   b Click the arrow icon next to the REPORTS or QUERIES subfolder.
   c Select Properties. Go to step 5.

▼ If you want to assign role privileges to an individual report executable (.ROX) file or query executable (.DOX) file:
   a Select the WOTRACK folder.
   b Select the REPORTS or QUERIES subfolder.
   c Click the arrow icon next to the report or query executable file.
   d Select Properties. Go to Step 5.

▼ If you want to assign role privileges to an individual report (.ROI) or query document (.DOI) file:
   a Select the WOTRACK folder.
   b Select the REPORTS or QUERIES subfolder.
   c Select the ROI folder.
   d Click the arrow icon next to the report or query document.
   e Select Properties. Go to step 5.
5 Select the Privileges tab. Share is the default setting that lets you to share privileges with groups.

6 Select the **Roles** option to open a list of available roles to which you can assign privileges to items in the Encyclopedia.

*Management Console (Files & Folders) with Privileges Tab Selected in WOTRACK for DEFLTREG Role*
7 Select a role to which you want to assign privileges and click the Right Arrow to copy it to the Selected dialog box.

Note that the privilege settings are now available. The following table describes the access for each privilege.

**Role Privileges Table**

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible</td>
<td>View items in the Encyclopedia.</td>
</tr>
<tr>
<td>Secure Read</td>
<td>Open, work with, and print, but not download, an item in the Encyclopedia.</td>
</tr>
<tr>
<td>Read</td>
<td>Open, work with, and print an item in the Encyclopedia.</td>
</tr>
<tr>
<td>Execute</td>
<td>Run items from the Encyclopedia.</td>
</tr>
<tr>
<td>Write</td>
<td>Place an item in the Encyclopedia.</td>
</tr>
<tr>
<td>Delete</td>
<td>Remove items from the Encyclopedia.</td>
</tr>
<tr>
<td>Grant</td>
<td>Extend privileges to an item to other users. The user who develops an item and the administrator both have grant privileges for that item.</td>
</tr>
<tr>
<td>All</td>
<td>Places a checkmark in all privilege types listed.</td>
</tr>
</tbody>
</table>

8 Select the check box(es) corresponding to the privileges you want to assign to the group you selected. If you want to assign all privileges, select the All checkbox.

The privileges you select will appear in the Selected dialog box.

**Management Console (Files & Folders) with Privileges Tab Selected in WOTRACK for DEFLTREG Role**

9 Refer to the following table for checkboxes that allow you to set and replace folder and subfolder privileges:

<table>
<thead>
<tr>
<th>If you want to . . .</th>
<th>then select the . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>set privileges for items in the folder</td>
<td>Apply these privilege settings to the contents of the folder check box.</td>
</tr>
<tr>
<td>set privileges for all subfolders and files in the subfolders in the current folder</td>
<td>Recursively include subfolders and their contents check box.</td>
</tr>
<tr>
<td>replace privileges on the items in the folder</td>
<td>Replace existing privilege settings check box.</td>
</tr>
</tbody>
</table>

10 Click Apply to save your changes and add roles for other groups.

11 If you are done working with role privileges, click OK to save your changes and return to the list of files and folders.
Setting Privileges by User

The following section describes how to set privileges by individual user. In this example, you will set privileges for all Work Order Tracking reports and queries for user Daley. You will assign Daley visible (V), secure read (S), and read privileges (R).

1. In Actuate, open Management Console.

2. Select **Files & Folders** from the Side Menu.

3. Click the RPT folder to open a list of subfolders corresponding to all of your Maximo application.

Management Console *(Files & Folders)* with RPT Folder Selected
4 Choose one of the following actions:

- If you want to assign privileges based on all reports and queries in the WOTRACK folder, click the arrow icon next to the WOTRACK folder and select Properties. Go to step 5.

- If you want to assign role privileges to only reports or only queries:
  
  a Select the WOTRACK folder.
  
  b Click the arrow icon next to the REPORTS or QUERIES subfolder.
  
  c Select Properties. Go to step 6.

- If you want to assign role privileges to an individual report executable (.ROX) or query executable (.DOX) file:
  
  a Select the WOTRACK folder.
  
  b Select the REPORTS or QUERIES subfolder.
  
  c Click the arrow icon next to the report or query executable file.
  
  d Select Properties. Go to step 5.

- If you want to assign role privileges to an individual report executable (.ROI) or query document (.DOI) file:
  
  a Select the WOTRACK folder.
  
  b Select the REPORTS or QUERIES subfolder.
  
  c Select the ROI folder.
  
  d Click the arrow icon next to the report or query document.
  
  e Select Properties. Go to step 5.
5. Select the Privileges tab. **Share** is the default setting that lets you share privileges with individual users.

6. Select the **Users** option to open a list of available users to which you can assign privileges.

Management Console (Files & Folders) with Privileges Tab Selected in WOTRACK for User Daley

7. Refer to the following table for checkboxes that allow you to set and replace folder and subfolder privileges:

<table>
<thead>
<tr>
<th>If you want to . . .</th>
<th>then select the . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>set privileges for items in the folder</td>
<td><strong>Apply these privilege settings to the contents of the folder</strong> check box.</td>
</tr>
<tr>
<td>set privileges for all subfolders and</td>
<td><strong>Recursively include subfolders and their contents</strong> check box.</td>
</tr>
<tr>
<td>files in the subfolders in the current</td>
<td></td>
</tr>
<tr>
<td>folder</td>
<td></td>
</tr>
<tr>
<td>replace privileges on the items in the</td>
<td><strong>Replace existing privilege settings</strong> check box.</td>
</tr>
<tr>
<td>folder</td>
<td></td>
</tr>
</tbody>
</table>
Setting Privileges by User

8 Select an individual to whom you want to assign privileges and click the Right Arrow to copy it to the Selected dialog box.

Note that the privilege settings are now available. You can select from the following:

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible</td>
<td>View items in the Encyclopedia.</td>
</tr>
<tr>
<td>Secure Read</td>
<td>Open, work with, and print, but not download, an item in the Encyclopedia.</td>
</tr>
<tr>
<td>Read</td>
<td>Open, work with, and print an item in the Encyclopedia.</td>
</tr>
<tr>
<td>Execute</td>
<td>Run items from the Encyclopedia.</td>
</tr>
<tr>
<td>Write</td>
<td>Place an item in the Encyclopedia.</td>
</tr>
<tr>
<td>Delete</td>
<td>Remove items from the Encyclopedia.</td>
</tr>
<tr>
<td>Grant</td>
<td>Extend privileges to an item to other users. The user who develops an item and the administrator both have grant privileges for that item.</td>
</tr>
<tr>
<td>All</td>
<td>Places a checkmark in all privilege types listed.</td>
</tr>
</tbody>
</table>

9 Select the check box(es) for the privileges you want to assign to the Daley group. For example, if you want to assign Visible, Secure, and Read privileges, select those check boxes.

The privileges you select will appear in the Selected dialog box.

10 Refer to the following table for check boxes that allow you to set and replace folder and subfolder privileges:

<table>
<thead>
<tr>
<th>If you want to . . .</th>
<th>then select the . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>set privileges for items in the folder</td>
<td>Apply these privilege settings to the contents of the folder check box.</td>
</tr>
<tr>
<td>set privileges for all subfolders and files in the subfolders in the current folder</td>
<td>Recursively include subfolders and their contents check box.</td>
</tr>
<tr>
<td>replace privileges on the items in the folder</td>
<td>Replace existing privilege settings check box.</td>
</tr>
</tbody>
</table>

11 Click Apply to save your changes and add roles for other users.

12 If you are done working with user privileges, click OK to save your changes and return to the list of files and folders.
Using the Jobs Folder

Use the Jobs selection form the side menu of the Encyclopedia to view the following types of jobs:

<table>
<thead>
<tr>
<th>Category</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled</td>
<td>Jobs to be processed at a later date and time.</td>
</tr>
<tr>
<td>Pending</td>
<td>Jobs in the process queue.</td>
</tr>
<tr>
<td>Running</td>
<td>Jobs now running.</td>
</tr>
<tr>
<td>Completed</td>
<td>Jobs completed.</td>
</tr>
</tbody>
</table>

To see jobs in the process queue, click Jobs and select the Scheduled tab.

To see jobs in the process queue, click Jobs and select the Pending tab.

To view reports now processing, click Jobs and select the Running tab.

To view reports that have already been run, click Jobs and select the Completed tab.
Adding Reports to the Encyclopedia

Overview

This chapter describes how the report administrator can use Management Console to:

- add (register) reports to the Encyclopedia
- open the Encyclopedia

Defining Encyclopedia Components

In the Management Console, the Encyclopedia contains the reports used by Maximo, as well as several folders containing objects used for administration. The Encyclopedia opens with the following components:

- A banner across the top. The default setting for this banner is the Actuate logo.
- A left pane with a side menu. This menu contains category selections that let you work with reports.
- A right pane with the contents of the item selected in the left pane.
Click the Files & Folders option to see a subfolder called Reports and a subfolder called Queries.
Defining Encyclopedia Components

If you click the Queries subfolder, you see a list of available queries and a dov folder containing any existing query documents.

Encyclopedia Page (Files & Folders) with Inventory > Reports Folder Selected

If you click the Reports subfolder, you see a list of report executables with extension “_act” and an roi folder containing any existing report documents.

Encyclopedia Page (Files & Folders) with Inventory > Reports Folder Selected
Adding Compiled Reports to the Encyclopedia

After you create a report, as the Report Administrator you must complete both of the following actions in order for the end user to run the report:

- delete the existing executable from Management Console
- place the new report executable file into the Encyclopedia

Follow the instructions below to complete these tasks:

1. In Actuate, open Management Console.
2. Select **Files & Folders** from the Side Menu.
3. Go to the folder that contains the old version of the report executable (.ROX) file, if one exists.
4 Place your cursor over the arrow icon to the left of the report (for example, inventory_balance_tbl_act). Click **Delete** to delete the existing report executable.

5 To delete this file, click **OK** when prompted. The report executables reappear.

**NOTE** If you do not delete this report, multiple versions of the same report open in the Encyclopedia.

6 The Report Executables reappear. Click **Add File**.

*Encyclopedia Page (Files & Folders) with Inventory Balance Report Selected*
Adding Compiled Reports to the Encyclopedia

7 Type the name of the report in the File field; or click Browse to select it.

8 Click Upload to upload the file to the Encyclopedia. The General Tab appears.

9 If you want to save your changes and return to the list of Files & Folders, click OK.

   If you want to save your changes and continue to display the General tab, click Apply.

When you save your changes, you add the new version of the report executable to the Encyclopedia.

Encyclopedia Page (Files & Folders) with New Inventory Report File Listed
This chapter describes the following tasks for the system administrator who will maintain the Report Server:

- Setting up Factories and Processors
- Increasing the maximum JVM Heap Size on the iServer
- Compiling Reports in Batch Format
- Clearing a Completed Notice
- Clearing Multiple Completed Notices
- Archiving reports

### Setting Up Factories and Processors

The following section describes how the system administrator should set up your factories and processors. The factory follows instructions in the report executable (.rox or .dox) to generate report (.roi) or query report (.doi) files. The factory process generates report output from a report executable file and notifies you when the reports are completed.

To set up your factories and processors, complete the following steps:

1. In Actuate, open Management Console.
2. Select System Administration from the Log in to drop-down list.

**NOTE** Use the password you entered for the system administrator during the Actuate iServer installation.

3. Click Log in to log in to management Console as the System Administrator. The Management Console appears.
4. Select the Servers option from the side menu. Actuate displays information about the server.
5. Click your server name or click the down arrow next to server name and select Properties to open the Properties Tabs.
6. Select the Factory Service tab.
7. Complete the following fields to set your Factory Service parameters. You might need to change the default values to enhance your company's system performance.
Max factory processes – The maximum number of concurrent factory processes for both synchronous and asynchronous jobs. The default is 4.

NOTE Synchronous reports are progressive. The first report page opens immediately. The remaining pages open as they generate or as the user requests them.

Asynchronous jobs run as background reports. All scheduled reports are run as asynchronous jobs.

Number of factories to reserve for synchronous jobs – The number of processes used for synchronous jobs. The default is 2.

NOTE To determine the number of processes for asynchronous jobs, you must subtract the Number of factories to reserve for synchronous jobs from the Max factory processes. For example, if you use the default values, the total number of factories for asynchronous jobs is 2 (4 factory processes minus 2 reserved for synchronous jobs).

Transient Reports

The e-mail feature is not compatible with transient reports. Therefore, do not modify the default settings in the following three transient-related fields:

- Transient report cache size – the maximum size of cache used for temporary reports. You cannot set the maximum size to exceed the default value (100MB).

- Transient report cache location – the location of the temporary report cache.

- Transient report timeout – the maximum number of minutes before Maximo deletes from the cache those files used for the temporary report. The default is 30 minutes.

Synchronous Jobs

The e-mail feature is not compatible with synchronous jobs. Therefore, do not modify the default settings in the following four synchronous-related fields.

- Max synchronous job runtime – the maximum time, in seconds, allowed to complete the progressive (synchronous) report generation. The default is 300 seconds. Actuate recommends a time of less than 900 seconds (15 minutes). If your report is not completed in the allotted time, it is cancelled.

- Max synchronous job queue size – the maximum number of progressive (synchronous) or temporary jobs allowed in the queue. The default is 100.

- Max synchronous job queue wait time – the maximum time, in seconds, a progressive (synchronous) or temporary job can stay in the queue. The default is 600 (10 minutes).

- File types this server can generate and print – The file types, separated by commas, which Actuate uses to generate and print reports.

Click OK.
You can increase your JVM (Java™ Virtual Machine) Heap Size on the iServer to improve Actuate performance for any reports that have charts. To increase your JVM Heap Size, complete the following steps:

1. In Actuate, open the **Management Console Sign-in** dialog box.

2. Select System Administration from the **Log in to** drop-down list.

3. Click **Log in** to log into Management Console as the System Administrator. The Management Console appears.

   **NOTE** Use the password you entered for the system administrator during the Actuate iServer installation.

4. Select the Servers option from the side menu.

5. Click your server name or click the down arrow next to server name and select Properties to open the Properties Tabs.

6. Select the Advanced tab.

7. Click Chart Server to open the Server Properties dialog box where you can change your chart server properties.

8. In the **Chart server max heap size** field, enter 256.

9. Click **OK** to save the change. The Advanced tab reappears.

10. Restart your Actuate iServer to increase the JVM maximum heap size.
Compiling Reports in Batch Format

The oracompile.bat file is in your default\config folder and lets you compile many reports simultaneously. To run the oracompile.bat file, complete the following steps:

1. Using Windows Explorer, navigate to your default\config folder and open either oracompile.bat (Oracle), sqlcompile.bat (SQL Server), or db2compile.bat (IBM DB2). Use Microsoft Notepad or another text editor to open the batch file.

2. Refer to the following table and complete the step according to where you installed e.Report Designer Professional:

<table>
<thead>
<tr>
<th>If you installed e.Report Designer Professional to . . .</th>
<th>complete this step . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>the default directory C:\Actuate8\ErdPro</td>
<td>continue to the next step.</td>
</tr>
<tr>
<td>a directory other than the default</td>
<td>modify the following line and change the directory to that location.</td>
</tr>
</tbody>
</table>
|                                                        | SET PATH=%PATH%;
|                                                        | C:\Actuate8\ErdPro\bin   |
|                                                        | After you modify this line, it appears as:                       |
|                                                        | SET PATH=%PATH%;<<location of eRDPro>>\bin                     |

3. Modify the following line so that it contains the folder where you are copying the Reports_Source (.rod) files.

   SET REPORT_ROOT=C:\Report_BUILDS\Reports_Source

   After you modify this line, it appears as:

   SET REPORT_ROOT=<<location of Reports_Source (.rod) files>>

4. Save the revised batch file.
Clearing a Completed Notice

After you schedule a report, Actuate creates a completed notice for that report. This notice provides detailed information on the report. Since these report notices build up over time, you should delete them if you do not use them.

To delete an individual completed notice for a purchase order report, complete the following steps:

1. In Actuate, log in to Management Console.
2. Select the Jobs options from the side menu and choose the Completed tab.
3. Place your cursor over the arrow icon to the left of the job notice you want to delete.
4. Right click the completed folder and select Delete to open the Confirm Deletion dialog box.

**CAUTION** You cannot recover a deleted notice.

5. Click OK to confirm the deleted notice. The page reopens with the selected job deleted.
Clearing Multiple Completed Notices

Since Actuate creates a completed notice each time you schedule a report, you might find it more convenient to clear multiple completed notices at one time instead of individually. To set Actuate to delete all .roi and .doi completed notices for all subfolders in your RPT folder, complete the following steps:

**NOTE** Use these steps if you want to delete large numbers of completed notices through the RPT report level.

1. In Actuate, log in to Management Console.

2. Select the Files & Folders option from the side menu.

3. Select the RPT folder to change properties for all subfolders in that folder. Your RPT folder contains subfolders corresponding to each of your Maximo applications.

4. Right-click the down arrow next to rpt and select Properties to open the properties tabs.

5. Select the Auto Archive tab and complete the following fields:

   ▼ **File Type** – Select Actuate Report Document (roi).

   ▼ **Delete when older than** – Enter 1 so that .roi files will be deleted after one day. Actuate now will delete all completed notices in every subfolder in your RPT folder.

6. Click **Apply**, then **OK**. The rpt folder reopens.

7. Repeat steps 4 – 6 and select all .doi file types in the **FileType** drop-down list.
Archiving Reports

You can archive reports to clean out your reports folders periodically. For more information about archiving, see the Using Actuate Management Console in the manuals folder on the Actuate Reporting Release 8 e.Report Designer Professional CD.

**WARNING** Archiving is equivalent to deleting. You CANNOT retrieve archived reports. You should archive only report document files (.roi).

To set up an auto archive policy to delete all .roi after two days, complete the following steps:

1. In Actuate, log in to Management Console.
2. Select Files & Folders from the side menu.
3. Right-click your Encyclopedia (the first level in the tree below Encyclopedia).
   or
   Right-click a report folder.
4. Choose Properties, then select the Auto Archive tab.
5. Complete the following fields:
   - **File Type** – Select Actuate Report Document (.roi).
   - **Delete when older than** – Enter 2 days (the default).
6. Click **Apply**, then **OK**. Actuate now will archive the reports in your encyclopedia or the folder you selected.
Setting Up Localized Reports and Queries in Maximo

Overview
This chapter contains information you need to localize your reports and queries in Maximo. This overview briefly describes each section in this chapter.

Determining report language – a description and flowchart of how Maximo determines whether you run a report in English or a localized language

Reports
Localizing reports – This section contains the following report-related tasks:

- Localizing report data – using e.Report Designer Professional to localize your report data, a listing of specific fields Maximo enables for localization “out of the box,” and how to set up the hyperlinks in your report to accept localized data

- Setting the label value Maximo displays on your report – modifying how your localized label appears in your report

- Populating the REPORTLABEL table – using e.Report Designer Professional to place localized data into the REPORTLABEL table that you will use to run a localized report

- Changing the value of report labels – using the Report Administration application to change the value of report labels

- Localizing cross-tab reports – describing how cross-tab reports differ from other types of reports.

Queries
Localizing queries – This section contains the following query-related tasks:

- Viewing query label values – setting query labels values in e.Report Designer Professional

- Localizing query data – changing your query’s SQL statement to run against your localized database

- Adding query labels – using the Report Administration application to add and change query labels
When you run reports, Maximo determines the language you are using and passes the information to Actuate. When Actuate receives this information, it compares it to the BASELANGUAGE setting of the MAXVAR (Maximo variable) table.

The following table shows the two possible results.

**Creating a Localized Report Table**

<table>
<thead>
<tr>
<th>If the BASELANGUAGE setting of the MAXVAR table and the language you are using are . . .</th>
<th>Maximo displays report information . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>the same</td>
<td>in the language indicated by the BASELANGUAGE setting of the MAXVAR table.</td>
</tr>
<tr>
<td>different</td>
<td>in your localized language, indicated by (L_{&lt;&lt;table name&gt;&gt;})</td>
</tr>
<tr>
<td></td>
<td>where</td>
</tr>
<tr>
<td></td>
<td><strong>&lt;&lt;table name&gt;&gt;</strong> is the base language table name).</td>
</tr>
</tbody>
</table>
Determining Report Language

The following flowchart shows how Maximo determines whether to use the BASELANGUAGE setting of the MAXVAR table or your localized language when one of your users runs a report.

The flowchart shows the divergence in data between the base language (the default BASELANGUAGE setting of the MAXVAR table is English) and the localized language (defined in L_<tablename>). In this example, a Spanish language user runs a Commodity Analysis Report.

Determining Your Report Language Flowchart

User opens Maximo session in browser

Maximo determines language based on the following items, listed by priority:
- User profile
- Language link on sign-in page
- Browser setting

User accesses reports and submits request using report request page

User opens Actuate session and selects Commodity Analysis

Report data

Is the BASELANGUAGE setting of the MAXVAR table different than the language of the passed Maximo values?

Maximo reads ITEM table

User sees report data in English

Examples:
Data1 = bearings
Data2 = pump

Maximo reads L_ITEM table

User sees report data in Spanish

Examples:
Data1 = bomba
Data2 = análisis de bienes

Maximo reads REPORTLABEL table

User sees report titles and labels in English

Examples:
Title = Commodity Analysis
Label = Description

Maximo reads L_REPORTLABEL table

User sees report titles and labels in Spanish

Examples:
Title = análisis de bienes
Label = descripción

Setting Up Localized Reports and Queries in Maximo 13-3
Localizing Reports

This section describes the following topics. These topics must be completed in order to localize your report data.

- Localizing report data – using e.Report Designer Professional to localize your report data, a listing of specific fields IBM Corporation enables for localization “out of the box,” and how to set up the hyperlinks in your report to accept localized data.

- Setting the label value Maximo displays on your report – modifying how your localized label appears in your report.

- Populating the REPORTLABEL table – using e.Report Designer Professional to place localized data into the REPORTLABEL table that you will use to run a localized report.

- Changing the value of report labels – using the Report Administration application to change the value of report labels.

**NOTE** If you are localizing a crosstab report, see “Localizing Cross-Tab Reports,” on page 13-11.
Localizing Report Data

IBM Corporation has added customized controls to Actuate that allow you to localize your reports in multiple languages. You can access these controls through e.Report Designer Professional. By customizing these controls, IBM Corporation provides Actuate with the capability to pull data from localized fields in addition to the base language fields.

This section describes how to customize three localization controls that exist in both the BaseDynamicTextControl library and BaseTextControl library so localized data appears in the report.

1. Open the source file of the report you want to modify in e.Report Designer Professional.

2. Select the field you want to modify, right-click, and select Properties to open the Properties dialog box.

3. Select the Properties tab.

   As an example, set the Vendor’s Name field in the Vendor Contract report by completing the following properties:

   ▼ MROAttributeName – This control determines the Maximo field name for the data control. Set this control to NAME.

   ▼ MROObjectName – This control determines the Maximo table for the data control. Set this control to COMPANIES.

   ▼ UseLocalization – This control determines if your Maximo database reads localized data. The default for this property is False. Set this control to True to enable Maximo to use localized data.

   **NOTE** You must update the query for the report so that it contains the ID field of the MROObjectName. The ID field is usually the SAMEASATTRIBUTE field for the OWNERID of the localized table.

   You can run the following SQL statement to determine the ID field to add to your query:

   ```sql
   select sameasattribute from maxattribute where objectname = 'L_COMPANIES' and attributename = 'OWNERID'
   ```

4. Modify the query to include COMPANIES.COMPANIESID as shown in the following example:

   ```sql
   select compcontact.company, companies.name, compcontact.contact, compcontact.position, compcontact.email, compcontact.voicephone, compcontact.faxphone, companies.companiesid from maximo.companies, maximo.compcontact where compcontact.company = companies.company and compcontact.orgid = companies.orgid and compcontact.orgid = :mroOrg and 1=1 order by compcontact.company
   ```
Identifying System Default Localized Tables

The following table lists those reports and fields that IBM Corporation enables for data localization “out of the box.”

“Out of the Box” Localized Reports Table

<table>
<thead>
<tr>
<th>Report File Name</th>
<th>Field</th>
<th>Class Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>vendor_contacts_act.rox</td>
<td>Name</td>
<td>BaseDynamicText1</td>
</tr>
<tr>
<td>item_orderstatus_act.rox</td>
<td>Description</td>
<td>BaseDynamicText1</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>ITEMDESCControl</td>
</tr>
<tr>
<td>commodity_anly_act.rox</td>
<td>Item Description</td>
<td>BaseDynamicText2</td>
</tr>
</tbody>
</table>

IBM Corporation does not localize additional reports “out of the box” due to the impact on Maximo performance.

Setting Up Hyperlinks

If you use hyperlinks in your reports, you must include the mroLangCode in the report’s link expression to pass the correct localized values to the hyperlinked report. The link expression defines the hyperlink for the report.

The following example shows a hyperlink form the PO List Report to the PO Status Report with the mroLangCode highlighted:

```
";ParmUserName=" & ParmUserName & ";mroSite=" & rowSite & 
";mroOrg=" & mroOrg & ";mroRootFolder=" & mroRootFolder & 
"&schema=" & schema & 
"&connectString=" & connectString & 
"&mroLangCode=" & mroLangCode & 
"&mroDbType=" & mroDbType
```

For general information on adding hyperlinks to reports, see “Creating a Hyperlink from One Report to Another,” on page 9-20.
Setting the Label Value Maximo Displays on Your Report

There are two ways you can supply label values to populate the report label table in Maximo:

▼ You can populate the **MROAttributeName** control and **MROObjectName** controls in the Properties dialog box for that label. For more information, see page 13-8.

▼ You can leave the **MROAttributeName** control and **MROObjectName** control blank and supply the label text through the Text control in the Properties dialog box for that label. In the Maximo reports that IBM Corporation provides to you “out of the box,” label data is provided through this method. For more information, see page 13-8.
Setting the Label Value Maximo Displays on Your Report

Providing Data from the MROAttributeName and MROObjectName Controls

To have report labels supplied by the MROAttributeName and MROObjectName controls, complete the following steps:

1. Open the report in e.Report Designer Professional, select the label you want to update, and open the Properties dialog box for that label.

2. In the Properties dialog box, set the value in the UseMaximoLabel control to True. When the UseMaximoLabel control is true, Maximo uses the MAXATTRIBUTE.TITLE value from the defined MROAttributeName and MROObjectName controls.

3. Enter values in the MROAttributeName and MROObjectName controls.

After you publish the labels of a report to the Maximo database, Actuate pulls data from the corresponding title field. When you run the report in your browser, the report label appears as Description.

NOTE: You can run the following SQL Statement to determine the label that appears on your report:

```
select title from maxattribute where objectname = 'COMPANIES' and attributename = 'NAME'
```

After you complete this section, continue on to the section “Providing Data from the Text Control,” on page 13-9.

Providing Data from the Text Control

To have report labels supplied by the Text control, complete the following steps:

1. Open the report in e.Report Designer Professional, select the label you want to update, and open the Properties dialog box for that label.

2. Accept the default value (False) for the UseMaximoLabel control.

3. Enter a value in the Text control. You may have already populated this field.
Populating the REPORTLABEL Table

Your REPORTLABEL table contains all of the report labels for those reports that IBM Corporation provides to you “out of the box.” If you want to use the Maximo Report Label feature to localize your reports, you must populate the titles and labels in the REPORTLABEL table when you create your new report.

Complete the following steps:


2. In the MROReportName control, enter the name of the file you created but do not include the .rox extension. In the figure shown, the file name item_orderstatus_act is for the Item Order Status Report.

3. In the PublishReportToDB control, change the value to True.

4. Close the Properties dialog box.

5. Click File>Save.

NOTE Before running your report, check your global variables. They must be set to the database against which you want to run the report.

6. Select the Run icon to build and run your report. By running the report, you enable the report’s file name, title, and labels to be populated to the REPORTLABEL table.

7. In the PublishReportToDB control, change the value back to False.

8. Compile the report to create an .rox file.

9. Publish the report to the Actuate Encyclopedia.

After you store the report title and label in the Maximo database, you can modify these fields through the Maximo Report Administration application.
Changing the Value of Report Labels

After publishing your report labels to the Maximo database, complete the following steps to change the values of report labels in your report. For this example, you will change the labels in the Job Plan List Report.

**NOTE**
To change the values of the fields in Job Plans or any other Maximo application, use Application Designer.

1. Open the Report Administration application in Maximo. For this example, select the Job Plan List report and view the labels for it on the Labels tab.

2. Click Preview on the Report tab to show how the report opens to the user.

3. Return to the Labels tab and change the Label Value for each of the following tables.

**Label Heading Replacement List**

<table>
<thead>
<tr>
<th>Replace . . .</th>
<th>With . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Plan List</td>
<td>JP List</td>
</tr>
<tr>
<td>Job Plan</td>
<td>JP #</td>
</tr>
<tr>
<td>Description</td>
<td>JP Description</td>
</tr>
<tr>
<td>Duration</td>
<td>JP Duration</td>
</tr>
</tbody>
</table>

4. Save your changes and preview the newly revised report with the new label values.
Localizing Cross-Tab Reports

You cannot localize all of the report labels for cross-tab reports. Due to the unique property values of this type of report, you cannot populate these labels to the Maximo database. Maximo publishes only the titles and header labels for cross-tab reports.

The following table lists cross-tab reports and their filenames.

**Cross-Tab Reports and File Names Table**

<table>
<thead>
<tr>
<th>Cross-Tab Report</th>
<th>File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Availability Report</td>
<td>asset_availability_act.rox</td>
</tr>
<tr>
<td>Asset Cost Rollup Report</td>
<td>asset_costrollup_act.rox</td>
</tr>
<tr>
<td>Location Availability Report</td>
<td>loc_availability_report.rox</td>
</tr>
<tr>
<td>Projected PM Labor Requirements</td>
<td>projected_pm_labor_requirements.rox</td>
</tr>
<tr>
<td>WO Material Shortage Report</td>
<td>wo_matbal_tbl_act.rox</td>
</tr>
</tbody>
</table>
Localizing Queries

This section describes the following topics that must be completed for you to localize your query data.

▼ Viewing query label values – checking query labels values in e.Report Designer Professional

▼ Localizing query data – changing your query’s SQL statement to run against your localized database

▼ Adding query labels – using the Report Administration application to add and change query labels

Viewing Query Label Values

Use the following instructions to see how localized field labels display for your queries. You will check your Maximo database to see if any query values exist in the REPORTLABEL table.

1. In e.Report Designer Professional, click the Data Row Editor icon to open the Data Row Editor dialog box where you can add or modify the columns of the query.

**Data Row Editor Dialog Box**

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Display Name</th>
<th>Type</th>
<th>Native Type</th>
<th>Format</th>
<th>Width (Chars)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITEMNUM</td>
<td>Item Number</td>
<td>String</td>
<td>VARCHAR2(2</td>
<td>80</td>
<td></td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>Description</td>
<td>String</td>
<td>VARCHAR2(...</td>
<td>80</td>
<td></td>
</tr>
<tr>
<td>ROTATING</td>
<td>Rotating Item</td>
<td>Double</td>
<td>NUMBER</td>
<td>22</td>
<td></td>
</tr>
<tr>
<td>COMMODITYGROUP</td>
<td>Commodity Group</td>
<td>String</td>
<td>VARCHAR2(6)</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>COMMODITY</td>
<td>Commodity</td>
<td>String</td>
<td>VARCHAR2(8)</td>
<td>17</td>
<td></td>
</tr>
<tr>
<td>LOTTYPE</td>
<td>Lot Type</td>
<td>String</td>
<td>VARCHAR2(...)</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>CAPITALIZED</td>
<td>Is Capitalized</td>
<td>String</td>
<td>VARCHAR2(1)</td>
<td>22</td>
<td></td>
</tr>
<tr>
<td>OUTSIDE</td>
<td>Is Outside</td>
<td>String</td>
<td>VARCHAR2(1)</td>
<td>22</td>
<td></td>
</tr>
<tr>
<td>INSPECTIONREQUIRED</td>
<td>Inspection Required</td>
<td>String</td>
<td>VARCHAR2(1)</td>
<td>22</td>
<td></td>
</tr>
<tr>
<td>SPAREPARTAUOTADD</td>
<td>Auto Add Spare Part</td>
<td>String</td>
<td>VARCHAR2(1)</td>
<td>22</td>
<td></td>
</tr>
<tr>
<td>CONDITIONENABLED</td>
<td>Is Condition Enabled</td>
<td>String</td>
<td>VARCHAR2(1)</td>
<td>22</td>
<td></td>
</tr>
</tbody>
</table>

2. You identify the value for the query label by its report file name and label key (the field's variable name).

For example, if you were looking for the value of the Item Number label in the Item Query, you would run the following SQL statement:

```
select labelvalue from REPORTLABEL where reportname = 'item.dox'
and labelkey = 'ITEMNUM';
```

3. If the REPORTLABEL table does not contain any values, the Maximo query appears with the Display Name of the field from e.Report Designer Professional.

**NOTE** All queries shipped to you by IBM Corporation have their field values in the REPORTLABEL table.
Localizing Query Data

Since queries do not use report controls, they cannot be localized in the same way as reports. To run your query with localized information, you must modify the corresponding SQL statement for that query.

The following example shows how you can modify the SQL Statement for the Item Query to accept a localized item description. The SQL statement appears before and after you add or modify text to localize the query.

Note bolded sections where you will change or append information:

**SQL Statement in English Language**

```
select item.itemnum, item.description, item.rotating, item.commoditygroup, item.commodity, item.lottype
from MAXIMO.item
where item.itemtype in (select value from MAXIMO.synonymdomain
                      where domainid = 'ITEMTYPE' and maxvalue = 'ITEM')
```

You must change the following items in this statement to accept values from the localized language:

- change `item.description` to `l_item description` to indicate that Maximo must use the localized item description data
- append `MAXIMO.l_item` to the “from statement” to indicate that Maximo must run the query for the item description from the localized Maximo data table

```
select item.itemnum, l_item.description, item.rotating, item.commoditygroup, item.commodity, item.lottype
from MAXIMO.item, MAXIMO.l_item
where item.itemtype in (select value from MAXIMO.synonymdomain
                      where domainid = 'ITEMTYPE' and maxvalue = 'ITEM')
      and item.itemid = l_item.ownerid
```
Adding Query Labels

To add label values for new queries, follow these instructions. In this section, you will create a new query called Example and a field (label) for that query called WONUM (Work Order Number).

**NOTE**  ▼ Queries do not use controls so their report label setup is different than reports.

▼ You also can use the following steps to add or change a label in any of the queries IBM Corporation provides to you “out of the box.”

1 Open the Report Administration application and select your query.

2 Click the Labels tab.

3 Click **New Row**. Enter values in the following fields:

    ▼ **Label Key** – Enter the variable name. In this example, WONUM is the variable name.

    ▼ **Label Value** – Enter the display name. In this example, Work Order # is the label display name.

    ▼ **Column Width** – Enter the column width for the label you select. In this example, 22 is the column width.

4 Click **Save** to add the new query label to the Maximo database.

5 Click the Report tab.

6 Click **Preview**. The report label appears exactly as you entered it.

**NOTE**  You do not have to regenerate XML when you change a query.
The MAXIMO.PROPERTIES file is the Maximo configuration file. You selected the folder location for this file and property values during installation. The tables in this appendix contain the following items and descriptions from the MAXIMO.PROPERTIES file:

- report server properties
- database properties mentioned in either Chapter 4, “Creating Spreadsheet Reports” or Chapter 5, “Using Maximo Query in e.Report Designer Professional.”

**NOTE** If you change the report server properties in MAXIMO.PROPERTIES, you must remove the Actuate Web module that holds the war files, rebuild, and redeploy. For information about building an Enterprise Application Archive file, refer to the Maximo System Administrator’s Guide.

For information about the following topics, refer the Maximo System Administrator’s Guide.

- all properties in the MAXIMO.PROPERTIES file
- Maximo security
## Report Server Properties

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mxe.report.actuate.reportserver</td>
<td>The machine name of the report server that accesses the Encyclopedia (also referred to as the Volume).</td>
</tr>
<tr>
<td>mxe.report.actuate.portalHost</td>
<td>The URL of the Active Portal Server, including port number and folder. The default folder name is acweb.</td>
</tr>
<tr>
<td>mxe.report.actuate.iServer</td>
<td>The URL of the Actuate iServer, including port number.</td>
</tr>
<tr>
<td>mxe.report.actuate.db.connectstring (Oracle)</td>
<td>The Actuate Encyclopedia uses this property to access the database. This property must specify a connection string on the Actuate server. The connection string must reference the same Oracle database that Maximo runs against. The connection string is the tnsnames.ora alias of the Oracle system identifier (SID).</td>
</tr>
<tr>
<td>mxe.report.actuate.db.connectstring (SQL Server)</td>
<td>The Actuate Encyclopedia uses this property to access the database. This property must specify a Data Source Name (DSN) on the Actuate server. The DSN must reference the same SQL Server database that Maximo runs against.</td>
</tr>
<tr>
<td>mxe.report.actuate.db.connectstring (IBM DB2)</td>
<td>The Actuate Encyclopedia uses this property to access the database. This property must specify a Database Alias on the Actuate server. The Databases Alias must reference the same IBM DB2 database that Maximo runs against.</td>
</tr>
<tr>
<td>mxe.report.actuate.rootEncycFolder</td>
<td>The Actuate Encyclopedia root folder name that contains all the subfolders, reports, and queries. The default is rpt.</td>
</tr>
<tr>
<td>mxe.report.actuate.rsseAlias</td>
<td>The alias name of the RSSE (Report Server Security Extension). RSSE lets you direct your Actuate server to an external security system for all authentication and security information. The default is localhost.</td>
</tr>
<tr>
<td>mxe.report.actuate.multiServer</td>
<td>The property that indicates whether multiple Maximo instances use one Actuate server (yes) or multiple Actuate servers (no). The default is no.</td>
</tr>
</tbody>
</table>
## Database Properties

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mxe.db.driver (Oracle)</td>
<td>The Oracle thin driver: oracle.jdbc.driver.OracleDriver</td>
</tr>
<tr>
<td>mxe.db.driver (SQL Server)</td>
<td>The SQL Server driver: com.inet.tds.TdsDriver</td>
</tr>
<tr>
<td>mxe.db.driver (IBM DB2)</td>
<td>The SQL Server driver: com.ibm.db2.jcc.DB2Driver</td>
</tr>
<tr>
<td>mxe.db.url (Oracle)</td>
<td>The default URL is:</td>
</tr>
<tr>
<td></td>
<td>jdbc:oracle:thin@&lt;dbserver&gt;:1521:&lt;sid&gt;</td>
</tr>
<tr>
<td></td>
<td>where</td>
</tr>
<tr>
<td></td>
<td>▼  &lt;dbserver&gt; is the name of your database server.</td>
</tr>
<tr>
<td></td>
<td>▼  1521 is your default Oracle port number.</td>
</tr>
<tr>
<td></td>
<td>▼  &lt;sid&gt; is your Oracle system identifier.</td>
</tr>
<tr>
<td>mxe.db.url (SQL Server)</td>
<td>The default URL is:</td>
</tr>
<tr>
<td></td>
<td>jdbc:inetdae7a:&lt;servername&gt;:1433?</td>
</tr>
<tr>
<td></td>
<td>database=&lt;databasename&gt;&amp;language=us_english&amp;nowarnings=true</td>
</tr>
<tr>
<td></td>
<td>where</td>
</tr>
<tr>
<td></td>
<td>▼  &lt;servername&gt; is your database server name.</td>
</tr>
<tr>
<td></td>
<td>▼  1433 is your default SQL Server port number.</td>
</tr>
<tr>
<td></td>
<td>▼  &lt;databasename&gt; is your SQL Server database name.</td>
</tr>
<tr>
<td></td>
<td>Note: You can follow the string jdbc:inetdae with 7 (supports Unicode) or 7a (supports ascii). Currently, Maximo supports only ascii for SQL Server.</td>
</tr>
<tr>
<td>mxe.db.url (IBM DB2)</td>
<td>The default URL is:</td>
</tr>
<tr>
<td></td>
<td>jdbc:db2://&lt;host name&gt;:50000/&lt;database alias&gt;</td>
</tr>
<tr>
<td></td>
<td>where</td>
</tr>
<tr>
<td></td>
<td>▼  &lt;host name&gt; is your database server name.</td>
</tr>
<tr>
<td></td>
<td>▼  50000 is your default IBM DB2 port number.</td>
</tr>
<tr>
<td></td>
<td>▼  &lt;database alias&gt; is the name you use to refer to the IBM DB2 database.</td>
</tr>
</tbody>
</table>
## Database Properties

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| mxe.db.user            | The name of the database user the server uses to attach to the database server.  
                          | This user must be the schema owner. The default is maximo.                  |
| mxe.db.password        | The password for the database schema owner user.                             
                          | The default is maximo.                                                     |
| mxe.db.schemaowner     | The owner of the database schema.                                            
                          | The default schemaowner is maximo.                                          |
This appendix helps you configure the two Report Server Security Extension (RSSE) properties files in Maximo. In order to have multiple instances of Maximo access a single Actuate Report Server, you must configure these files.

**NOTE**

For more information about RSSE files, refer to Document Identification Number M04749 on the Support Online Web site’s Knowledge Base.

Maximo contains two RSSE-related properties files:

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSSE_LOCALHOST.PROPERTIES</td>
<td>connection properties for JDBC, Maximo, and LDAP</td>
</tr>
<tr>
<td>RSSE_MAXIMO.PROPERTIES</td>
<td>connection properties for JDBC, Maximo, and LDAP as well as Maximo role mapping properties</td>
</tr>
</tbody>
</table>

**RSSE_Localhost.Properties and RSSE_Maximo.Properties Files**

This section contains descriptions for JDBC, Maximo, and LDAP connection properties in the RSSE_LOCALHOST.PROPERTIES and the RSSE_MAXIMO.PROPERTIES file.
### JDBC Connection Properties

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| jdbc.url (Oracle)     | The default URL: jdbc:oracle:thin@<dbserver>:1521:<sid> where  
  ▼ <dbserver> is the name of your database server.  
  ▼ 1521 is your default Oracle port number.  
  ▼ <sid> is your Oracle system identifier. |
  ▼ <servername> is your database server name.  
  ▼ 1433 is your default SQL Server port number.  
  ▼ <databasename> is your SQL Server database name.  

Note: You can follow the string jdbc:inetdae with 7 (supports Unicode) or 7a (supports ascii). Currently, Maximo supports only ascii for SQL Server. |
| jdbc.url (IBM DB2)    | jdbc:db2://<host name>:50000/<database alias> where  
  ▼ <host name> is your database server name.  
  ▼ 50000 is your default IBM DB2 port number.  
  ▼ <database alias> is the name you use to refer to the IBM DB2 database. |
| jdbc.username         | User name for the jdbc connection.  
The default is maximo. |
| jdbc.password         | Password for the jdbc connection.  
The default is maximo. |
Maximo Connection Properties

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>jdbc.driverClass (Oracle)</td>
<td>The Oracle thin driver: oracle.jdbc.driver.OracleDriver</td>
</tr>
<tr>
<td>jdbc.driverClass (SQL Server)</td>
<td>The SQL Server driver: com.inet.tds.TdsDriver</td>
</tr>
<tr>
<td>jdbc.driverClass (IBM DB2)</td>
<td>The IBM DB2 driver: com.ibm.db2.jcc.DB2Driver</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>maximo.host</td>
<td>The IP address of the Server name where Maximo runs. The default is 172.22.50.15.</td>
</tr>
<tr>
<td>maximo.port</td>
<td>The RMI registry port for Maximo. The default is 1099.</td>
</tr>
<tr>
<td>maximo.servername</td>
<td>The Maximo server name. This property must be the same as that used for the mxe.name property in the Maximo.Properties file. The default is MXServer.</td>
</tr>
</tbody>
</table>

LDAP Connection Properties

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ldap.context.factory</td>
<td>The context factory LDAP uses to access the Maximo server. The default is com.sun.jndi.ldap.LdapCtxFactory.</td>
</tr>
<tr>
<td>ldap.provider.url</td>
<td>The LDAP URL of your Maximo server. Default url: ldap://172.22.4.8.389</td>
</tr>
<tr>
<td>ldap.user.basedn</td>
<td>The top level of the LDAP directory tree. Default values for Organizational Unit (OU) and Domain Component (DC): OU=Bedford DC=maximodev DC=Maximo DC=com</td>
</tr>
</tbody>
</table>
## Maximo Role Mapping Properties
(MSSE_Maximo.Properties File Only)

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rsse.internalrole.all</td>
<td>Maximo assigns the all role to all users. Default: all</td>
</tr>
<tr>
<td>rsse.internalrole.administrator</td>
<td>Users with the administrator role can modify folders and reports as well as user and role privileges. Default: MAXADMIN</td>
</tr>
<tr>
<td>rsse.internalrole.operator</td>
<td>Users with the operator role can modify folders and reports, but not user and role privileges. Default: SYSADM.</td>
</tr>
<tr>
<td>rsse.multiserver</td>
<td>RSSE Multiserver property. This property indicates whether multiple Maximo instances use one Actuate server (no) or many.</td>
</tr>
</tbody>
</table>
This appendix helps you to configure the ACTUATEI18NTEXT.PROPERTIES file in Maximo. You must configure this file so that many instances of Maximo can access a single Actuate Report Server.

**NOTE** For more information about the ACTUATEI18NTEXT file, search for Doc ID M04749 in the Knowledge Base of the Support Online Web site.

The ACTUATEI18NTEXT.PROPERTIES file lets you establish database access to externalized text in Maximo. In order to define these properties, you must define these parameters.

The following table provides the property names and descriptions for the ACTUATEI18NTEXT.PROPERTIES file.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| actuate.externText.JDBCDriverName (Oracle) | The Actuate externalized-text JDBC thin driver name.  
Default: oracle.jdbc.driver.OracleDriver. |
| actuate.externText.JDBCDriverName (SQL Server) | The Actuate externalized-text JDBC driver name.  
Default: com.inet.tds.TdsDriver |
| actuate.externText.JDBCDriverName (IBM DB2) | The Actuate externalized-text JDBC driver name.  
Default: com.ibm.db2.jcc.DB2Driver |
| actuate.externTextJDBCConnectionURL (Oracle) | The Actuate externalized-text JDBC connection. Default URL:  
jdbc:oracle:thin@<dbserver>:1521:<sid>  
where  
$dbserver$ is the name of your database server.  
$1521$ is your default Oracle port number.  
$<sid>$ is your Oracle system identifier. |
<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>actuate.externTextJDBCConnectionURL (SQL Server)</td>
<td>The Actuate externalized text JDBC connection. Default URL: ( \text{jdbc:inetdae7a:&lt;servername&gt;:1433?database=&lt;databasename&gt;&amp;language=us_english&amp;nowarnings=true} ) where (&lt;\text{servername}&gt;) is your database server name. (1433) is your default SQL Server port number. (&lt;\text{databasename}&gt;) is your SQL Server database name. <strong>NOTE</strong> You can follow the string (\text{jdbc:inetdae7}) with either 7 (supports Unicode) or 7a (supports ascii). Currently, Maximo supports only ASCII for SQL Server.</td>
</tr>
<tr>
<td>actuate.externTextJDBCConnectionURL (IBM DB2)</td>
<td>The Actuate externalized text JDBC connection. Default URL: ( \text{jdbc:db2://&lt;host name&gt;:50000/&lt;database alias&gt;} ) where (&lt;\text{host name}&gt;) is your database server name. (50000) is your default IBM DB2 port number. (&lt;\text{database alias}&gt;) is the name you use to refer to the IBM DB2 database.</td>
</tr>
<tr>
<td>actuate.externText.username</td>
<td>The Actuate externalized text user name. Default: maximo.</td>
</tr>
</tbody>
</table>
This section contains a list and description of the common terms used in this document. For more information, see the *Actuate 8 Glossary* in the manuals folder on the Actuate Reporting Release 8 e.Report Designer Professional CD.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active Portal</strong></td>
<td>Lets you use the Web to access reports in your Encyclopedia through Microsoft Internet Explorer.</td>
</tr>
<tr>
<td><strong>Actuate Query</strong></td>
<td>An Ad-Hoc Report. Enables Maximo End Users to choose the content, grouping, sorting, filtering and formatting of their own unique report.</td>
</tr>
<tr>
<td><strong>ad hoc parameter</strong></td>
<td>In e.Report Designer and e.Report Designer Professional, a parameter associated with a database column that passes an expression to extend dynamically the query’s where clause. An ad hoc parameter restricts the number of rows returned from the database to the report.</td>
</tr>
<tr>
<td><strong>Archive</strong></td>
<td>See Auto-Archive.</td>
</tr>
<tr>
<td><strong>asynchronous</strong></td>
<td>In Actuate iServer, a report generation process or job that runs in the background independently of other processes.</td>
</tr>
<tr>
<td><strong>auto-archive</strong></td>
<td>In Actuate, archiving is equivalent to deleting. You can not retrieve archived reports. You should archive only report document files (.roi).</td>
</tr>
<tr>
<td><strong>BAS</strong></td>
<td>See Basic Source (.bas) file.</td>
</tr>
<tr>
<td><strong>basic source (.bas) file</strong></td>
<td>A source file containing Actuate Basic code associated with a specific report design.</td>
</tr>
<tr>
<td><strong>browser scripting control</strong></td>
<td>In e.Report Designer and e.Report Designer Professional, browser scripting control supports the writing of code for your Web browser inside a report and allows you to open and use any type of Web page item.</td>
</tr>
<tr>
<td><strong>compile</strong></td>
<td>In e.Report Designer and e.Report Designer Professional, compiling translates an Actuate Basic source file and a report object design (.rod) file into a report object executable (.rox) file.</td>
</tr>
<tr>
<td><strong>Data Manager</strong></td>
<td>A Maximo e.Spreadsheet Designer tool used to create a connection between a workbook and external data, add queries, and create report ranges for the spreadsheet.</td>
</tr>
<tr>
<td><strong>Data Row Editor</strong></td>
<td>In e.Report Designer Professional, a tool used to display and sort available data rows.</td>
</tr>
<tr>
<td><strong>delete privilege</strong></td>
<td>A privilege that provides the ability to remove items from the Encyclopedia.</td>
</tr>
<tr>
<td><strong>DHTML</strong></td>
<td>See Dynamic Hypertext Markup Language (DHTML).</td>
</tr>
<tr>
<td><strong>DOI</strong></td>
<td>See Query Report Instance.</td>
</tr>
<tr>
<td><strong>DOX</strong></td>
<td>See Query Report Executable.</td>
</tr>
<tr>
<td><strong>Glossary</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Dynamic Hypertext Markup Language (DHTML)</strong></td>
<td>Dynamic Hypertext Markup Language (DHTML) is an HTML extension that provides interactivity in a Web page without needing to communicate with a Web server.</td>
</tr>
<tr>
<td><strong>Encyclopedia</strong></td>
<td>The Encyclopedia is a repository that contains all the items managed by a single iServer machine. Multiple users share these items, which include folders, report files, and user profiles.</td>
</tr>
<tr>
<td><strong>e.Report</strong></td>
<td>A structured document that follows a set of rules to organize, summarize, and present data from many records.</td>
</tr>
<tr>
<td><strong>e.Report Designer</strong></td>
<td>A flexible tools that lets report developers create or modify simple reports quickly. Reports created in e.Report Designer require no programming.</td>
</tr>
<tr>
<td><strong>e.Report Designer Professional</strong></td>
<td>A tool that report developers install on their desktop to let them create custom reports and/or modify existing reports. e.Report Designer Professional lets professional developers deliver information in any format and present reports in any layout regardless of report complexity.</td>
</tr>
<tr>
<td><strong>e.Spreadsheet Designer</strong></td>
<td>An application used to design, create, analyze, and distribute custom spreadsheets over the Web using the Actuate iServer system or an application server.</td>
</tr>
<tr>
<td><strong>Encyclopedia</strong></td>
<td>A shared repository for all information related to the reporting environment. In addition to the reports used by Maximo, the Encyclopedia contains three directories:</td>
</tr>
<tr>
<td></td>
<td>• an administrative directory – users, roles, and privileges</td>
</tr>
<tr>
<td></td>
<td>• a requests and scheduling directory – synchronous or asynchronous instructions to perform an action and jobs designated for execution at a specified time</td>
</tr>
<tr>
<td></td>
<td>• a report items directory – designs, executables, instances, parameters, files, and libraries</td>
</tr>
<tr>
<td><strong>executable (.rox) file</strong></td>
<td>A file you run to generate report documents with current data.</td>
</tr>
<tr>
<td><strong>execute privilege</strong></td>
<td>A privilege that provides the ability to run items from the Encyclopedia.</td>
</tr>
<tr>
<td><strong>Factory</strong></td>
<td>An internal tool that generates an e.report for viewing. The Factory follows the instructions in a report executable (.rox) file to generate a report (.roi).</td>
</tr>
<tr>
<td><strong>grant privilege</strong></td>
<td>A privilege that provides the ability to extend privileges for an item to other users. The user who develops an item and the administrator both have grant privileges for that item.</td>
</tr>
<tr>
<td><strong>hyperlink</strong></td>
<td>In e.Report Designer and e.Report Designer Professional, a connection from one part of a report to another part of the same or different report. Typically, hyperlinks support access to related information within the same report, in another report, or in another application.</td>
</tr>
<tr>
<td><strong>report design (.rod) file</strong></td>
<td>Components specifying the format and content of a finished report.</td>
</tr>
<tr>
<td><strong>iServer System</strong></td>
<td>A Server application that generates reports, manages them in the Encyclopedia, and makes them available to users.</td>
</tr>
<tr>
<td><strong>Java Database Connectivity</strong></td>
<td>Java Database Connectivity (JDBC) is a standard protocol used by Java to access database data sources in a platform-independent manner.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td>Join</td>
<td>An SQL query operation that combines two tables and returns them in a result set based on the values in the join fields.</td>
</tr>
<tr>
<td>JDBC</td>
<td>See Java Database Connectivity.</td>
</tr>
<tr>
<td>job</td>
<td>An asynchronous or batch process used to generate reports.</td>
</tr>
<tr>
<td>library (.rol) file</td>
<td>A file that contains reusable report components.</td>
</tr>
<tr>
<td>Management Console</td>
<td>A Web-based administration tool that enables server management from any Web-enabled desktop or device.</td>
</tr>
<tr>
<td>privilege</td>
<td>A level of control over an item in the Encyclopedia. Privileges are granted to users either directly or through roles. The privileges include the ability to delete, execute, grant, read, secure read, view, and write. The user who develops a particular item and places it in the Encyclopedia and the administrator both have all privileges for that item.</td>
</tr>
<tr>
<td>read privilege</td>
<td>A privilege that provides the ability to open, work with, and print an item in the Encyclopedia.</td>
</tr>
<tr>
<td>report object design (.rod) file</td>
<td>A design file that contains components that specify the format and content of a finished report.</td>
</tr>
<tr>
<td>report object instance (.roi) file</td>
<td>A file that contains the viewable report.</td>
</tr>
<tr>
<td>report page</td>
<td>A report returned from a request page.</td>
</tr>
<tr>
<td>report structure</td>
<td>In e.Report Designer or e.Report Designer Professional, a tool that displays the outline of the report components showing their relationships to one another.</td>
</tr>
<tr>
<td>request</td>
<td>A synchronous or asynchronous instruction to an Actuate iServer to perform an action.</td>
</tr>
<tr>
<td>ROD</td>
<td>See report object design (.rod) File.</td>
</tr>
<tr>
<td>ROI</td>
<td>See report object instance (.roi) File.</td>
</tr>
<tr>
<td>ROL</td>
<td>See library (.rol) file.</td>
</tr>
<tr>
<td>Report Server Security Extension (RSSE)</td>
<td>An Actuate iServer capability that accesses data from an external database or security source, such as an LDAP directory server, in order to manage user information.</td>
</tr>
<tr>
<td>secure read privilege</td>
<td>A privilege that provides the ability to open, work with, and print, but not download, an item in the Encyclopedia.</td>
</tr>
<tr>
<td>static parameter</td>
<td>In e.Report Designer or e.Report Designer Professional, a global variable, defined with the parameter editor, for which an end user can set an initial value when defining a report. The report developer can design the report to use the parameter’s value to affect the report’s outcome.</td>
</tr>
<tr>
<td>synchronous</td>
<td>In Actuate iServer, a report generation process or job that occurs on demand.</td>
</tr>
<tr>
<td>Template</td>
<td>A file that determines how generated HTML pages open in Internet Explorer. Template files can contain HTML tags and scripting language commands</td>
</tr>
</tbody>
</table>
which determine the format of the text, the text that should be appear, and variables that form part of your request.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Textual Query Editor</td>
<td>A textual tool in e.Report Designer Professional used to write a SQL SELECT statement.</td>
</tr>
<tr>
<td>Visible Privilege</td>
<td>A privilege that provides the ability to view items in the Encyclopedia.</td>
</tr>
<tr>
<td>Volume 1</td>
<td>A collection of Encyclopedia items managed by an Actuate e.Reporting Server. Administrators use a volume to group parts of a large Encyclopedia in convenient and manageable clusters.</td>
</tr>
<tr>
<td>Volume 2</td>
<td>The name of the machine on which the Actuate e.Reporting Server is running.</td>
</tr>
<tr>
<td>Wildcard</td>
<td>A character used in a search or conditional expression that matches one or more literal characters.</td>
</tr>
<tr>
<td>Write Privilege</td>
<td>A privilege that provides the ability to place an item in the Encyclopedia.</td>
</tr>
</tbody>
</table>
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites.
Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

**Trademarks**

AIX, IBM, IBM Corporation, the IBM logo, Tivoli, and WebSphere are registered trademarks of the International Business Machines Corporation in the United States, other countries, or both.

Intel, the Intel logo, and Pentium are registered trademarks of the Intel Corporation in the United States, other countries, or both.

Microsoft, Windows, and Internet Explorer are registered trademarks of Microsoft Corporation in the United States, other countries, or both.
Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Sun, Sun Microsystems, the Sun logo, and Solaris are trademarks of Sun Microsystems, Inc.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, and service names may be trademarks or service marks of others.
A

accessing  report administration module 6-3
activating Maximo Labels tab 9-17
Active Portal 1-2
Actuate 7-1
  adding compiled reports to the Encyclopedia 11-4
  adding reports to the Encyclopedia 11-1
  configuring 10-1
  defining components 1-2
  increasing JVM maximum heap size on iServer 12-3
  maintaining a report server 12-1
  using as your reporting application 1-1
Actuate files
  design (.rod) files 7-2
  executable (.rox) files 7-2
Actuate server
  configuring with Maximo network 1-7
actuate.externText.JDBCDriverName C-1
actuate.externText.password C-2
actuate.externTextJDBCConnectionURL C-1, C-2
actuateexternText.username C-2
Actuatei18ntext.Properties C-1
ad hoc parameters 4-21
adding  a new report to the Maximo database 6-4
  additional fields in query 5-12
  compiled reports to the Encyclopedia 11-4
  parameters in query 5-10
  parameters to a report 9-23
  query labels 13-15
  reports to the Encyclopedia 11-1
  search fields 3-26
  server profile 7-8
administering reports 6-1
analysis reports 2-1
archiving  reports 12-7
archiving reports 12-7
attached documents 3-16
attaching documents in report administration 6-7
attribute name
  determining for a parameter 6-37

B

bas (basic source) files 7-2
batch format
  compiling reports in 12-4
bound parameters 6-35
business analysis and reporting tabs 3-3

calling Maximo Labels tab 9-17
Active Portal 1-2
Actuate 7-1
  adding compiled reports to the Encyclopedia 11-4
  adding reports to the Encyclopedia 11-1
  configuring 10-1
  defining components 1-2
  increasing JVM maximum heap size on iServer 12-3
  maintaining a report server 12-1
  using as your reporting application 1-1
Actuate files
  design (.rod) files 7-2
  executable (.rox) files 7-2
Actuate server
  configuring with Maximo network 1-7
actuate.externText.JDBCDriverName C-1
actuate.externText.password C-2
actuate.externTextJDBCConnectionURL C-1, C-2
actuateexternText.username C-2
Actuatei18ntext.Properties C-1
ad hoc parameters 4-21
adding  a new report to the Maximo database 6-4
  additional fields in query 5-12
  compiled reports to the Encyclopedia 11-4
  parameters in query 5-10
  parameters to a report 9-23
  query labels 13-15
  reports to the Encyclopedia 11-1
  search fields 3-26
  server profile 7-8
administering reports 6-1
analysis reports 2-1
archiving  reports 12-7
archiving reports 12-7
attached documents 3-16
attaching documents in report administration 6-7
attribute name
  determining for a parameter 6-37

calling Maximo Labels tab 9-17
Active Portal 1-2
Actuate 7-1
  adding compiled reports to the Encyclopedia 11-4
  adding reports to the Encyclopedia 11-1
  configuring 10-1
  defining components 1-2
  increasing JVM maximum heap size on iServer 12-3
  maintaining a report server 12-1
  using as your reporting application 1-1
Actuate files
  design (.rod) files 7-2
  executable (.rox) files 7-2
Actuate server
  configuring with Maximo network 1-7
actuate.externText.JDBCDriverName C-1
actuate.externText.password C-2
actuate.externTextJDBCConnectionURL C-1, C-2
actuateexternText.username C-2
Actuatei18ntext.Properties C-1
ad hoc parameters 4-21
adding  a new report to the Maximo database 6-4
  additional fields in query 5-12
  compiled reports to the Encyclopedia 11-4
  parameters in query 5-10
  parameters to a report 9-23
  query labels 13-15
  reports to the Encyclopedia 11-1
  search fields 3-26
  server profile 7-8
administering reports 6-1
analysis reports 2-1
archiving  reports 12-7
archiving reports 12-7
attached documents 3-16
attaching documents in report administration 6-7
attribute name
  determining for a parameter 6-37

C

callback classes
  in Maximo eSpreadsheet Designer 4-25
changing
  a detailed report to accept the hyperlink 9-21
  column names for end users 5-16
  field labels 6-14, 9-16
  localized report label values 13-10
  report titles 6-14, 9-16
  the Actuate Administrator’s password 10-1
clearing
  a completed notice 12-5
  multiple completed notices 12-6
columns names
  changing for end users 5-16
  compiling reports in batch format 12-4
  completed notice
    clearing multiple 12-6
  components
    defining Actuate 1-2
configuring
  Actuate 10-1
  e.Report Designer Professional 7-1
  Maximo network with Actuate server 1-7
creating
  parameters in eSpreadsheet 4-21
  queries 5-1
  query report using textual query editor 5-3
  report in eSpreadsheet Designer 4-3
  toolbar button on Maximo toolbar 6-9
  your first report 9-6
crosstab
  localizing reports 13-11
  report type defined 2-1
current record
  running report for 6-19
current/selected/all reports
  defined 6-17
  running 6-19
customer support i-x
customizing
  e.Report Designer Professional 7-4
  query 3-31
D
database
  adding a new report to 6-4
  properties in Maximo.Properties A-3
defined names
  in Maximo eSpreadsheet Designer 4-25
defining
  current/selected/all reports 6-19
  Encyclopedia components 11-1
  parameter-based reports 6-24
  parameters in eSpreadsheet 4-24
  report types 6-17
deleting a report 6-27
design (.rod) files 7-2
detail check box
  for detail report 6-8
detail report 2-1
  changing to accept the hyperlink 9-21
  for Maximo applications 2-2
determining
  parameter attribute name 6-37
  report language 13-2
display names
  modifying with the same label 5-13
documents
  attaching 3-16
downloading
  a report 3-17
  Excel data format in Maximo 3-18
  Excel display format in Maximo 3-18
  fully editable RTF format 3-18
  options 3-19
  PDF format 3-18
  RTF format in Maximo 3-18

E
e.Report Designer 1-2
e.Report Designer Professional 1-4, 7-1
  changing a detailed report to accept the hyperlink 9-21
  creating your first report in 9-6
  customizing 7-4
  hardware requirements 1-5
  hyperlinking to another report 9-20
  loading 7-4
  minimum hardware requirements 1-5
  running a report from 8-4, 8-5
e-mail report tab 3-10
Encyclopedia 1-2
  adding reports 11-1
  components 11-1
  folder and report structure 11-2
eSpreadsheet 1-5
  creating parameters 4-21
  defining parameters in 4-24
  minimum hardware requirements 1-5
  modifying 4-20
eSpreadsheet Designer
  installing 4-1
  modifying a SQL query 4-14
Excel data format
  downloading in Maximo 3-18
  Excel display format

downloading in Maximo 3-18
executable (.rox) files 7-2

F
factories and processors
  setting up 12-1
fields labels
  changing 6-14
file descriptions
  Actuate18ntext.Properties C-1
  Maximo.Properties A-1
  RSSE_Localhost.Properties B-1
  RSSE_Maximo.Properties B-1
files types
  .roi 7-3
  .rol 7-3
  .rox 7-4
folder structure in Encyclopedia 11-2
fully editable RTF format
  downloading in Maximo 3-18

G
generating
  request page 6-12
global vars parameters
  setting up 5-8
graphics
  in Maximo eSpreadsheet Designer 4-25
  groups, users, and roles 10-1

H
hardware requirements
e.Report Designer Professional 1-5
hierarchy
  report type defined 2-1
hyperlink
  changing a detailed report to accept 9-21
  setting up for localized reports 13-6
hyperlinking
  to another report 9-20
Index

I

increasing
  the JVM maximum heap size 12-3
installing
  eSpreadsheet Designer 4-1
iServer 1-5
  increasing JVM maximum heap size 12-3
iServer posting query to Encyclopedia 5-12

J

JDBC B-2
JDBC connection
  properties B-2
  setting up 4-2
jdbc.driverClass B-3
jdbc.password B-2
jdbc.url B-2
jdbc.username B-2
jobs folder
  using 10-11
joins
  linking related tables 4-17
JVM
  increasing maximum heap size 12-3

L

labels tab 6-14
  changing report titles in 9-16
LDAP connection B-3
ldap.context.factory B-3
ldap.provider.url B-3
ldap.user.basedn B-3
library (.rol) files 7-3
linking
  related tables through joins 4-17
list reports 2-1
loading
  and configuring e.Report Designer Professional 7-1
  e.Report Designer Professional 7-1, 7-4
loading e.Report Designer Professional 7-4
localized reports
  setting label values 13-4, 13-7
localized tables
  by system default 13-6
localizing
  crosstab reports 13-11
  query 13-12
  query data 13-14
  report data 13-5
  reports 13-4

M

maintaining a report server 12-1

Management Console 1-6
Maximo
  applications that have overview and detail reports 2-2
  configuring network with Actuate server 1-7
  connection properties B-3
  downloading Excel data format 3-18
  downloading Excel display format 3-18
  downloading fully editable RTF 3-18
  downloading PDF format 3-18
  downloading RTF format 3-18
  network configuration with Actuate server 1-7
  opening reports 3-2
  pointing to palette files 7-7
  Query 1-5
  registering (adding) a new report 6-4
  role mapping properties B-4
  signing in to reports 3-2
  templates 9-1
  working with your SQL SELECT statement in 9-19
Maximo eSpreadsheet Designer
  callback classes 4-25
  defined names 4-25
  graphics 4-25
  multiple queries 4-25
  pivot ranges 4-25
  virtual defined names 4-25
  XSL stylesheets 4-25
Maximo Multiple Different Subheader Template 9-3
Maximo Multiple Same Subheader Template 9-4
Maximo Single Subheader Template 9-5
maximo.host B-3
maximo.port B-3
Maximo.Properties file descriptions A-1
maximoservername B-3
modifying
  display names with same label 5-13
  query in eSpreadsheet Designer 4-14
  report 4-20
MROAttributeName control 13-8
MROObjectName control 13-8
multiple queries
  in Maximo eSpreadsheet Designer 4-25
mxe.db.driver (Oracle) A-3
mxe.db.driver (SQL Server) A-3
mxe.db.password A-4
mxe.db.url A-3
mxe.db.user A-4
mxe.report.actuate.db.connectstring A-2
mxe.report.actuate.iServer A-2
mxe.report.actuate.multiServer A-2
mxe.report.actuate.portalHost A-2
mxe.report.actuate.reportserver A-2
mxe.report.actuate.rptServerAdminPass A-2
mxe.report.actuate.rsseAlias A-2
Index

N

network
  configuring Maximo with Actuate server 1-7
notice
  clearing a completed 12-5
  clearing multiple completed 12-6

O

online support i-x
overview reports 2-1
  for Maximo applications 2-2

P

palette files
  pointing to 7-7
parameter
  determining attribute name 6-37
parameter-based reports
  defined 6-17
  defining 6-24
  running 6-24, 8-6
  storing in multiple applications 6-39
parameters
  ad hoc defined 4-21
  adding in query 5-10
  bound 6-35
  creating in eSpreadsheet 4-21
  defining in eSpreadsheet 4-24
  setting up global vars 5-8
  static 4-21
  unbound 6-36
  working with 6-18
password
  changing the Actuate Administrator's 10-1
PDF format
  downloading in Maximo 3-18
pivot ranges
  in Maximo eSpreadsheet Designer 4-25
pointing to Maximo palette files 7-7
populating REPORTLABEL table 13-9
posting query to iServer Encyclopedia 5-12
previewing request page 6-12
privileges
  setting 10-1
  setting by role 10-2
  setting by user 10-7
properties B-3
  JDBC connection B-2
  LDAP connection B-3
  Maximo connection B-3
  Maximo role mapping B-4
providing security access 6-28

Q

Query 5-1
query
  adding additional fields to 5-12
  adding labels 13-15
  adding parameters 5-10
  creating 5-1
  customizing 3-31
  label values 13-13
  localizing 13-12
  localizing data 13-14
  posting to iServer Encyclopedia 5-12
  reports 2-1
  running 3-29, 5-12
  tab 3-5
  tips for creating 5-12
query report
  creating through textual query editor 5-3

R

records
  running report for all 6-22
registering a new report to the Maximo database 6-4
removing search fields 3-26
renaming
  labels in the textual query editor 5-14
  report columns 6-14
report
  creating in eSpreadsheet Designer 4-3
  deleting 6-27
  downloading 3-17
  modifying eSpreadsheet 4-20
  selecting 8-2
report administration
  accessing module 6-3
  attaching documents 6-7
  changing field labels in labels tab 9-16
  changing report titles in labels tab 9-16
  creating toolbar button on Maximo toolbar 6-9
  deleting report 6-27
report columns 6-14
report data
  localizing 13-5
report developers
  providing security access to 6-28
report label values
  changing localized 13-10
report language
  determining 13-2
report server
  maintaining 12-1
report server properties
  in Maximo.Properties A-2
report titles
  changing 6-14
report type
  analysis 2-1
crosstab 2-1
detail 2-1
hierarchy 2-1
list 2-1
overview 2-1
query 2-1
reporting toolbar
using 3-15
REPORTLABEL table
populating 13-9
reports
adding 6-4
adding compiled to the Encyclopedia 11-4
adding parameters to 9-23
administering 6-1
archiving 12-7
defining types 6-17
detail 6-8
hyperlinking 9-20
localizing 13-4
opening in Maximo 3-2
parameter-based 6-24
running 3-13
running for all records 6-22
running for current record 6-19
running for selected record 6-20
searching 3-23
signing in 3-2
signing in to Maximo 3-2
structure in Encyclopedia 11-2
reports tab 3-3
request page
generating 6-12
previewing 6-12
request page tab
using 3-8
roi files 7-3
rol files 7-3
rox files 7-4
rsse.internalrole.administrator B-4
rsse.internalrole.all B-4
rsse.internalrole.operator B-4
rsse.multiserver B-4
RSSE_Localhost.Properties
file descriptions B-1
RSSE_Maximo.Properties
file descriptions B-1
RTF format
downloading in Maximo 3-18
run report tab 3-9
run reports 3-13
Running 8-4, 8-6
running
a parameter-based report 8-6
a report from e.Report Designer Professional 8-4, 8-5
current/selected/all reports 6-19
parameter-based reports 6-24
query 3-29, 5-12
report for all record 6-22
report for current record 6-19
report for selected records 6-20
tips for parameter-based reports 6-34
security access 6-28
selected records
running report for 6-20
selecting a report 8-2
server
adding profile 7-8
configuring Actuate with Maximo network 1-7
setting
label values for localized reports 13-4, 13-7
privileges 10-1
privileges by role 10-2
privileges by user 10-7
setting up
a privilege template 10-1
factories and processors 12-1
global vars parameters 5-8
hyperlinks for localized reports 13-6
JDBC connection 4-2
localized queries 13-1
localized reports 13-1
signing in to reports 3-2
SQL
modifying query in eSpreadsheet Designer 4-14
working with your SELECT statement in Maximo 9-19
static parameters 4-21
storing parameter-based reports in multiple applications 6-39
support, online i-x
system default localized tables 13-6
T
tables
linking related through joins 4-17
template
using Maximo Multiple Different Subheader 9-3
using Maximo Same Subheader 9-4
using Maximo Single Subheader Template 9-5
text control 13-8
textual query editor
renaming labels in 5-14
using to create query report 5-3
tips
for creating query 5-12
for running parameter-based reports 6-34
U
unbound parameters 6-36
using
jobs folder 10-11
Maximo templates 9-1
the reporting toolbar 3-15
the request page tab 3-8
V
viewing query label values 13-13
virtual defined names in Maximo eSpreadsheet Designer 4-25
Index

W

working
  with parameters 6-18
  with your SQL SELECT statement 9-19

X

XSL stylesheets
  in Maximo eSpreadsheet Designer 4-25